Contents

Read Me First. ................................................................. 7
How to Use the Online Manual. ........................................ 8
Trademarks and Licenses. .............................................. 9
Search Tips. ................................................................. 10
Window Used in Operation Explanation. .............................. 12
Useful Functions Available on the Machine. ......................... 13
  Useful Functions Available from Applications and the Main Unit. .......... 14
Helpful Functions Available Through the Network. .................. 18
  Online Storage Integration Function. .................................. 21
  Printing with Google Cloud Print. ....................................... 22
    Preparations for Printing with Google Cloud Print. .................. 23
    Printing from Computer or Smartphone with Google Cloud Print. .... 26
  Use PIXMA Cloud Link. ................................................... 28
    Application Management. .............................................. 35
    Cloud Windows. ....................................................... 40
  Using Canon Inkjet Cloud Printing Center. .......................... 43
    Printing Your Printer Registration ID. .............................. 55
    Canon Inkjet Cloud Printing Center window. ...................... 56
    Requirements for Canon Inkjet Cloud Printing Center operation. .... 70
Using Remote UI. ............................................................ 71
Printing from AirPrint Compliant Device. ............................. 74
How to Use Print from E-mail. .......................................... 79
  Preparing to Use Print from E-mail. .................................. 84
  Timezone List. ............................................................ 87
Overview of the Machine. ............................................... 88
  Safety Guide. .............................................................. 89
    Safety Precautions. ................................................... 90
    Regulatory and Safety Information. ................................. 91
Main Components and Basic Operations. ............................... 95
  Main Components. ...................................................... 96
    Front View. ............................................................ 97
    Rear View. ........................................................... 99
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleaning the Print Head</td>
<td>163</td>
</tr>
<tr>
<td>Cleaning the Print Head Deeply</td>
<td>165</td>
</tr>
<tr>
<td>Aligning the Print Head</td>
<td>167</td>
</tr>
<tr>
<td>Performing Maintenance from a Computer</td>
<td>170</td>
</tr>
<tr>
<td>Cleaning the Print Heads from Your Computer</td>
<td>171</td>
</tr>
<tr>
<td>Cleaning the Paper Feed Rollers from Your Computer</td>
<td>173</td>
</tr>
<tr>
<td>Aligning the Print Head</td>
<td>174</td>
</tr>
<tr>
<td>Aligning the Print Head Position from Your Computer</td>
<td>175</td>
</tr>
<tr>
<td>Use Your Computer to Print a Nozzle Check Pattern</td>
<td>178</td>
</tr>
<tr>
<td>Cleaning Inside the Machine</td>
<td>179</td>
</tr>
<tr>
<td>Cleaning the Machine</td>
<td>180</td>
</tr>
<tr>
<td>Cleaning the Exterior of the Machine</td>
<td>181</td>
</tr>
<tr>
<td>Cleaning the Platen Glass and Document Cover</td>
<td>182</td>
</tr>
<tr>
<td>Cleaning the Paper Feed Roller</td>
<td>183</td>
</tr>
<tr>
<td>Cleaning the Inside of the Machine (Bottom Plate Cleaning)</td>
<td>185</td>
</tr>
<tr>
<td>Cleaning the Protrusions inside the Machine</td>
<td>187</td>
</tr>
<tr>
<td>Changing the Machine Settings</td>
<td>188</td>
</tr>
<tr>
<td>Changing Machine Settings from Your Computer</td>
<td>189</td>
</tr>
<tr>
<td>Changing the Print Options</td>
<td>190</td>
</tr>
<tr>
<td>Registering a Frequently Used Printing Profile</td>
<td>192</td>
</tr>
<tr>
<td>Managing the Machine Power</td>
<td>194</td>
</tr>
<tr>
<td>Reducing the Machine Noise</td>
<td>196</td>
</tr>
<tr>
<td>Changing the Machine Operation Mode</td>
<td>198</td>
</tr>
<tr>
<td>Changing the Machine Settings on the LCD</td>
<td>200</td>
</tr>
<tr>
<td>Changing the Machine Settings on the LCD</td>
<td>201</td>
</tr>
<tr>
<td>Print settings</td>
<td>203</td>
</tr>
<tr>
<td>LAN settings</td>
<td>204</td>
</tr>
<tr>
<td>Device user settings</td>
<td>207</td>
</tr>
<tr>
<td>Language selection</td>
<td>208</td>
</tr>
<tr>
<td>Firmware update</td>
<td>209</td>
</tr>
<tr>
<td>Reset setting</td>
<td>210</td>
</tr>
<tr>
<td>About ECO settings</td>
<td>211</td>
</tr>
<tr>
<td>About Quiet setting</td>
<td>213</td>
</tr>
<tr>
<td>Before Using the Machine with the Access Point Mode</td>
<td>214</td>
</tr>
<tr>
<td>Information about Network Connection</td>
<td>216</td>
</tr>
<tr>
<td>Useful Information about Network Connection</td>
<td>217</td>
</tr>
<tr>
<td>Initial Values Set at Factory (Network)</td>
<td>218</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Connecting the Machine to the Computer Using a USB Cable.</td>
<td>219</td>
</tr>
<tr>
<td>When Detecting the Printers Have the Same Name during Setup.</td>
<td>220</td>
</tr>
<tr>
<td>Connecting to Other Computer with LAN/Changing the Connection Method from USB to LAN.</td>
<td>221</td>
</tr>
<tr>
<td>Printing Out Network Setting Information.</td>
<td>222</td>
</tr>
<tr>
<td>About Network Communication.</td>
<td>224</td>
</tr>
<tr>
<td>Changing and Confirming Network Settings.</td>
<td>225</td>
</tr>
<tr>
<td>IJ Network Tool.</td>
<td>226</td>
</tr>
<tr>
<td>Changing the Settings in the Wireless LAN Sheet.</td>
<td>227</td>
</tr>
<tr>
<td>Changing the WEP Detailed Settings.</td>
<td>229</td>
</tr>
<tr>
<td>Changing the WPA or WPA2 Detailed Settings.</td>
<td>231</td>
</tr>
<tr>
<td>Changing the Settings in the Wired LAN Sheet.</td>
<td>234</td>
</tr>
<tr>
<td>Changing the Settings in the Admin Password Sheet.</td>
<td>235</td>
</tr>
<tr>
<td>Monitoring Wireless Network Status.</td>
<td>236</td>
</tr>
<tr>
<td>Initializing the Network Settings of the Machine.</td>
<td>239</td>
</tr>
<tr>
<td>Viewing the Modified Settings.</td>
<td>240</td>
</tr>
<tr>
<td>Screens for Network Connection of IJ Network Tool.</td>
<td>241</td>
</tr>
<tr>
<td>Canon IJ Network Tool Screen.</td>
<td>242</td>
</tr>
<tr>
<td>Configuration Screen.</td>
<td>245</td>
</tr>
<tr>
<td>Wireless LAN Sheet.</td>
<td>246</td>
</tr>
<tr>
<td>Search Screen.</td>
<td>248</td>
</tr>
<tr>
<td>WEP Details Screen.</td>
<td>250</td>
</tr>
<tr>
<td>WPA Details Screen.</td>
<td>251</td>
</tr>
<tr>
<td>WPA2 Details Screen.</td>
<td>252</td>
</tr>
<tr>
<td>Authentication Type Confirmation Screen.</td>
<td>253</td>
</tr>
<tr>
<td>PSK: Passphrase and Dynamic Encryption Setup Screen.</td>
<td>254</td>
</tr>
<tr>
<td>Setup Information Confirmation Screen.</td>
<td>255</td>
</tr>
<tr>
<td>Wired LAN Sheet.</td>
<td>256</td>
</tr>
<tr>
<td>Admin Password Sheet.</td>
<td>257</td>
</tr>
<tr>
<td>Network Information Screen.</td>
<td>258</td>
</tr>
<tr>
<td>Access Control Sheet.</td>
<td>259</td>
</tr>
<tr>
<td>Edit Accessible MAC Address Screen/Add Accessible MAC Address Screen.</td>
<td>263</td>
</tr>
<tr>
<td>Edit Accessible IP Address Screen/Add Accessible IP Address Screen.</td>
<td>264</td>
</tr>
<tr>
<td>Other Screens of IJ Network Tool.</td>
<td>265</td>
</tr>
<tr>
<td>Canon IJ Network Tool Screen.</td>
<td>266</td>
</tr>
<tr>
<td>Status Screen.</td>
<td>269</td>
</tr>
<tr>
<td>Connection Performance Measurement Screen.</td>
<td>270</td>
</tr>
<tr>
<td>Maintenance Screen.</td>
<td>272</td>
</tr>
<tr>
<td>Network Setup of the Card Slot Screen.</td>
<td>273</td>
</tr>
<tr>
<td>Associate Port Screen.</td>
<td>275</td>
</tr>
</tbody>
</table>
Read Me First

⇒ Notes on Online Manual Usage
⇒ How to Print

Notes on Online Manual Usage

• Reproduction, diversion or copying of any text, photo or image published in the Online Manual (hereinafter referred to as "this guide"), in whole or in part, is prohibited.
• In principle, Canon shall change or delete the contents of this guide without prior notice to customers. In addition, Canon may suspend or stop the disclosure of this guide due to unavoidable reasons. Canon shall not be liable for any damage suffered by customers as a result of changes in or deletion of information in this guide, or suspension/stoppage of disclosure of this guide.
• Although the contents of this guide have been prepared with utmost care, please contact the service center if you find any incorrect or missing information.
• In principle, the descriptions in this guide are based on the product at the time of its initial sale.
• This guide does not disclose the manuals of all the products sold by Canon. See the manual supplied with the product when using a product that is not described in this guide.

How to Print

Use the print function of your Web browser to print this guide.

To set to print background colors and images, follow the steps below.

Note
• In Windows 8, print in the desktop version.

• In Internet Explorer 9 or 10
  1. Select (Tools) > Print > Page setup....
  2. Select the Print Background Colors and Images checkbox.

• In Internet Explorer 8
  1. Press the Alt key to display the menus.
     Alternatively, from Tools, select Toolbars > Menu Bar to display the menus.
  2. Select Page Setup... from the File menu.
  3. Select the Print Background Colors and Images checkbox.

• In Mozilla Firefox
  1. Press the Alt key to display the menus.
     Alternatively, click Firefox, then select Menu Bar from the right arrow of Options to display the menus.
  2. Select Page Setup... from the File menu.
  3. Select the Print Background (colors & images) checkbox in Format & Options.
How to Use the Online Manual

Symbols Used in This Document

⚠️ Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect operation of the equipment. These must be observed for safe operation.

⚠️ Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect operation of the equipment. These must be observed for safe operation.

➡️ Important
Instructions including important information. To avoid damage and injury or improper use of the product, be sure to read these indications.

➡️ Note
Instructions including notes for operation and additional explanations.

 Ро Basic
Instructions explaining basic operations of your product.

➡️ Note
• Icons may vary depending on your product.

Touch-enabled Device Users

For touch actions, you need to replace "right-click" in this document with the action set on the operating system. For example, if the action is set to "press and hold" on your operating system, replace "right-click" with "press and hold."
Trademarks and Licenses

- Microsoft is a registered trademark of Microsoft Corporation.
- Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other countries.
- Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other countries.
- Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other countries.
- Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.
- IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.
- Google Cloud Print, Google Chrome, Android and Google Play are either registered trademarks or trademarks of Google Inc.
- Adobe, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
- Photo Rag is a trademark of Hahnemühle FineArt GmbH.
- Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.
- All other company names and products mentioned herein may be trademarks or registered trademarks of their respective companies.

Note

- The formal name of Windows Vista is Microsoft Windows Vista operating system.
Search Tips

You can search for target pages by entering keywords in the search window.

Note

• The displayed screen may vary.

• Searching for Functions

   You can find target pages easily by entering your product's model name and a keyword for the function you want to learn about.

   Example: When you want to learn how to load paper
   Enter "(your product's model name) load paper" in the search window and perform a search

• Troubleshooting Errors

   You can obtain more accurate search results by entering your product's model name and a support code.

   Example: When the following error screen appears
   Enter "(your product's model name) 1000" in the search window and perform a search
Note

• The displayed screen varies depending on your product.

• Searching for Application Functions

You can find target pages easily by entering your application's name and a keyword for the function you want to learn about.

Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

• Searching for Reference Pages

You can search for reference pages described in this guide by entering your model name and a page title.
You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning procedure page
Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.
Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a search
Window Used in Operation Explanation

In this guide, most of the operations are described based on the windows displayed when Windows 8 operating system (called Windows 8 below) is used.
Useful Functions Available on the Machine

The following useful functions are available on the machine.
Enjoy pleasant photography experience by utilizing various functions.

Helpful Functions Available Through the Network
You can print more conveniently through integration with smartphones and other devices or with services on the web.

PIXMA Cloud Link

Useful Functions Available from Applications and the Main Unit
You can create items such as collages easily or download delightful printing materials, and print them.
Useful Functions Available from Applications and the Main Unit

On the machine, the following useful functions are available from applications and the main unit.

- Print Photos Easily
- Connect Wirelessly with Ease
- Download Content Materials
- Print Photos on Facebook

Print Photos Easily Using an Application

Organize Images Easily

In My Image Garden, you can register the names of people and events to photos. You can organize photos easily as you can display them not only by folder but also by calendar, event, and person. This also allows you to find the target photos easily when you search for them later on.

<Calendar View>

<People View>

Display Recommended Items in Slide Shows

Based on the information registered to photos, Quick Menu automatically selects the photos on your computer and creates recommended items such as collages and cards. The created items appear in slide shows.
If there is an item you like, you can easily print it in just two steps.

1. In Image Display of Quick Menu, select the item you want to print.
2. Print the item with My Image Garden.

Place Photos Automatically

Delightful items are created easily as the selected photos are placed automatically according to the theme.

Other Various Functions

My Image Garden has many other useful functions.
Refer to "What You Can Do with My Image Garden" for details.

Connect Wirelessly with Ease in "Access Point Mode"

The machine supports "access point mode" in which you can connect to the machine wirelessly from a computer or smartphone even in an environment without an access point or wireless LAN router.
Switch to "access point mode" with simple steps to enjoy scanning and printing wirelessly.
When you use the machine with the access point mode, be sure to specify the access point name of the machine and the security setting in advance.

- **Before Using the Machine with the Access Point Mode**

For details on printing or scanning with the access point mode:

- Printing with the Access Point Mode
- Scanning with the Access Point Mode

---

**Download a Variety of Content Materials**

**CREATIVE PARK**

A "printing materials site" where you can download all the printing materials for free. Various types of content such as seasonal cards and paper crafts that can be made by assembling paper parts are provided.

It is easily accessible from Quick Menu.

**CREATIVE PARK PREMIUM**

A service where customers using models that support PREMIUM Contents can download exclusive printing materials. PREMIUM Contents can be downloaded easily via My Image Garden. Downloaded PREMIUM Contents can be printed directly with My Image Garden.

To download PREMIUM Contents, make sure that genuine Canon ink tanks/ink cartridges are installed for all colors on a supported printer.

---

**Note**

- The designs of PREMIUM Contents provided in this page are subject to change without prior notice.
Print Photos on Facebook Easily Using a Facebook App "Print Your Days"

Use Print Your Days to collect Facebook photos of memories of parties and travel, recent activity of your family and friends, your hobbies, etc., then create and print a work of art. Print Your Days is available from the Print Your Days Facebook page.
Helpful Functions Available Through the Network

The following useful functions are available on the machine.
Enjoy even more pleasant photography experience by utilizing various functions.

- Use App from Various Environments by Using PIXMA Cloud Link
- Upload scanned images to the web
- Print web data easily
- Print by using Google Cloud Print
- Print directly from your iPad, iPhone, or iPod touch
- Manage Your Printer from a Remote Location by Using Remote UI
- Print Easily by Sending E-mail from Your Computer or Smartphone
- Print easily from your smartphone by using PIXMA Printing Solutions
- Printing with Windows RT

Use App from Various Environments by Using PIXMA Cloud Link

By using PIXMA Cloud Link, you can access an application that supports this service and use it directly without using your computer. In addition to printing photos and documents from various applications, you can register and manage applications.
Refer to "Use PIXMA Cloud Link" for details.

Upload Scanned Images Easily to the Web

If you use Evernote or Dropbox on your computer, you can easily upload scanned images to the web. Uploaded images can be utilized from other computers, smartphones, etc.
Refer to "Online Storage Integration Function" for details.

Print Photos on Photo-Sharing Services or Print Web Template Forms Easily from the Machine

You can directly print photos on photo-sharing services or template forms offered on the web without using a computer.

- Online Album Photo Print
  You can access photo-sharing services on the web from the machine and directly print photos in online albums (such as Picasa Web Albums) while checking them on the printer screen.
• **Web Template Form Print**
  Canon offers various template forms including seasonal stationery and calendars on the web. You can download and print the template forms you want anytime, as much as you need, by operating the machine only.

### Print in Various Environments with Google Cloud Print

The machine is compatible with Google Cloud Print (Google Cloud Print is a service provided by Google Inc.).

By using Google Cloud Print, you can print from anywhere with applications or services supporting Google Cloud Print.

Refer to "[Printing with Google Cloud Print](#)" for details.

### Print Directly from iPad, iPhone, or iPod touch with Apple AirPrint

The machine is compatible with the AirPrint function of Apple iOS devices.

You can directly print e-mails, photos, web pages, etc. from iPad, iPhone, or iPod touch to the machine over wireless LAN.

Refer to "[Printing from AirPrint Compliant Device](#)" for details.
Manage Your Printer from a Remote Location by Using Remote UI

By using Remote UI, you can set up this machine, check the machine status, and even perform maintenance from your computer or smartphone.

Because you can use this service from a remote location through the network, you can check printer information even when you're out away from the printer.

Refer to "Using Remote UI" for details.

Print Easily by Sending E-mail from Your Computer or Smartphone

By using Print from E-mail, you can easily print a photo or document saved on your computer or smartphone just by attaching it to an e-mail.

You can easily print from your travel destination or an outside location. You can even let friends and family print on the printer by setting up your printer beforehand.

Refer to "How to Use Print from E-mail" for details.

Print Easily from a Smartphone with PIXMA Printing Solutions

Use PIXMA Printing Solutions to easily print photos saved on a smartphone wirelessly.

You can also receive scanned data (PDF or JPEG) directly on a smartphone without using a computer.

PIXMA Printing Solutions can be downloaded from App Store and Google Play.

Printing with Windows RT

When you use Windows RT, printing is easy because you simply connect this machine to the network.

For information about connecting to the network, see here.

When the connection is complete, the Canon Inkjet Print Utility software, which allows you to specify detailed print settings, is downloaded automatically.

By using Canon Inkjet Print Utility, you can check the printer status and specify detailed print settings. (The available functions will differ depending on your usage environment and connection method.)
Online Storage Integration Function

The machine can integrate with online storage services such as Evernote.

Integration with Online Notetaking Service "Evernote"

If an Evernote client application is installed on your computer, you can import scanned images into the application and upload them to the Evernote server.

The uploaded images can be browsed from other computers, smartphones, etc.

To use Evernote, you need to create an account. See the "CREATE ACCOUNT" page of Evernote for account creation.

• Settings

In the Settings Dialog Box of IJ Scan Utility, select the item you want to set, then select Evernote for Send to an application in Application Settings.

Refer to "Settings Dialog Box" for your model from Home of the Online Manual for details.

Important

• The Evernote service features are subject to change or termination without prior notice.
Printing with Google Cloud Print

The machine is compatible with Google Cloud Print™ (Google Cloud Print is a service provided by Google Inc.).

By using Google Cloud Print, you can print from anywhere with applications or services supporting Google Cloud Print.

1. **Preparations for Printing with Google Cloud Print**

2. **Printing from Computer or Smartphone with Google Cloud Print**

**Important**

- LAN connection with the machine and Internet connection are required to register the machine and to print with Google Cloud Print. Internet connection fees apply.
- This function may not be available depending on the country or region you live in.
Preparations for Printing with Google Cloud Print

To print with Google Cloud Print, you need to get Google account and register the machine with Google Cloud Print in advance.

➡ Getting Google Account

If you already have Google account, register the machine.

➡ Registering the Machine with Google Cloud Print

Getting Google Account

First, get your Google account in order to register the machine with Google Cloud Print.

Access to Google Cloud Print with the web browser on the computer or the mobile device, then register the required information.

* The screen above may change without prior notice.

Registering the Machine with Google Cloud Print

Register the machine with Google Cloud Print.

The authentication procedure using the web browser on the computer or the mobile device is required in the process of registering. Because the authentication URL is printed from machine when the authentication process is performed, prepare A4 or Letter-sized plain paper.

Important

- LAN connection with the machine and Internet connection are required to register the machine and to print with Google Cloud Print. Internet connection fees apply.
- If the machine’s owner changes, delete the machine from Google Cloud Print.

1. Make sure that the machine is turned on.

If your printer has a LCD monitor

2. Display the Home screen.
3. Select Setup.


   Note
   • If you have already registered the machine with Google Cloud Print, the confirmation message to re-register the machine is displayed.

5. When the confirmation screen to register the machine is displayed, select Yes.

6. Select a display language on the print setting screen of Google Cloud Print.
   The confirmation message to print the authentication URL is displayed.

7. Load A4 or Letter-sized plain paper, then select OK.
   The authentication URL is printed.

8. Ensure that the authentication URL is printed, select Yes.

9. Perform the authentication process using the web browser on the computer or the mobile device.
   Access to the URL using the web browser on the computer or the mobile device and perform the authentication process following the on-screen instructions.

   Note
   • Perform the authentication process with your Google account which you have gotten in advance.

10. When the message that the registration is complete is displayed on the LCD of the machine, select OK.
   When authentication process is complete properly, the registration items are displayed. When authentication process is complete, you can print the data with Google Cloud Print.
   When authentication process is not complete properly and the error message is displayed, select OK. When the confirmation message to print the authentication URL is displayed, print the authentication URL, then perform the authentication process on the computer again.

If your printer does not have a LCD monitor

2. Remote UI startup

3. Select Google Cloud Print setup -> Register with Google Cloud Print
4. When the confirmation screen to register the machine is displayed, select **Yes**.

5. In the print setup for Google Cloud Print, select the display language, and then select **Authentication**.

6. When the registration completion message appears, select **OK**.

---

**Deleting the Machine from Google Cloud Print**

If the machine's owner changes or if you want to re-register the machine, delete the machine from Google Cloud Print by following the steps below.

1. Make sure that the machine is turned on.

If your printer has a LCD monitor

2. Display the Home screen.

3. Select **Setup**.

4. Select **Web service setup -> Web service connection setup -> Google Cloud Print setup -> Delete from Google Cloud Print**.

5. When the confirmation screen to delete the machine is displayed, select **Yes**.

If your printer does not have a LCD monitor

2. **Remote UI startup**

3. Select **Google Cloud Print setup -> Delete from Google Cloud Print**.

4. When the confirmation screen to delete the machine is displayed, select **Yes**.
Printing from Computer or Smartphone with Google Cloud Print

When you send print data with Google Cloud Print, the machine receives the print data and prints it automatically if the machine is turned on.

When printing from a computer, smartphone, or other external device with Google Cloud Print, load paper into the machine in advance.

Sending the Print Data with Google Cloud Print

1. Make sure that the machine is turned on.

   Note
   - If you want to send the print data from an outside location, turn on the machine in advance.

2. Print from the computer or smartphone.

   The figure below is an example of when printing from the web browser corresponding with Google Cloud Print. The screen differs depending on the applications or services supporting Google Cloud Print.

   When the preparation for printing with Google Cloud Print is complete and when the machine is turned on, the machine receives the print data and prints it automatically.

   Note
   - Depending on the communication status, it may take a while to print the print data or the machine may not receive the print data.
   - While printing with Google Cloud Print, the printing may be canceled depending on the machine's status, such as when the machine is being operated or an error has occurred. To resume printing, check the machine's status, then print with Google Cloud Print again.
   - For print settings:
     - If you select the media type other than plain paper or if you select the paper size other than A4/Letter/B5/A5-size, the print data is printed in single-sided even when you select the duplex print setting. (The paper size differs depending on the model of your printer. For information about
the supported paper sizes, go to the Online Manual home page, and refer to the "Cannot Print Properly with Automatic Duplex Printing" for your model.)

- If you select plain paper as media type or if you select B5/A5-size as paper size, the print data is printed with border even when you select the borderless print setting.
- The print results may differ from the print image depending on the print data.
- Depending on the device sending the print data, you may not select the print settings when sending the print data with Google Cloud Print.

When you want to print from Google Cloud Print immediately

When the machine cannot receive the print data, or you want to start printing immediately, you can check whether there is a print job on the Google Cloud Print and start printing manually.

Follow the steps below.

**Important**

- Depending on your printer model, this function may not be available.

1. Make sure that the machine is turned on.

2. Display the Home screen.

3. Select **Setup**.

4. Select **Web service inquiry**.

**Note**

- If you have not registered the machine with Google Cloud Print, **Web service inquiry** is not displayed. [Register the machine with Google Cloud Print](#).

5. Select **Print from Google Cloud Print**.

   The confirmation screen to check is displayed.

6. Select **Yes**.

   If there is the print data, the machine receives the print data and prints it.
Use PIXMA Cloud Link

By using PIXMA Cloud Link, you can connect your printer to a cloud service, such as CANON iMAGE GATEWAY, Evernote, or Twitter, and use the following functions without using a computer:

• Print images from a photo-sharing service
• Print documents from a data management service
• Use Twitter to report the printer status, such as no paper or ink empty

In addition, you can use various functions by adding and registering apps that are linked with various cloud services.

Also, if you register to Canon Inkjet Cloud Printing Center, you can also use these functions from your smartphone or tablet device.

Important

• In certain countries, PIXMA Cloud Link may not be available or the available apps may be different.
• Some apps require that you have an account before you use those apps. For such apps, please set up an account beforehand.
• To find out which models support PIXMA Cloud Link check the Canon homepage.
• The screen display may change without prior notice.

Before Using PIXMA Cloud Link

First, check your environment.

• Network environment

  The printer must be connected to a LAN and to the Internet.
  If your printer is not connected to a LAN, see here and set one up.
For information on the LAN and Internet settings, see the manual of your network devices or contact the manufacturer.

**Important**

- The user will bear the cost of Internet access.

**Printer software (firmware) version**

If the printer's firmware version is earlier than Ver. 2.000, you need to update the firmware. Refer to "Firmware update" for your model from the Home of the Online Manual for details.

**Important**

- When you update the firmware of this product, the displayed screens, the operation procedures, and the functions may change.
- If you register a photo-sharing service to your printer and then later update the printer firmware, the photo-sharing service will be deregistered. Please perform the account setup again.

### Preparing to use PIXMA Cloud Link from your printer

Follow the steps described below to register the printer information.

The screen display differs depending on your computer.

1. Check that the printer is connected to the Internet

2. From the printer home screen, select Cloud

3. Registration to the server will take place

   When the registration completed screen appears, select OK.

4. On the confirmation screen, select Next
5. In the **License agreement** and **Privacy statement** windows, read the statements, and then select **Agree** if you agree.

![License agreement](image)

**<License agreement>**

![Privacy statement](image)

**<Privacy statement>**

### Note

- If you select **Disagree**, a confirmation screen of canceling the user information registration appears. If you select **Yes**, the user information registration is canceled, and you return to the Home screen.
- If you selected **Disagree**, you can still use this service later.
- You can print the displayed information by pressing the **Start** button.

6. On the **Time zone** screen, select the time closest to your region, and then select **Next**.

![Time zone](image)

7. In the time zones list, select the region closest to you.

   For some regions, a screen for applying the daylight saving time setting may appear.
8. When a message appears notifying that the app is now available, select **Apps**

The registration of printer information is completed, and a list of apps is displayed. See [here](#) for the description of the apps list screen.

When you complete the registration, you can add/delete/sort apps and print photos and documents that have been uploaded.

When you register your printer to Canon Inkjet Cloud Printing Center, you can use PIXMA Cloud Link from your smartphone or tablet device.

**Using PIXMA Cloud Link**

This section introduces the photo printing procedure by using CANON iMAGE GATEWAY as an example.

### Important

- The available functions differ depending on the app.
- The printing procedure differs depending on the app.
- You need to get the account and register photo and other data beforehand.
- The following file formats can be printed: jpg, jpeg, pdf, docx, doc, xlsx, xls, pptx, ppt, txt, and rtf.
  - The file formats that can be printed differ depending on the app.
- Before you print, check that printer is on and is connected to the network. Then start.

### Note

- You can use CANON iMAGE GATEWAY to print jpg and jpeg file formats.

1. On the **Main screen**, select the app to be used

2. Enter the information according to the instructions on the authentication screen, and then select **Log in**
Important

- Some apps may not be fully displayed in the display area. If this is the case, scroll up, down, right, and left to change the display area.

- The Login screen may vary between apps.
- On the Login screen, just enter the account and password and log in. Otherwise, the operation of the product after the login is not guaranteed.
- After logging in, you may be asked from an external service to agree to use their app. Agree if you are using the app.

3. In the displayed album list, select the album of your choice

4. In the displayed image list, select the image that you want to print, and then select **Next**

5. Make the necessary print settings, and then select **Color**
6. A message that indicates the completion of issuing print job appears, and printing starts.

   The print data has been sent.

To end the printing, select **Exit**. The screen returns to the apps list screen.
To continue printing, select **Continue**, and perform the operation from Step 3.

**Important**
- If a print job is not printed within 24 hours after the print job is issued, the print job will expire and cannot be printed.
- With premium apps that limit the number of print jobs, print jobs that cannot be printed due to expiration and other reasons are also included in the print count.

**Cloud troubleshooting**

**If you cannot print**

Check the following if you cannot print.

- Check that the printer is connected to the Internet.
- Check that the printer is connected to a LAN and the LAN environment is connected to the Internet.
- Check that no error message is displayed on the printer’s LCD monitor.
  
  If the problem is not resolved, use the printer driver from your computer to perform the print job and check whether the data can be printed normally on the printer.
  
  If you still cannot print, see the troubleshooting page for your model on the Home of the *Online Manual*.

**Note**

- With a wireless LAN connection, after the printer is turned on, it may take several minutes before communication is possible. Check that your printer is connected to the wireless network, and wait a while before you start printing.
- If the printer is not turned on or is not connected to the Internet, and consequently a print job is not processed within 24 hours after it was submitted, the print job is automatically canceled. If this happens, check the printer power and the Internet connection, and then re-submit the print job.
Copyright c 1991-2013 Unicode, Inc. All rights reserved. Distributed under the Terms of Use in http://www.unicode.org/copyright.html.

This software is based in part on the work of the Independent JPEG Group.

THE BASIC LIBRARY FUNCTIONS
Written by: Philip Hazel
Email local part: ph10
Email domain: cam.ac.uk
Copyright (c) 1997-2008 University of Cambridge All rights reserved.

THE "BSD" LICENCE
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the University of Cambridge nor the name of Google Inc. nor the names of their contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Application Management

This section explains how to add, delete, and sort apps.

Add apps

You can add your favorite apps to the printer.
Follow the steps described below to add apps.

1. From the printer home screen, select Cloud

2. On the cloud's Main screen, select Add/delete

3. Select Register apps

4. On the list, select the category of the app

5. From the displayed apps list, select the app that you want to register
6. Select **Register**

![Register](image)

The registration is completed and the app is added to the apps list.

To register another app, repeat the procedure from step 5.

To end the app registration, select **Back** and return to the cloud's Main screen.

**Important**

- Some apps may require you to have an account before using the app. If this is the case, get the account beforehand.

**Delete apps**

You can delete unnecessary apps from the apps list.

Follow the steps described below to delete apps.

1. From the printer home screen, select **Cloud**

2. On the cloud's Main screen, select **Add/delete**
3. Select **Delete registered apps**

4. From the apps list, select the app that you want to delete

---

**Note**

- Description of displayed icons
  - : Cannot be used because it is not yet released or not available in your region.
  - : Can be used with genuine Canon ink.

5. Select **Delete**

When the deletion is finished, the app will be deleted from the apps list on the main screen.

To delete another app, repeat the procedure from step 4.
To end the app deletion, select **Back** and return to the cloud's Main screen.

**Sort apps**

You can sort apps displayed on the apps list.
Follow the steps described below to sort apps.

1. From the printer home screen, select **Cloud**

2. On the cloud's Main screen, select **Add/delete**
3. Select **Sort**

4. On the apps list, select the app that you want to sort

Note

- Description of displayed icons
  - Cannot be used because it is not yet released or not available in your region.
  - Can be used with genuine Canon ink.

5. Use ▲ / ▼ buttons to move the app

6. Select **Done**
Sorting is complete.
To continue the sorting, repeat the procedure from step 4.
To end the sorting, select **Back** and return to the cloud's Main screen.
Cloud Windows

This section describes the Main screen of Cloud and the services available on the Main screen.

- About the Main screen
- Register apps
- Delete registered apps
- Sort
- Log out of all apps
- License agreement/Privacy statement
- Settings

About the Main screen

When using the Cloud function, follow the steps described below first and display the Main screen.

1. Check that the printer is connected to the Internet

2. From the printer home screen, select Cloud

The cloud's Main screen appears.

You can use areas shown below to perform various functions, including adding, starting, and managing apps and printing photos and documents.

![Main screen diagram]

(1) Display area
(2) Add/delete button
(3) Manage button

Important

- Some apps may require you to have an account before using the app. If this is the case, get the account beforehand.
- After selecting the app, some apps may not be fully displayed in the display area. If this is the case, scroll up, down, right, and left to change the display area.

: Visible area
• The app is not displayed if it is not yet released, or if the language not available in your region is selected in the display language setting.

(1) Display area

The display changes based on the menu you select.
Immediately after starting the cloud, registered apps appear on the list.
To start an app, select the app that you want to use on the list.

Note

• Description of displayed icons

: Cannot be used because it is not yet released or not available in your region.
: Can be used with genuine Canon ink.

(2) Add/delete button

Use this button to add, delete, and sort apps.

Register apps
Select this to add your favorite apps.

See here for details on how to add apps

Delete apps
Select this to delete registered apps.

See here for details on how to delete apps

Sort
Select this to sort the apps list.

See here for details on how to sort the apps list

(3) Manage button

Use this button to log out of an app, show the license agreement and privacy statement, and set the time zone.
Log out of all apps

You can log out at the same time from all apps that you are logged into.

Note

- Some apps may not allow you to log out when you are logged on. If you want to log in with a different account, you need to use this function to log out first.
- Once you log out, you need to log in again. You may lose the settings with some apps.

License agreement / Privacy statement

This shows the license agreement and privacy statement. Press the Start button to print the displayed information.

Settings

Select this to set the time zone. Select your region on the list. For some regions, you can set whether or not to apply the daylight saving time setting.

Important

- If you cannot find your region on the list, select the one closest to your region.
Using Canon Inkjet Cloud Printing Center

Canon Inkjet Cloud Printing Center is a service that links with the cloud function of the printer and allows you to perform operations such as registering and managing apps from your smartphone or tablet device, and checking the print status, print error, and ink status of the printer. You can also print photos and documents from your apps.

If you are using this service from your computer, you can manage the apps.

Important

- The screen display may change without prior notice.

Before using Canon Inkjet Cloud Printing Center

Preparations before using Canon Inkjet Cloud Printing Center

Using Canon Inkjet Cloud Printing Center

Troubleshooting Canon Inkjet Cloud Printing Center

Before using Canon Inkjet Cloud Printing Center

First, check your environment.

- Printer specification
  Check that Canon Inkjet Cloud Printing Center supports the printer.

- Network environment
  The printer must be connected to a LAN and to the Internet.

Important

- The user will bear the cost of Internet access.
• **Printer software (firmware) version**

If the printer's firmware version is earlier than Ver. 2.000, you need to update the firmware. Refer to "Firmware update" for your model from the Home of the *Online Manual* for details.

**Important**

- When you update the firmware of this product, the displayed screens, the operation procedures, and the functions may change.
- If you register a photo-sharing service to your printer and then later update the printer firmware, the photo-sharing service will be deregistered. Please perform the account setup again.

• **Operating requirements**

See [here](#) for the operating requirements for computers, smartphones, and tablet device.

**Important**

- This service may not be available in certain countries or regions. Also even if the service is available, there are apps that cannot be used in certain regions.

### Preparations before using Canon Inkjet Cloud Printing Center

To use the Canon Inkjet Cloud Printing Center, you need to follow the steps described below and register the user information.

#### Print registration information from the printer

1. Check that the printer is connected to the Internet

2. From the home window, select **Setup** -> **Web service setup** -> **Web service connection setup** -> **IJ Cloud Printing Center setup** -> **Register with this service**

3. When you are asked to confirm the registration, select **Yes**
4. Select the language to be used in Print settings

5. Follow the instructions displayed in the window, and print the URL of the authentication site and the Printer registration ID

Set A4 size or Letter size plain paper and select OK.
The authentication URL and Printer registration ID are printed.

Note

- You will use this printed page in the next step.

Canon Inkjet Cloud Printing Center

User registration
To use Canon Inkjet Cloud Printing Center, you need to register the printer owner information.
Access the URL below from a browser on a computer or smartphone, then enter the printer registration ID to register. If you have already registered with Canon Inkjet Cloud Printing Center, log in and add a printer.

(Note)
All operations up to the completion of registration must be performed within approximately 60 minutes from now. Beyond that time, the printer registration ID below will be disabled.

URL:
http://ia-cij.com/

Printer registrationID:
VRK7JK

Important

- The operation to complete the registration should be done within 60 minutes.
Access the URL on the printed page, and then enter the e-mail address and other necessary information

**Important**

- Do not use the Back button of the web browser while an operation is processing. The screen may not transition properly.

1. Use the web browser on your PC, smartphone, tablet, or other devices to access the authentication URL

   ![Authentication URL](http://cs.c-ij.com/)

2. On the Login screen, select **Create new account**

   ![Create new account](#)

3. Enter the **E-mail address** and **Printer registration ID** of the printer's owner, and then select **OK**
Important

- There are character restrictions for the e-mail address, as shown below.
  - You can use up to 255 alphanumeric characters consisting of single-byte characters and symbols (!#$%&'*+/=?^_{}|~.-@).
  - Multibyte characters cannot be used. You will get an error if the e-mail address you enter contains a character that cannot be used.
- If you registered a different e-mail address by mistake, you can cancel the registration by going to the printer's Home screen and selecting **Setup** -> **Web service setup** -> **Web service connection setup** -> **IJ Cloud Printing Center setup** -> **Delete from this service**.
  - You may not be able to receive the notification if you are using a spam filter. If you have a setting to receive only the e-mails from certain domains, be sure to change the setting to allow receiving e-mails from "noreply@mail.cs.c-ij.com". There will be no error display even if you could not receive the e-mail because of the spam filter setting or if you entered an incorrect e-mail address.

4. The registration page URL is sent to the e-mail address entered

**Access the URL in the e-mail, register the information, and complete the user registration**

1. When an e-mail with the subject "Information on Canon Inkjet Cloud Printing Center" is sent to the e-mail address that you entered, select the URL

2. In the **License agreement** and **Privacy statement** windows of Canon Inkjet Cloud Printing Center, read the statements, and select **Agree** if you agree
3. Configure required settings on the User information input screen, and then select **OK**
Time zone
Select your region on the list. If you cannot find your region on the list, select the one closest to your region.

Apply daylight saving time
This appears only when there is a daylight saving time in the time zone that you selected. Select whether or not to apply the daylight saving time.

Password
Enter the login password for Canon Inkjet Cloud Printing Center.

Password (Confirmation)
Enter the password again for confirmation.

Important
• There are character restrictions for the password, as shown below.
  • The password needs to be between 8 and 32 characters long, using single-byte alphanumeric characters and symbols ("#$%&'()*+,-./:;<=>?@[\]^_`{|}~). (Alphabets are case-sensitive)

The registration is completed. The registration completed message appears. When you press OK, the Login screen appears.
Enter the registered e-mail address and password and log in to the Canon Inkjet Cloud Printing Center.

See here for the details of the Login screen

Using Canon Inkjet Cloud Printing Center

When the user registration is completed, you can log in to the Canon Inkjet Cloud Printing Center and use the service.

1. From your PC, smartphone, or tablet, access the service login URL (http://cs.c-ij.com/)

2. On the Login screen, enter the **E-mail address** and **Password**, and then select **Log in**

---

**Important**

- The e-mail address and password are case-sensitive. Make sure the case is correct.
E-mail address
Enter the e-mail address that you entered in the user registration.

Password
Enter the password that you entered in the user registration.

**Important**

- If you fail to log in five straight times, you will not be able to login again for an hour.
- You remain logged in for an hour after the last access.
- If you do not log in for 400 days, you will be unsubscribed from the Canon Inkjet Cloud Printing Center automatically.
- The service may not function properly if you log in from multiple devices at the same time.

After logging in, you can use useful services such as adding/managing apps that work in conjunction with this product's cloud functionality and checking the ink status.

For the description of the screens and operation, see [here](#).

**Printing procedure**

This section introduces the photo printing procedure by using CANON iMAGE GATEWAY as an example.

**Important**

- The available functions differ depending on the app.
- The printing procedure differs depending on the app.
- You need to get the account and register photo and other data beforehand.
- The following file formats can be printed: jpg, jpeg, pdf, docx, doc, xlsx, xls, pptx, ppt, txt, and rtf.
  The file formats that can be printed differ depending on the app.
- Before you print, check that printer is on and is connected to the network. Then start.

**Note**

- You can use CANON iMAGE GATEWAY to print jpg and jpeg file formats.
1. On the Main screen, select the app to be used

2. Enter the information according to the instructions on the authentication screen, and then select **Log in**

![Login Screen](image)

3. In the displayed album list, select the album of your choice

![Album List](image)

4. In the displayed image list, select the image that you want to print, and then select **Next**
5. Make the necessary print settings, and then select **Print**

6. A print job completion message appears, and printing starts
To end the printing, select Exit and return to the Apps list screen.
To continue printing, select Continue and repeat the procedure from step 3.

--- Important ---

- If a print job is not printed within 24 hours after the print job is issued, the print job will expire and cannot be printed.
- With premium apps that limit the number of print jobs, print jobs that expire and cannot be printed are also included in the print count.

Troubleshooting Canon Inkjet Cloud Printing Center

- If an app cannot be installed
- If the registered app is not in the Apps list
- If the information is not updated when you press the Update button
- If you do not receive the registration e-mail
- Printing starts on its own even if you do not do anything

If an app cannot be installed

Check the country or region where the printer was purchased.
If the printer is taken outside the country or region where it was purchased, apps cannot be installed.
For an app that is already installed, if the new region supports that app, you can continue to use it.
However, if you uninstall an app, be aware that you will not be able to install it outside of the country or region where the printer was purchased.

If the registered app is not in the Apps list

Check the display language of Canon Inkjet Cloud Printing Center.
If the display language is switched to a language that does not support an app, the app will not be displayed in the apps list but will continue to be registered.
If you switch back to the target language of the app, it will be displayed in the apps list and you will be able to start, register, or unregister the app.

If the information is not updated when you press the Update button

Because the Properties screen requires network connection with this product, the information may not be reflected immediately. Please wait awhile, and then try updating the information again.
If the information is still not updated, then check that the product is connected to the Internet.

If you do not receive the registration e-mail

Printing starts on its own even if you do not do anything

You may have entered a different e-mail address during the user registration of Canon Inkjet Cloud Printing Center.

On the printer's Home screen, select Setup -> Web service connection setup -> IJ Cloud Printing Center setup -> Delete from this service to prevent unauthorized access using this address.
After resetting the printer, repeat the user registration of Canon Inkjet Cloud Printing Center from the beginning.
Printing Your Printer Registration ID

Important

- Canon Inkjet Cloud Printing Center
  Models:
  MG7100 series, MG6400 series, MG5500 series

To add a printer by using Canon Inkjet Cloud Printing Center, you will need a Printer registration ID.

From the operation panel of this machine, print the URL of the authentication site and your Printer registration ID. The procedure is as follows:

1. Check that the printer is connected to the Internet.

   Important

   - To use this function, you must connect this printer to the Internet.

2. From the home window, select Setup -> Web service setup -> Web service connection setup -> IJ Cloud Printing Center setup -> Register with this service.

3. In the registration confirmation window, click Yes.

4. In the print settings, select the display language.

5. Follow the instructions displayed in the window, and print the URL of the authentication site and your Printer registration ID.

   Set A4 size or Letter size plain paper and select OK.
   The authentication site URL and your Printer registration ID are printed.

   Important

   - The operation to complete the registration should be done within 60 minutes.
Canon Inkjet Cloud Printing Center window

This section describes the Canon Inkjet Cloud Printing Center screens that are displayed on your smartphone, tablet device, or computer.

- Description of the Login screen
- Description of the Main screen

Description of the Login screen

This section provides the description of the Login screen of Canon Inkjet Cloud Printing Center.

- **Important**
  - You have 5 tries to enter your password. If you fail, you will not be able to log in for about the next hour.
  - You remain logged in for an hour after the last access.

**Language**
Select the language you will be using.
Then select **Update** to switch the language display.

**E-mail address**
Enter the e-mail address that you entered in the user registration.

**Password**
Enter the password that you entered in the user registration.

- **Important**
  - The e-mail address is case-sensitive. Make sure the case is correct.

**Reset password from here**
Select this if you forgot the password.
Reset your password by following the instructions on the screen.
Create new account
A new registration will be added to the Canon Inkjet Cloud Printing Center.
For a new registration, you need the Printer registration ID.

System requirements
This displays the system requirements for the Canon Inkjet Cloud Printing Center.

Help/legal notices (smartphone and tablet devices only)
The description of the Canon Inkjet Cloud Printing Center screen and various reminders are displayed.

Software license info (PC only)
The licensing information of Canon Inkjet Cloud Printing Center is displayed.

About Canon Inkjet Cloud Printing Center
This displays the descriptions of this service.

Description of the Main screen
When you log in to the Canon Inkjet Cloud Printing Center, the Main screen appears.
You can use areas shown below to start, add, and manage apps.
If you are using a smartphone or tablet, then you can also print photos and documents.

⇒ If you are using a smartphone or tablet
⇒ If you are using a PC

If you are using a smartphone or tablet

![Main screen of Canon Inkjet Cloud Printing Center]

(1) Mng. printer button
(2) Printer name area
(3) Context menu
(4) Display area
(5) Menu area

(1) Mng. printer button

Press the Mng. printer button to display the Mng. printer screen.

On the Mng. printer screen, you can check the printer information registered in the Canon Inkjet Cloud Printing Center, change the printer name, delete printers, add printers, and copy apps.

- **Check the printer information**

  The registered printer name is displayed.

  - indicates the currently selected printer.
  - indicates that an error occurred on the printer.

- **Change the printer name**

  When you select , a screen to change the printer name appears. Follow the instructions on the screen to change the name.

- **Delete printers**

  A screen appears to confirm the printer deletion. By selecting **OK**, the printer information will be deleted. If you want to clear the information saved on the printer, select the checkbox before **OK**. Otherwise, select **Cancel**.
When you select [X], the printer is deleted from the Canon Inkjet Cloud Printing Center. When transferring the ownership of the printer, select **Clear the information saved on the printer**.

**Add printers**

Select this to add printers to be used in the Canon Inkjet Cloud Printing Center. You need a [Printer registration ID](#) to add a printer.

**Note**

- Up to 16 printers are guaranteed to operate for each e-mail address.

**Copy apps**

Select this to copy apps added in the selected printer to another printer.

When you select [Copy apps], the screen shown below appears.

Set the **Destination printer** and the **Source printer**. Then select [OK].

**2) Printer name area**

The registered name of the printer selected is displayed. You can [change the printer name](#) in Mng. printer.

**3) Context menu**

When you select [ ], the context menu appears. The information displayed depends on the menu currently selected in the menu area. The [ ] symbol indicates that there is a new unread notice.
• **Sort**

This displays the screen to sort registered apps.

You can use the ▲ ▼ buttons to change the display order of apps. When you finish sorting, press the **Done** button to confirm the order.

• **Latest notices**

This displays the latest notices. The ❗ symbol indicates that there is a new unread notice.
• **User information**

  User information

  This displays the User information screen.

  You can change the registered e-mail address, password, language, time zone, and other settings.

• **Help/legal notices**

  Help/legal notices

  The description of the Canon Inkjet Cloud Printing Center screen and various reminders are displayed.

• **Log out**

  Log out

  This opens the Log out screen of the Canon Inkjet Cloud Printing Center.

(4) **Display area**

  The display changes based on the menu you select.

(5) **Menu area**

  The following 4 menu buttons are displayed:

  • **Apps**

    This displays the list of registered apps in the Display area.

    The Sort screen appears when you select Sort in the context menu.

  • **Config**

    This displays the Register apps screen in the Display area.

    The display can be toggled between Registered and Search apps.

    The Registered screen lists registered apps.

    You can check the information of these apps or deregister them.
On the **Search apps** screen, the apps that you can register by using the Canon Inkjet Cloud Printing Center are displayed by category.

- When you select the details of the app are displayed.

- When you select / , you can choose to register or unregister the app.

**Note**

- Description of displayed icons
  - : Cannot be used because it is not yet released or not available in your region.
  - : Can be used with genuine Canon ink.
• **Properties**

This screen displays the status of the printer that is currently selected. You can check how much ink is remaining or details about an error that occurred. You can also access the ink purchasing site and the *Online Manual*.

**Important**

- The Properties displayed may differ from the actual status at the display time, depending on the printer status.

• **Status**

This screen displays the print status and the print history. You can check the print status by looking at **Print status list**, and the print history by looking at **Print history**. You can also cancel print jobs and delete history information. To cancel or delete a job, select that job and then select **Cancel** or **Delete**.

**If you are using a PC**

![Diagram of the printer interface]

- **Mng. printer button**
- **Printer name area**
- **Menu area**
- **Notices area**
- **Information area**
- **Global navigation area**
- **Display area**
(1) Mng. printer button

Press the Mng. printer button to display the Mng. printer screen.

On the Mng. printer screen, you can check the printer information registered in the Canon Inkjet Cloud Printing Center, display the printer information update date/time, change the printer name, delete printers, add printers, and copy apps.

- **Check the printer information**

  ![Screen capture of Mng. printer](image)

  The registered printer name is displayed.

  ![Check symbol](image)
  indicates the currently selected printer.

  ![Warning symbol](image)
  indicates that an error occurred on the printer.

- **Display update date/time of the printer information**

  ![Screen capture of Mng. printer](image)

  This displays the date and time the printer information was last updated.

  ![Refresh button](image)
  refreshes the information.

- **Change the printer name**

  When you select ![Edit symbol](image), a screen to change the printer name appears.

  Follow the instructions on the screen to change the name.
• **Delete printers**

When you select [X], the printer is deleted from the Canon Inkjet Cloud Printing Center. When transferring the ownership of the printer, select **Clear the information saved on the printer**.

• **Add printers**

Select this to add printers to be used in the Canon Inkjet Cloud Printing Center. You need a **Printer registration ID** to add a printer.

**Note**

- Up to 16 printers are guaranteed to operate for each e-mail address.

• **Copy apps**

Select this to copy apps added in the selected printer to another printer.

When you select [Copy apps], the screen shown below appears.

(2) **Printer name area**

The registered name of the printer selected is displayed.

You can **change the printer name** in Mng. printer.
(3) Menu area

The following 4 menu buttons are displayed:

- **Sort**
  
  This displays the list of registered apps in the Display area.
  
  Drag the app to change the order.

  ![Sort Menu](image)

  When you finish sorting, press the **Set sort order** button and confirm the order.

- **Config**
  
  This displays the Register apps screen in the Display area.
  
  The display can be toggled between **Registered** and **Search apps**.

  The **Registered** screen lists registered apps.
  
  You can check the information of these apps or deregister them.

  ![Config Menu](image)

  On the **Search apps** screen, the apps that you can register by using the Canon Inkjet Cloud Printing Center are displayed by category.
When you select the details of the app are displayed. When you select / OFF, you can choose to register or unregister the app.

**Note**

- Description of displayed icons
  - Cannot be used because it is not yet released or not available in your region.
  - Can be used with genuine Canon ink.

**Properties**

This screen displays the status of the printer that is currently selected. You can check how much ink is remaining or details about an error that occurred. You can also access the ink purchasing site and the *Online Manual*.

**Important**

- The Properties displayed may differ from the actual status at the display time, depending on the printer status.

**Status**

This screen displays the print status and the print history. You can check the print status by looking at *Print status list*, and the print history by looking at *Print history*.

You can also cancel print jobs and delete history information.

To cancel or delete a job, select that job and then select **Cancel** or **Delete**.
(4) Notices area
This displays the latest notice. Nothing is displayed in this area if there is no notice.
When you select Notice list, you can display up to 40 items.

(5) Information area
This display other information, including the privacy statement and other companies' licensing information.

(6) Global navigation area
The User information, Instructions, and Log out buttons are displayed.
Press the User information to change the settings.

(7) Display area
The display changes based on the menu you select.
Requirements for Canon Inkjet Cloud Printing Center operation

The system requirements for using Canon Inkjet Cloud Printing Center are described below.
Please note these points when you use this service.

System requirements

When using a computer

<table>
<thead>
<tr>
<th></th>
<th>CPU</th>
<th>RAM</th>
<th>Monitor display</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x86 or x64 1.6 GHz or higher</td>
<td>2 GB or higher</td>
<td>Resolution 1024 x 768 pixels or higher Number of display colors 24 bits (true-color) or higher</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OS</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP SP3 or later</td>
<td>Internet Explorer 8*</td>
</tr>
<tr>
<td></td>
<td>Mozilla Firefox 18.0.1 or later</td>
</tr>
<tr>
<td></td>
<td>Google Chrome 24.0.1312.60 or later</td>
</tr>
<tr>
<td>Windows Vista SP1 or later</td>
<td>Internet Explorer 8*, 9</td>
</tr>
<tr>
<td></td>
<td>Mozilla Firefox 18.0.1 or later</td>
</tr>
<tr>
<td></td>
<td>Google Chrome 24.0.1312.60 or later</td>
</tr>
<tr>
<td>Windows 7</td>
<td>Internet Explorer 8*, 9, 10</td>
</tr>
<tr>
<td></td>
<td>Mozilla Firefox 18.0.1 or later</td>
</tr>
<tr>
<td></td>
<td>Google Chrome 24.0.1312.60 or later</td>
</tr>
<tr>
<td>Windows 8</td>
<td>Internet Explorer 10 (Classic/Metro version)</td>
</tr>
<tr>
<td></td>
<td>Mozilla Firefox 18.0.1 or later</td>
</tr>
<tr>
<td></td>
<td>Google Chrome 24.0.1312.60 or later</td>
</tr>
<tr>
<td>Mac OS X v.10.4.11-10.8</td>
<td>Safari 5.1-5.3</td>
</tr>
</tbody>
</table>

* When you use Internet Explorer 8, the web pages may not display correctly.
Canon recommends that you upgrade to Internet Explorer 9 or later. If you are using Windows XP, Canon recommends that you use another browser, such as Mozilla Firefox.

When using a smartphone or a tablet device

<table>
<thead>
<tr>
<th>OS</th>
<th>Browser</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>iOS 5.1 or later</td>
<td>OS standard browser</td>
<td>320 x 480 (HVGA) or higher</td>
</tr>
<tr>
<td>Android 2.3.3 or later</td>
<td></td>
<td>480 x 800 (HVGA) or higher</td>
</tr>
</tbody>
</table>

• On the browser you are using, enable JavaScript.
• On the browser you are using, enable cookies.
• Canon recommends that you do not use the zoom function or change the font size on your browser. Otherwise, the Canon Inkjet Cloud Printing Center pages may not display correctly.
• Canon recommends that you do not use the translation function of Google Chrome. Otherwise, the Canon Inkjet Cloud Printing Center pages may not display correctly.
• Canon recommends that you do not use a proxy server outside of your country. Otherwise, the service may not be able to determine the correct region.
Using Remote UI

This service allows you to check printer information and execute utility functions from your computer or smartphone.

You can also use the convenient web services presented by Canon.

Checking the printer IP address

To use this service, first check the IP address of this machine from the operation panel of the machine.

>>> Important

- Before you check the IP address of this machine or use the Remote UI, make sure that the machine is connected to the LAN and the LAN environment is connected to the Internet. Note that the customer is responsible for paying all Internet connection fees.

1. Check that the machine has been turned on

If your printer has a LCD monitor

2. From the home window, select Setup -> Device settings -> LAN settings -> Confirm LAN settings -> WLAN setting list or LAN setting list. Then from the displayed window, check the IP address.

>>> Note

- To print the IP address, load one sheet of A4 size or Letter size plain paper. Then from the home window, select Setup -> Device settings -> LAN settings -> Confirm LAN settings -> Print LAN details, in sequence.
If your printer does not have a LCD monitor

2. Load one sheet of A4 size or Letter size plain paper

3. Hold down the Stop button until the Alarm lamp flashes 15 times

4. Release the button
   Printing of the network setup information starts.

Remote UI startup

In the Web browser, directly enter the IPv4 address that you checked from the LCD monitor of the machine. The Remote UI starts.

1. From your computer, smartphone, or tablet device, open the Web browser, and enter the following URL:
   http://<Printer IP address>
   For "<Printer IP address>" enter the IP address that you checked in "Checking the printer IP address."

2. Remote UI startup
   The Remote UI starts and the top window is displayed.

   ![Remote UI startup](image)

Printer status

This function displays printer information such as the remaining ink amount, the status, and detailed error information.
You can also connect to the ink purchase site or support page, and use Web Services.

Utilities

This function allows you to set and execute the machine utility functions such as cleaning.
**AirPrint settings**
This function allows you to specify the Apple AirPrint settings, such as position information.

**Google Cloud Print setup**
This function allows you to register this machine to Google Cloud Print or delete the machine.

**Firmware update**
This function allows you to update the firmware and check version information.

**Manual (Online)**
This function displays the *Online Manual.*

**Network Configuration**
This function displays the network settings.
Printing from AirPrint Compliant Device

This document explains how to use AirPrint to print wirelessly from your iPad, iPhone and iPod touch to a Canon printer.

AirPrint enables you to print photos, email, Web pages and documents from your Apple device directly to your printer without installing a driver.

Checking Your Environment

First, check your environment.

- **AirPrint Operation Environment**
  
  To use AirPrint, you will need one of the following Apple devices running the latest version of iOS:
  
  ◦ iPad (all models)
  ◦ iPhone (3GS or later)
  ◦ iPod touch (3rd generation or later)

- **Network Environment**
  
  The Apple device (iPad, iPhone, or iPod touch) and this machine must be connected to the same Wi-Fi network.

Printing with AirPrint

1. Check that this machine is turned on and is connected to the LAN.

2. From the app of your Apple device, tap the operation icon to display the menu options.
3. From the menu options, tap **Print**.

4. From **Printer Options**, select the model that you are using.

   **Important**
   - Because some app does not support AirPrint, **Printer Options** may not be displayed. If an app does not let you use printer options, you cannot print from that app.

   **Note**
   - The printer options differ depending on the app and model you are using. Normally, when you tap **Print** and select a model name, the displayed printer options will include up to the following four options:
     - **Printer**: Select a model that can be used in your wireless LAN.
• Copies: Select the number of print copies.
• Duplex Printing: If the model supports duplex printing, you can select On or Off.
• Range: The page range can be used only with specific app and file types (such as PDF files).

5. For 1 Copy, click + or - to set the number of required copies.

6. For Duplex Printing, click On to enable duplex printing or click Off to disable the function.

7. When printing a file type that has multiple pages, such as a PDF file, click Range and then click All Pages or select the range of pages to be printed.

8. Tap the Print.
   When you execute printing, the printer prints according to the specified settings.

Paper Size

With AirPrint, the paper size is selected automatically according to the app being used on the Apple device and the region in which AirPrint is used.

When Apple's photo app is used, the default paper size is L size in Japan, and 4”x6” or KG in other countries and regions.

When documents are printed from Apple's Safari app, the default paper size is letter size in the U.S. region, and A4 in Japan and Europe.

Important
• Your app may support different paper sizes.

Checking the Print Status

During printing, a Print icon is displayed in the list of recently used app, and you can use it to check the print progress.

To display the list of latest used app, press the Home button on the Apple device twice. The Print icon is displayed at the bottom of the Home screen.
Deleting a Print Job

To delete a print job with AirPrint, use one of the following two methods:

- From the machine: If your printer has a LCD monitor, use the operation panel to cancel the print job. If your printer does not have a LCD monitor, press the Stop button on the machine to cancel the print job.
- From an Apple device: Press the Home button on the Apple device twice. Tap the Print icon and display the print job list. Tap the print job to be canceled, and then tap Cancel Print.

AirPrint Troubleshooting

If the document does not print, check the following:

1. Check that the machine power is on. If the machine power is on, turn it off and then back on again, and check whether the issue is resolved.

2. Check that the machine is connected by LAN to the same network subnet as the device on which iOS is installed.

3. Check that the machine has enough paper and ink.

4. If your printer has a LCD monitor, check that no error message is displayed on the LCD monitor.

   If the problem persists, use the printer driver on your computer to execute printing and check whether the document can be printed normally on the machine.

   If the document cannot be printed, refer to the Online Manual for your model.
Note

- After you turn on the machine, it may take few minutes before the machine can communicate through a wireless LAN connection. Confirm that the machine is connected to the wireless LAN, and then try printing.
- If Bonjour on the machine is disabled, AirPrint cannot be used. Check the LAN settings on the machine, and enable Bonjour.

Note

- The windows used in the explanations may differ from those displayed by your Apple product or app.
How to Use Print from E-mail

Print from E-mail allows you to print attachment files easily. You only attach a picture or a document from your computer or smartphone and send the e-mail with the attached file.

You can print simply from outside like a travel destination. Also, your family or friends can print by registering beforehand.

You can use Print from E-mail on any Canon printer that supports the service.

Checking Your Environment

First, check your environment.

- **Network environment**
  - This product needs to be connected to a LAN with an Internet connection.

  ➤Important
  - The user will bear the cost of Internet access.
  - This function may not be available in some countries/regions.
  - Depending on your printer model, this function may not be available.

- **Printer software (firmware) version**
  - If the printer's firmware version is earlier than Ver. 2.000, you need to update the firmware.
  - You can execute firmware update from Remote UI or from your printer.
  - To execute the update from Remote UI, refer to the Remote UI usage instructions.
  - To execute the update from your printer, go to the Online Manual home page, and refer to the "Firmware Update" document for your printer model.

Preparing to use Print from E-mail

To use Print from E-mail, you need to register the printer by entering information about the printer's owner.
1. Print the printer registration page's URL and the PIN code

2. Access the URL and enter the owner's e-mail address and other required information

3. Check if an e-mail has been sent to the e-mail address you entered

4. Access the URL provided in the e-mail and complete the printer registration process

**Note**

- The e-mail address that appears on the screen when you have finished registering is the e-mail address that will be used just for the **Print from E-mail** function.

- For details about the registration procedure, see here

### Printing from Your Computer or Smartphone

1. Prepare a file that you want to print

   The file format, number of files, and file size that this printing function supports are provided below.

   **Supported File Formats**
   - Adobe PDF files
   - JPEG files

   **Important**
   - Only files that are attached to e-mail can be printed. E-mail messages cannot be printed.
   - Encrypted Adobe PDF files, password-protected files, and files that are set to print disabled cannot be printed.
   - Files that are attached as compressed files cannot be printed.
   - Files other than Adobe PDF files and JPEG files cannot be printed.

   **Supported Number of Files and File Sizes**
   - Up to 10 attachment files can be printed.
   - The maximum size of an e-mail with attachment files is 5 MB.

   **Note**
   - The size of an e-mail is determined based on the size of the entire transmission file, including the e-mail message and the header. Therefore sometimes an attachment file cannot be printed even if the size of the attachment file is less than 5 MB.
   - If the size of an attached JPEG file is less than 10 KB, the file cannot be printed.

2. Attach a file that you want to print from your PC or smartphone to the e-mail and send it to the e-mail address for printing

   To check the printer address, perform one of the following operations from the operation panel of this machine:
• From the operation panel of this machine, display the home window and select Setup -> Web service setup -> Web service connection setup -> Print from E-mail setup -> Check address for printing.

• From the operation panel of this machine, select Web service -> Web service setup -> Cloud settings -> Print from E-mail setup -> Check address for printing.

**Important**

• You will not be able to use the service during periods when the service is undergoing maintenance.

### Use the Service With More Than One Person

To allow multiple users to use this function, register users (other than the printer's owner) as members.

1. The printer's owner uses his/her PC or smartphone to access the service's login URL (https://pr.mp.c-ij.com/po) and logs in

2. Select the printer name that you want to add the member. Click Member Settings -> Add to enter the member's e-mail address, and click Register

   A URL of the member registration page is sent to the e-mail address of the newly registered member.

3. Registered member accesses to the URL that is included in the e-mail, and complete the registration

   You can use this service from registered e-mail address.

### Note

• You can register up to 500 members.

### Print from E-mail Troubleshooting

- The Document Does Not Print
- If You Cannot Register to the Service or Delete the Service
- If You Cannot Print after the Printer Is Repaired

### The Document Does Not Print

If the document does not print, check the following:

• Check that the printer power is on.
  If the printer power is on, turn it off and then back on again, and check whether the issue is resolved.
• Check that the printer is connected to the network.
• Check that the printer is connected to a LAN and the LAN has an Internet connection.
• Look at the printer LCD monitor and check that no error message is displayed.
  If the problem persists, use the printer driver on your computer to execute printing and check whether
the document can be printed normally on the printer.
If the document cannot be printed, refer to the on-screen manual (operating instructions) that comes
with the printer.

• Check that the file attached to the e-mail is a Adobe PDF file or an JPEG file.
• Check whether the e-mail address of the send destination is correct.
To check the printer address, perform one of the following operations from the operation panel of this
machine:

◦ From the operation panel of this machine, display the home window and select

![Setup -> Web service setup -> Web service connection setup -> Print from E-mail setup ->
Check address for printing.]

◦ From the operation panel of this machine, select

![Web service -> Web service setup -> Cloud settings -> Print from E-mail setup -> Check address for printing.]

• Check that the user's e-mail address for using this service is registered.
If you want to check the error details, the printer owner have to access the login URL (https://pr.mp.c-
ij.com/po).
• In the Print Status screen, click Go to Print History Screen and check the history of jobs that were
sent. You can check the error details.
If you want to check the error details, the printer owner have to access the login URL (https://pr.mp.c-
ij.com/po).

Note

• For a wireless LAN connection, after the printer is turned on, it may take a few minutes before
communication becomes possible. Confirm that your printer is connected to the wireless LAN, and
then try printing.

If You Cannot Register to the Service or Delete the Service

If You Cannot Register to the Service

• If the printer operation panel display the message "Failed to register with "Print from E-mail".", the
registration to Print from E-mail may not have been completed in time. Select OK to release the
error, and start over again from the beginning.
• Check that the firmware version of the printer has been updated.

If You Do Not Receive the URL to Complete the Registration by E-mail

• An incorrect e-mail address may have been entered. Wait about 30 minutes, and operate the printer
operation panel to print the printer registration URL and PIN code. Then re-register from the
beginning.

If You Cannot Delete the Service

• If the printer operation panel display the message "Failed to connect to "Print from E-mail". Only the
information on the printer was deleted." is displayed, it could be that the registration information on the
service could not be deleted even though the Print from E-mail information stored on this machine
was deleted.
Select OK to release the error, and then access the service's login URL (https://pr.mp.c-ij.com/po) to
delete the registration information.
• If the Print from E-mail information stored on this printer could not be deleted even though the registration information on the service was deleted, delete the registration information from Deregistration of Registered Printer(s) by performing one of the following operations:

  ◦ From the operation panel of this machine, display the home window and select Setup -> Web service setup -> Web service connection setup -> Print from E-mail setup -> Deregistration of Registered Printer(s).

  ◦ From the operation panel of this machine, select Web service -> Web service setup -> Cloud settings -> Print from E-mail setup -> Deregistration of Registered Printer(s).

If You Cannot Print after the Printer Is Repaired

Re-registering the printer and the printer owner

  • When the printer is repaired, all of the registered information is deleted and Print from E-mail can no longer be used.

  If you want to use this service again, you must re-register the printer and the printer owner. For information about the re-registration procedure, see "Preparing to Use Print from E-mail". Even if users other than the owner were registered as members, repeat the registration starting from here.

Trademarks

  • Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other countries.

  • Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other countries.

  • Mac OS, Bonjour, iPad, iPhone, iPod touch, and Safari are trademarks of Apple Inc., registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.

  • IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

  • All other company names and products mentioned herein may be trademarks or registered trademarks of their respective companies.
Preparing to Use Print from E-mail

To use this service to print a photo or document, you need to follow the procedure provided below and register the machine.

Print the Printer Registration Page's URL and the PIN Code

First, print the printer registration page's URL and the PIN code.
Check that there is sufficient amount of ink in the machine, and then print using the machine's operation panel.

1. Check that the machine is connected to the network

   Important

   • This product needs to be connected to a LAN with an Internet connection.

2. From the operation panel of this machine, display the home page and select Register printer by performing one of the following operations:

   • From the operation panel of this machine, display the home window and select Setup -> Web service setup -> Web service connection setup -> Print from E-mail setup -> Register printer.

   • From the operation panel of this machine, display the home window and select Web service -> Web service setup -> Cloud settings -> Print from E-mail setup -> Register printer.

3. Follow the instructions on the screen and print the printer registration URL and PIN code

   Important

   • Do not turn off the power on the machine until the registration process is completed. Access the printed URL and log in within 25 minutes.

   • If you canceled the registration before it is completed, repeat the procedure from printing the registration information.

Access the Printed URL and Enter the Owner's E-mail Address and Other Required Information

Next, enter the owner's e-mail address and other required information.

1. Access the printed URL using the PC's web browser, and click Log In

2. In the use agreement window, select Agree
3. Enter the printer owner's e-mail address, and click Next

**Important**

- An e-mail is sent with the required information for completing the registration to the e-mail address entered for the printer's owner.
- If domain-specific reception is set, change the setting so that mail can be received from "info@mp.c-ij.com"

**Note**

- The e-mail address of the printer owner cannot be changed once the printer owner is registered. To change the e-mail address, delete the registration of the registered printer, and re-register the printer owner by using the new e-mail address. In this case, all previously registered information will be deleted.
- The notification is sent automatically to the registered e-mail address when the printing or service maintenance starts.

4. In the **Printer Owner Registration** window, enter the information shown below, and click Next

**User Name**

Enter any name. The name that you enter is displayed at login.

**Important**

- The maximum number of characters that can be entered is 30.

**Language**

Select the language that you are using. The language that you select is used in notification e-mails such as print start notices.

**Time Zone**

Refer to this section, and select the standard time of the city that is nearest to the region where you live.

**Date/Time Display Format**

Select the format of your choice. The format that you select is applied to the date/time information in the screens and notification e-mails of this service.

**Daylight Saving Time**

This setting is combined with the Time Zone setting, and applied to the date/time information in the screens and notification e-mails of this service. When you select **ON**, 1 hour is added to the Time Zone setting when the date/time information is displayed.

5. In the **Printer Registration** window, enter the **Printer Name**, and click **Confirm**
Enter any name that will allow you to identify the printer.

**Important**

- The maximum number of characters that can be entered is 30.

6. In the **Confirm Owner Registration** window, check the registration information, and then click **Register**

A temporary password will be displayed.

**Important**

- The temporary password that appears is not included in the notification e-mail. Be sure to write down the temporary password before closing the screen.

**Check if an E-mail Has Been Sent to the E-mail Address You Entered**

A URL is notified to complete the registration to the e-mail address that for the registered printer’s owner.

**Access the URL in the E-mail and Complete the Printer Registration**

1. Access the URL provided in the e-mail

**Important**

- You have to complete the registration within 30 minutes.

2. Enter the registered e-mail address of the printer’s owner, the temporary password, and click **Log In**

3. Set a password of your choice, and click **Register**

When the password setting process is completed, the printer’s e-mail address and the service’s URL are displayed, and the printer’s registration process is completed.

**Important**

- When you enter the password, the following character restrictions apply.
  - Set a password that has 8 or more characters.
  - The characters that you can use are single-byte uppercase letters, single-byte lowercase letters, and single-byte numbers.
  - In the password, combine all of the different types of characters that can be used.
- The displayed printer’s e-mail address and the URL of the login page are not sent. Be sure to write down the printer’s e-mail address and the URL of the login page before closing the screen.
## Timezone List

<table>
<thead>
<tr>
<th>Timezone (UTC)</th>
<th>Timezone Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UTC-12:00</td>
<td>International Date Line West</td>
</tr>
<tr>
<td>UTC-11:00</td>
<td>Midway Island</td>
</tr>
<tr>
<td>UTC-10:00</td>
<td>Hawaii</td>
</tr>
<tr>
<td>UTC-09:00</td>
<td>Alaska</td>
</tr>
<tr>
<td>UTC-08:00</td>
<td>Tijuana, Baja California, Pacific Time (US &amp; Canada)</td>
</tr>
<tr>
<td>UTC-07:00</td>
<td>Arizona, Chihuahua, La Paz, Mazatlan, Mountain Time (US &amp; Canada)</td>
</tr>
<tr>
<td>UTC-06:00</td>
<td>Guadalajara, Mexico City, Monterrey, Saskatchewan, Central America, Central Time (US &amp; Canada)</td>
</tr>
<tr>
<td>UTC-05:00</td>
<td>Indiana (East), Bogota, Lima, Quito, Eastern Time (US &amp; Canada), Caracas</td>
</tr>
<tr>
<td>UTC-04:00</td>
<td>Asuncion, Santiago, Georgetown, La Paz, San Juan, Manaus, Atlantic Time (Canada), Newfoundland</td>
</tr>
<tr>
<td>UTC-03:00</td>
<td>Cayenne, Greenland, Buenos Aires, Brasilia, Montevideo</td>
</tr>
<tr>
<td>UTC-02:00</td>
<td>Mid-Atlantic</td>
</tr>
<tr>
<td>UTC-01:00</td>
<td>Azores, Cape Verde Is.</td>
</tr>
<tr>
<td>UTC-00:00</td>
<td>Casablanca, Dublin, Edinburgh, Lisbon, London, Monrovia, Reykjavik, Coordinated Universal Time</td>
</tr>
<tr>
<td>UTC+01:00</td>
<td>Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna, Sarajevo, Skopje, Warsaw, Zagreb, Brussels, Copenhagen, Madrid, Paris, Belgrade, Bratislava, Budapest, Ljubljana, Prague, West Central Africa</td>
</tr>
<tr>
<td>UTC+02:00</td>
<td>Athens, Bucharest, Istanbul, Amman, Windhoek, Jerusalem, Cairo, Harare, Pretoria, Beirut, Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius, Minsk</td>
</tr>
<tr>
<td>UTC+03:00</td>
<td>Kuwait, Riyadh, Tbilisi, Nairobi, Baghdad, Moscow, St. Petersburg, Volgograd, Tehran</td>
</tr>
<tr>
<td>UTC+04:00</td>
<td>Abu Dhabi, Muscat, Yerevan, Baku, Port Louis, Kabul</td>
</tr>
<tr>
<td>UTC+05:00</td>
<td>Islamabad, Karachi, Ekaterinburg, Tashkent, Sri Jayawardanepura, Chennai, Kolkata, Mumbai, New Delhi, Kathmandu</td>
</tr>
<tr>
<td>UTC+06:00</td>
<td>Astana, Dhaka, Almaty, Novosibirsk, Yangon (Rangoon)</td>
</tr>
<tr>
<td>UTC+07:00</td>
<td>Krasnoyarsk, Bangkok, Hanoi, Jakarta</td>
</tr>
<tr>
<td>UTC+08:00</td>
<td>Irkutsk, Ulaan Batar, Kuala Lumpur, Singapore, Perth, Taipei, Beijing, Chongqing, Hong Kong, Urumqi</td>
</tr>
<tr>
<td>UTC+09:00</td>
<td>Seoul, Yakutsk, Osaka, Sapporo, Tokyo, Adelaide, Darwin</td>
</tr>
<tr>
<td>UTC+10:00</td>
<td>Vladivostok, Canberra, Melbourne, Sydney, Guam, Port Moresby, Brisbane, Hobart</td>
</tr>
<tr>
<td>UTC+11:00</td>
<td>Magadan, Solomon Is., New Caledonia</td>
</tr>
<tr>
<td>UTC+12:00</td>
<td>Auckland, Wellington, Fiji, Marshall Is., Petropavlovsk-Kamchatsky</td>
</tr>
<tr>
<td>UTC+13:00</td>
<td>Samoa, Nuku'alofa</td>
</tr>
</tbody>
</table>
Overview of the Machine

➤ Safety Guide
  ➤ Safety Precautions
  ➤ Regulatory and Safety Information

➤ Main Components and Basic Operations
  ➤ Main Components
  ➤ About the Power Supply of the Machine
  ➤ LCD and Operation Panel

➤ Loading Paper / Originals
  ➤ Loading Paper
  ➤ Loading Originals

➤ Replacing an Ink Tank
  ➤ Replacing an Ink Tank
  ➤ Checking the Ink Status

➤ Maintenance
  ➤ When Printing Becomes Faint or Colors Are Incorrect
  ➤ Performing Maintenance from a Computer
  ➤ Cleaning the Machine

➤ Changing the Machine Settings
  ➤ Changing Machine Settings from Your Computer
  ➤ Changing the Machine Settings on the LCD

➤ Information about Network Connection
  ➤ Useful Information about Network Connection

➤ About Network Communication
  ➤ Changing and Confirming Network Settings
  ➤ Screens for Network Connection of IJ Network Tool
  ➤ Other Screens of IJ Network Tool
  ➤ Appendix for Network Communication

➤ Tips for Ensuring Optimal Printing Quality
  ➤ Useful Information about Ink
  ➤ Key Points to Successful Printing
  ➤ Be Sure to Make Paper Settings after Loading Paper
  ➤ Canceling a Print Job
  ➤ Key to Enjoying Consistent Printing Quality
  ➤ Precautions for Safe Transport of the Machine

➤ Legal Limitations on Use of Your Product and Use of Images

➤ Specifications
Safety Guide

- Safety Precautions
- Regulatory and Safety Information
Safety Precautions

Choosing a location
Do not install the machine in a location that is unstable or subject to excessive vibration.
Do not install the machine in locations that are very humid or dusty, in direct sunlight, outdoors, or close to a heating source.
To avoid the risk of fire or electric shocks, use the machine under the operating environment specified in the On-screen Manual.
Do not place the machine on a thick rug or carpet.
Do not place the machine with its back attached to the wall.

Power supply
Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the power cord if necessary.
Never remove the plug by pulling on the cord.
Pulling the cord may damage the power cord, leading to possible fire or electrical shock.
Do not use an extension lead/cord.

Working around the machine
Never put your hands or fingers in the machine while it is printing.
When moving the machine, carry the machine at both ends. In case the machine weighs more than 14 kg, it is recommended to have two people lifting the machine. Accidental dropping of the machine causes injury. For the machine's weight, refer to the On-screen Manual.
Do not place any object on the machine. Especially do not place metal objects (paper clips, staples, etc.) or containers of flammable solvents (alcohol, thinners, etc.) on top of the machine.
Do not transport or use the machine on a slant, vertically or upside-down, as the ink may leak and damage the machine.

Working around the machine (For the multifunction printer)

Print Heads/ink tanks and FINE Cartridges
Keep ink tanks out of the reach of children. In case ink* is accidentally licked or swallowed, rinse out mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical advice immediately.
* Clear Ink contains nitrate salts (For models containing Clear Ink).
In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice immediately.
Never touch the electrical contacts on a Print Head or FINE Cartridges after printing.
The metal parts may be very hot and could cause burns.
Do not throw ink tanks and FINE Cartridges into fire.
Do not attempt to disassemble or modify the Print Head, ink tanks, and FINE Cartridges.
Regulatory and Safety Information

International ENERGY STAR® Program
As an ENERGY STAR Partner, Canon Inc. has determined that this product meets the ENERGY STAR guidelines for efficiency.

About the disposal of the battery (For models containing lithium battery)
Dispose of used batteries according to the local regulations.

Users in the U.S.A.
FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10393/K10394/K10395/K10397 (Contains FCC ID: AZDK30356)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.
Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.
Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If such changes or modifications should be made, you could be required to stop operation of the equipment.

FCC ID: AZDK30356

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate equipment.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The equipment complies with FCC radiation exposure limits for at uncontrolled equipment. This equipment should be installed and operated with minimum distance at least 20cm between the radiator and persons body (excluding extremities: hands, wrists, feet and ankles) and must not be colocated or operated with any other antenna or transmitter.

Canon U.S.A., Inc.
One Canon Park
Melville, New York 11747
1-800-652-2666

Users in Canada

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment and meets RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated keeping the radiator at least 20cm or more away from person's body (excluding extremities: hands, wrists, feet and ankles).

Pour les usagers résidant au Canada

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence.

L'exploitation est autorisée aux deux conditions suivantes :

(1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.
Cet équipement est conforme aux limites d'exposition aux rayonnements énoncées pour un environnement non contrôlé et respecte les règles d'exposition aux fréquences radioélectriques (RF) CNR-102 de l'IC. Cet équipement doit être installé et utilisé en gardant une distance de 20 cm ou plus entre le dispositif rayonnant et le corps (à l'exception des extrémités : mains, poignets, pieds et chevilles).

**Users in Jordan**

This printer contains WLAN Module approved by TRC/SS/2013/36

Name of WLAN Module : K30356

**European Union (and EEA) only.**

This symbol indicates that this product is not to be disposed of with your household waste, according to the WEEE Directive (2002/96/EC) and your national law. This product should be handed over to a designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar product or to an authorized collection site for recycling waste electrical and electronic equipment (EEE). Improper handling of this type of waste could have a possible negative impact on the environment and human health due to potentially hazardous substances that are generally associated with EEE. At the same time, your cooperation in the correct disposal of this product will contribute to the effective usage of natural resources. For more information about where you can drop off your waste equipment for recycling, please contact your local city office, waste authority, approved WEEE scheme or your household waste disposal service. For more information regarding return and recycling of WEEE products, please visit www.canon-europe.com/environment.

(EEA: Norway, Iceland and Liechtenstein)

**India only.**

This product is not to be disposed of with your household waste, according to the e-waste (Management and Handling) Rules, 2011.

This product should be handed over to a designated collection point, e.g., to an authorized collection site for recycling waste electrical and electronic equipment (EEE). Improper handling of this type of waste could have a possible negative impact on the environment and human health due to potentially hazardous substances that are generally associated with EEE. At the same time, your cooperation in the correct disposal of this product will contribute to the effective usage of natural resources. For more information regarding return and recycling of WEEE products, please visit http://www.canon.co.in/environment/.
Also, this product complies with the "India E-waste Rule 2011" and prohibits use of lead, mercury, hexavalent chromium, polybrominated biphenyls or polybrominated diphenyl ethers in concentrations exceeding 0.1 % by weight and 0.01 % by weight for Cadmium, except for the exemptions set in Schedule II of the Rule.

Environmental Information

Reducing your environmental impact while saving money

Power Consumption and Activation Time

The amount of electricity a device consumes depends on the way the device is used. This product is designed and set in a way to allow you to reduce your electricity costs. After the last print it switches to Ready Mode. In this mode it can print again immediately if required. If the product is not used for a time, the device switches to its Power Save Mode. The devices consume less power (Watt) in these modes.

If you wish to set a longer Activation Time or would like to completely deactivate the Power Save Mode, please consider that this device may then only switch to a lower energy level after a longer period of time or not at all.

Canon does not recommend extending the Activation Times from the optimum ones set as default.

Energy Star®

The Energy Star® programme is a voluntary scheme to promote the development and purchase of energy efficient models, which help to minimise environmental impact.

Products which meet the stringent requirements of the Energy Star® programme for both environmental benefits and the amount of energy consumption will carry the Energy Star® logo accordingly.

Paper types

This product can be used to print on both recycled and virgin paper (certified to an environmental stewardship scheme), which complies with EN12281 or a similar quality standard. In addition it can support printing on media down to a weight of 64g/m², lighter paper means less resources used and a lower environmental footprint for your printing needs.
Main Components and Basic Operations

- Main Components
- About the Power Supply of the Machine
- LCD and Operation Panel
Main Components

- Front View
- Rear View
- Inside View
- Operation Panel
Front View

(1) operation panel
Use to change the settings of the machine or to operate it. Also, lift and open it to replace an ink tank, to check the ink lamp, or to remove jammed paper inside the machine.

⇒ Operation Panel

(2) document cover
Open to load an original on the platen glass.

(3) paper guides
Slide to align with both sides of the paper stack.

(4) feeder
Load various sizes or types of paper which you can use on the machine. Two or more sheets of the same size and type of paper can be loaded at the same time, and fed automatically one sheet at a time.

⇒ Loading Plain Paper / Photo Paper
⇒ Loading Envelopes

(5) front tray
Open to load paper or perform the print operation.

(6) paper support
Extend to load paper in the front tray.

(7) output tray extension
Open to support ejected paper.
(8) paper output support
Extend to support ejected paper.

(9) paper output tray
Printed paper is ejected. Open it before printing.

(10) platen glass
Load an original to copy or scan.
Rear View

(1) transport unit
Open to remove jammed paper.

(2) power cord connector
Plug in the supplied power cord.

(3) USB port
Plug in the USB cable to connect the machine with a computer.

Important
- Do not touch the metal casing.
- Do not plug in or unplug the USB cable while the machine is printing or scanning originals with the computer.
Inside View

(1) **ink lamps**
Lights or flashes red to indicate the ink tank status.

- Checking the Ink Status with the Ink Lamps

(2) **print head holder**
The print head is pre-installed.

---

**Note**
- For details on replacing an ink tank, see [Replacing an Ink Tank](#).
Operation Panel

* All lamps on the operation panel are shown lit in the illustration below for explanatory purposes.

![Operation Panel Diagram](image)

(1) **ON button/POWER lamp**
   Turns the power on or off. Lights white after flashing when the power is turned on. Before turning on the power, make sure that the document cover is closed.
   ➤ Turning the Machine On and Off

(2) **HOME button**
   Used to display the HOME screen.
   ➤ LCD and Operation Panel

(3) **LCD (Liquid Crystal Display)**
   Displays messages, menu items, and the operational status.
   ➤ Confirming that the Power Is On

(4) **+ - buttons**
   Specifies the number of copies to copy or print.

(5) **Black button**
   Starts black & white copying, scanning, etc.

(6) **Color button**
   Starts color printing, copying, scanning, etc.

(7) **Stop button**
   Cancels operation when print, copy, or scan job is in progress.

(8) **Alarm lamp**
   Lights or flashes orange when an error occurs, such as paper-out or ink-out.

(9) **▲, ▼, ◀, and ▶ buttons**
   Used to select a menu or setting item.
   ➤ LCD and Operation Panel
(10) **OK button**
Finalizes the selection of a menu or setting item.
Resolves an error when printing is in progress or resumes the machine's normal operation after removing jammed paper.

(11) **Back button**
Returns the LCD to the previous screen.

(12) **Function buttons**
Used to select menus on the **HOME** screen or select a function menu displayed at the bottom of the LCD.

⇒ **Using the Function Buttons**

(13) **Wi-Fi lamp**
Lights or flashes blue to indicate the wireless LAN status.

**Lights:**
- **Wireless LAN active** is selected.

**Flashes:**
Printing or scanning over wireless LAN. Also flashes while configuring the wireless LAN connection.
About the Power Supply of the Machine

- Confirming that the Power Is On
- Turning the Machine On and Off
- Notice for the Power Plug/Power Cord
- Notice for Unplugging the Power Cord
Confirming that the Power Is On

The **POWER** lamp is lit white when the machine is turned on. Even if the LCD is off, if the **POWER** lamp is lit, the machine is on.

![POWER lamp and home button](image)

**Note**

- It may take a while for the machine to start printing immediately after you turn on the machine.
- The LCD will turn off if the machine is not operated for about 5 minutes. To restore the display, press any button except the **ON** button or perform the print operation. You cannot change the wait time before the LCD turns off.
Turning the Machine On and Off

Turning on the machine

1. Press the **ON** button to turn on the machine.
   
The **POWER** lamp flashes and then remains lit white.

   ➤ Confirming that the Power Is On

![Image of the ON button]

**Note**

- It may take a while for the machine to start printing immediately after you turn on the machine.
- If the **Alarm** lamp lights up or flashes orange and an error message is displayed on the LCD, see A Message Is Displayed.

**Auto power on feature**

- You can set the machine to automatically turn on when a print or scan operation is performed from a computer connected by USB cable or network. This feature is set to off by default.
  
  From the machine
  ➤ About ECO settings
  
  From the computer
  ➤ Managing the Machine Power

Turning off the machine

1. Press the **ON** button to turn off the machine.
   
   When the **POWER** lamp stops flashing, the machine is turned off.
Important

- When you unplug the power cord after turning off the machine, be sure to confirm that the **POWER** lamp is off.

  ➤ **Notice for Unplugging the Power Cord**

Note

**Auto power off feature**

- You can set the machine to automatically turn off when no operations are performed or no print jobs are sent to the machine for a certain interval. This is the default setting.
  
  From the machine
  
  ➤ **About ECO settings**

  From the computer
  
  ➤ **Managing the Machine Power**
Notice for the Power Plug/Power Cord

Unplug the power cord once a month to confirm that the power plug/power cord does not have anything unusual described below.

- The power plug/power cord is hot.
- The power plug/power cord is rusty.
- The power plug/power cord is bent.
- The power plug/power cord is worn.
- The power plug/power cord is split.

⚠️ Caution

- If you find anything unusual with the power plug/power cord described above, unplug the power cord and call for service. Using the machine with one of the unusual conditions above may cause a fire or an electric shock.

⇒ Notice for Unplugging the Power Cord
Notice for Unplugging the Power Cord

To unplug the power cord, follow the procedure below.

**Important**

- When you unplug the power cord, press the ON button, then confirm that the POWER lamp is off. Unplugging the power cord while the POWER lamp is lit or flashing may cause drying or clogging of the print head and print quality may be reduced.

1. Press the ON button to turn the machine off.

2. Confirm that the POWER lamp is off.

3. Unplug the power cord.

The specification of the power cord differs depending on the country or region of use.
LCD and Operation Panel

You can use the machine to make copies or scan originals without a computer. You can also make good use of the various functions of the machine using the operation panel starting from the HOME screen on the LCD.

The HOME screen consists of three screens. You can use the ▲ or ▼ button (A) to switch between them. Each screen provides menus for making copies, scanning originals, etc. To select a menu on each screen, use the left, center, or right Function button (B).

On the menu screen or settings screen, use the ▲, ▼, ◀, or ► button (C) to select an item or option, then press the OK button (D) to proceed with the procedure. To return to the previous screen, press the Back button (E).

Using the Function Buttons

When you select a menu on the HOME screen, function menus (F) will appear where required at the bottom of the screen. Pressing a corresponding Function button (G), (H), or (I) displays its function, such as a settings screen.

The number of function menus and their contents vary depending on the screen. Check the function menus displayed at the bottom of the screen, then select the one desired.
Example: The screen in **Scan**

![Scan Screen](image)

**(G)** Press the left **Function** button to select **Save/Forward**. The screen for selecting destinations to save or forward the scanned photo data will appear.

![Save/Forward Screen](image)

**(H)** Press the center **Function** button. The **Document setting** screen will appear.

![Document Setting Screen](image)

**(I)** Press the right **Function** button to select **Scan settings**. The scan settings screen will appear.

![Scan Settings Screen](image)
Loading Paper / Originals

- Loading Paper
- Loading Originals
Loading Paper

- Loading Plain Paper / Photo Paper
- Loading Envelopes
- Media Types You Can Use
- Media Types You Cannot Use
- Printing Area
Loading Plain Paper / Photo Paper

You can load plain paper or photo paper.

**Important**
- If you cut plain paper into small size such as 4” x 6” (10 x 15 cm) or 5” x 7” (13 x 18 cm) to perform trial print, it can cause paper jams.

**Note**
- We recommend Canon genuine photo paper for printing photos. For details on the Canon genuine paper, see Media Types You Can Use.
- You can use general copy paper. For the page size and paper weight you can use for this machine, see Media Types You Can Use.

1. Prepare paper.
   
   Align the edges of paper. If paper is curled, flatten it.

   ![Flatten curled paper](image)

   **Note**
   - Align the edges of paper neatly before loading. Loading paper without aligning the edges may cause paper jams.
   - If paper is curled, hold the curled corners and gently bend them in the opposite direction until the paper becomes completely flat. For details on how to flatten curled paper, see "Load the paper after correcting its curl." in Paper Is Smudged/Printed Surface Is Scratched.
   - When using Photo Paper Plus Semi-gloss SG-201, even if the sheet is curled, load one sheet at a time as it is. If you roll up this paper to flatten, this may cause cracks on the surface of the paper and reduce the print quality.

2. Load paper.

   (1) Open the front tray gently.
(2) Holding the right tab on the front tray, pull out the feeder until it stops.

(3) Use the right paper guide (A) to slide both paper guides all the way out.

(4) Load the paper in the center of the feeder WITH THE PRINT SIDE FACING DOWN.
    Push the paper stack all the way to the back of the feeder.

**Important**
- Always load paper in the portrait orientation (B). Loading paper in the landscape orientation (C) can cause paper jams.
(5) Slide the right paper guide (A) to align the paper guides with both sides of the paper stack.
Do not slide the paper guides too hard against the paper. The paper may not be fed properly.

Note

- Do not load sheets of paper higher than the load limit mark (D).
- Keep the paper stack height below the tabs (E) of the paper guides.
- Load small size paper, such as 4” x 6” (10 x 15 cm), by pushing it in all the way to the back of the feeder.
(6) Holding the right tab on the front tray, push the feeder back until the arrow (▸) on the front tray is aligned with the arrow (◂) on the machine.

3. Open the paper output tray.
   (1) Extend the paper support (F), then open the output tray extension (G).
   (2) Open the paper output tray (H) gently, then extend the paper output support (I).
Important

- Be sure to open the paper output tray when printing. If not open, the machine cannot start printing.

Note

After loading paper
- Select the size and type of the loaded paper on the print settings screen of the operation panel or printer driver.
Loading Envelopes

You can load Envelope DL and Envelope Com 10. The address is automatically rotated and printed according to the envelope’s direction by specifying with the printer driver properly.

**Important**

- Printing of envelopes from the operation panel is not supported.
- Do not use the following envelopes. They could jam in the machine or cause the machine to malfunction.
  - Envelopes with an embossed or treated surface
  - Envelopes with a double flap
  - Envelopes whose gummed flaps are already moistened and adhesive

1. Prepare envelopes.
   - Press down on all four corners and edges of the envelopes to flatten them.
   - If the envelopes are curled, hold the opposite corners and gently twist them in the opposite direction.
   - If the corner of the envelope flap is folded, flatten it.
   - Use a pen to press the leading edge in the inserting direction flat and sharpen the crease.

   The figures above show a side view of the leading edge of the envelope.

**Important**

- The envelopes may jam in the machine if they are not flat or the edges are not aligned. Make sure that no curl or puff exceeds 0.1 inches (3 mm).

2. Load envelopes.
(1) Open the front tray gently.

(2) Hold the right tab on the front tray to pull out the feeder until it stops.

(3) Use the right paper guide (A) to slide both paper guides all the way out.

(4) Load the envelopes in the center of the feeder WITH THE ADDRESS SIDE FACING DOWN.
The folded flap of the envelope will be faced up on the left side.

(B) Rear side
(C) Address side

Push the envelopes all the way to the back of the feeder.
Up to 5 envelopes can be loaded at once.
(5) Slide the right paper guide (A) to align the paper guides with both sides of the envelopes.
Do not slide the paper guides too hard against the envelopes. The envelopes may not be fed properly.

(6) Holding the right tab on the front tray, push the feeder back until the arrow (ᐸ) on the front tray is aligned with the arrow (ᐸ) on the machine.

**Note**
- Do not load envelopes higher than the load limit mark (D).
- Keep the envelope stack height below the tabs (E) of the paper guides.
3. Open the paper output tray.

(1) Extend the paper support (F), then open the output tray extension (G).
(2) Open the paper output tray (H) gently, then extend the paper output support (I).

**Important**
- Be sure to open the paper output tray when printing. If not open, the machine cannot start printing.
Note

After loading envelopes
- Select the size and type of the loaded envelopes on the print settings screen of the printer driver.
Media Types You Can Use

Choose paper suitable for printing, for the best print results. Canon provides you various types of paper to enhance the fun of printing, such as stickers as well as papers for photo or document. We recommend the use of Canon genuine paper for printing your important photos.

Media Types

Commercially available papers

- Plain Paper (including recycled paper)*1
- Envelopes*2

Canon genuine papers

The Model Number of Canon genuine paper is shown in brackets. Refer to the instruction manual supplied with the paper for detailed information on the printable side and notes on handling paper. For information on the page sizes available for each Canon genuine paper, access our website.

Note

- You may not be able to purchase some Canon genuine papers depending on the country or region of purchase. Paper is not sold in the US by Model Number. Purchase paper by name.

Paper for printing photos:

- Photo Paper Pro Platinum <PT-101>
- Glossy Photo Paper "Everyday Use" <GP-501/GP-601>
- Photo Paper Glossy <GP-601>
- Photo Paper Plus Glossy II <PP-201>
- Photo Paper Pro Luster <LU-101>
- Photo Paper Plus Semi-gloss <SG-201>
- Matte Photo Paper <MP-101>

Paper for printing business documents:

- High Resolution Paper <HR-101N>*2

Paper for creating your own prints:

- T-Shirt Transfers <TR-301>*2
Photo Stickers <PS-101>

*1 100% recycled paper can be used.
*2 Printing to this paper from the operation panel is not supported.

Paper Load Limit
Media Type Settings on the Operation Panel
Setting the Media Type with the Printer Driver

Page Sizes
You can use the following page sizes.

Note
- Printing on the following paper sizes from the operation panel is not supported.
  - Legal and Envelopes

Standard sizes:
- Letter
- A5
- B5
- 5” x 7” (13 x 18 cm)
- Envelope DL
- Legal
- A4
- 4” x 6” (10 x 15 cm)
- 8” x 10” (20 x 25 cm)
- Envelope Com 10

Non-standard sizes:
You can print on non-standard size paper within the following ranges.
- Minimum size: 3.50 x 5.00 inches (89.0 x 127.0 mm)
- Maximum size: 8.50 x 14.00 inches (215.9 x 355.6 mm)

Paper Weight
You can use paper in the following weight range.
- 17 to 28 lb (64 to 105 g /m²) (except for Canon genuine paper)

Do not use heavier or lighter paper (except for Canon genuine paper), as it could jam in the machine.

Notes on Storing Paper
- Take out only the necessary number of paper from the package, just before printing.
- To avoid curling, when you do not print, put unused paper back into the package and keep it on a level surface. And also, store it avoiding heat, humidity, and direct sunlight.
Paper Load Limit

Commercially Available Papers

<table>
<thead>
<tr>
<th>Media Name</th>
<th>Front Tray</th>
<th>Paper Output Tray</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper (including recycled paper)&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Approx. 100 sheets</td>
<td>Approx. 50 sheets</td>
</tr>
<tr>
<td>Envelopes</td>
<td>5 envelopes</td>
<td>*&lt;sup&gt;2&lt;/sup&gt;</td>
</tr>
</tbody>
</table>

Canon Genuine Papers

Note

- We recommend that you remove the previously printed sheet from the paper output tray before continuously printing to avoid blurs and discoloration (except for High Resolution Paper <HR-101N>).

Paper for printing photos:

<table>
<thead>
<tr>
<th>Media Name &lt;Model No.&gt;</th>
<th>Front Tray</th>
</tr>
</thead>
</table>
| Photo Paper Pro Platinum <PT-101><sup>3</sup> | 10 sheets: A4, Letter, and 8" x 10" (20 x 25 cm)  
                        | 20 sheets: 4" x 6" (10 x 15 cm)                |
                        | 20 sheets: 4" x 6" (10 x 15 cm)                |
| Photo Paper Glossy <GP-601><sup>3</sup> | 10 sheets: A4 and Letter  
                        | 20 sheets: 4" x 6" (10 x 15 cm)                |
| Photo Paper Plus Glossy II <PP-201><sup>3</sup> | 10 sheets: A4, Letter, 5" x 7" (13 x 18 cm), and 8" x 10" (20 x 25 cm)  
                        | 20 sheets: 4" x 6" (10 x 15 cm)                |
| Photo Paper Pro Luster <LU-101><sup>3</sup> | 10 sheets: A4 and Letter                          |
| Photo Paper Plus Semi-gloss <SG-201><sup>3</sup> | 10 sheets: A4, Letter, 5" x 7" (13 x 18 cm), and 8" x 10" (20 x 25 cm)  
                        | 20 sheets: 4" x 6" (10 x 15 cm)                |
| Matte Photo Paper <MP-101> | 10 sheets: A4 and Letter                          |
|                        | 20 sheets: 4" x 6" (10 x 15 cm)                |

Paper for printing business documents:

<table>
<thead>
<tr>
<th>Media Name &lt;Model No.&gt;</th>
<th>Front Tray</th>
<th>Paper Output Tray</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Resolution Paper &lt;HR-101N&gt;</td>
<td>65 sheets</td>
<td>50 sheets</td>
</tr>
</tbody>
</table>
Paper for creating your own prints:

<table>
<thead>
<tr>
<th>Media Name &lt;Model No.&gt;</th>
<th>Front Tray</th>
</tr>
</thead>
<tbody>
<tr>
<td>T-Shirt Transfers &lt;TR-301&gt;</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Photo Stickers &lt;PS-101&gt;</td>
<td>1 sheet</td>
</tr>
</tbody>
</table>

*1 Proper feeding of paper may not be possible at the maximum capacity depending on the type of paper or environmental conditions (either very high or low temperature or humidity). In such cases, reduce the number of paper you load at a time to less than half.

*2 We recommend that you remove the previously printed envelope from the paper output tray before continuously printing to avoid blurs and discoloration.

*3 When loading paper in stacks, the print side may become marked as it is fed or paper may not feed properly. In this case, load one sheet at a time.
# Media Type Settings on the Operation Panel

## Commercially Available Papers

<table>
<thead>
<tr>
<th>Media Name</th>
<th>Settings in Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper (including recycled paper)</td>
<td>Plain paper</td>
</tr>
</tbody>
</table>

## Canon Genuine Papers

### Paper for printing photos:

<table>
<thead>
<tr>
<th>Media Name &lt;Model No.&gt;</th>
<th>Settings in Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo Paper Pro Platinum &lt;PT-101&gt;</td>
<td>Pro Platinum</td>
</tr>
<tr>
<td>Glossy Photo Paper &quot;Everyday Use&quot; &lt;GP-501/GP-601&gt;</td>
<td>Glossy</td>
</tr>
<tr>
<td>Photo Paper Glossy &lt;GP-601&gt;</td>
<td>Glossy</td>
</tr>
<tr>
<td>Photo Paper Plus Glossy II &lt;PP-201&gt;</td>
<td>Plus Glossy II</td>
</tr>
<tr>
<td>Photo Paper Pro Luster &lt;LU-101&gt;</td>
<td>Plus Semi-gloss</td>
</tr>
<tr>
<td>Photo Paper Plus Semi-gloss &lt;SG-201&gt;</td>
<td>Plus Semi-gloss</td>
</tr>
<tr>
<td>Matte Photo Paper &lt;MP-101&gt;</td>
<td>Matte</td>
</tr>
</tbody>
</table>
Media Types You Cannot Use

Do not use the following types of paper. Using such paper will cause not only unsatisfactory results, but also the machine to jam or malfunction.

- Folded, curled, or wrinkled paper
- Damp paper
- Paper that is too thin (weighing less than 17 lb (64 g/m²))
- Paper that is too thick (weighing more than 28 lb (105 g/m²), except for Canon genuine paper)
- Paper thinner than a postcard, including plain paper or notepad paper cut to a small size (when printing on paper smaller than A5)
- Picture postcards
- Postcards affixed with photos or stickers
- Envelopes with a double flap
- Envelopes with an embossed or treated surface
- Envelopes whose gummed flaps are already moistened and adhesive
- Any type of paper with holes
- Paper that is not rectangular
- Paper bound with staples or glue
- Paper with adhesives
- Paper decorated with glitter, etc.
Printing Area

- Printing Area
- Other Sizes than Letter, Legal, Envelopes
- Letter, Legal
- Envelopes
Printing Area

To ensure the best print quality, the machine allows a margin along each edge of media. The actual printable area will be the area inside these margins. Recommended printing area : Canon recommends that you print within this area. Printable area : The area where it is possible to print. However, printing in this area can affect the print quality or the paper feed precision.

Note

- With performing Automatic Duplex Printing and Duplex (Two-sided) Copying, the printable area will be 0.08 inches (2 mm) smaller at the top margin.
- When performing borderless copying or borderless printing from a printed photo, select Extended copy amount in Print settings of Device settings to specify the amount of images that extends off the paper.

Borderless Printing

- By selecting Borderless Printing option, you can make prints with no margins.
- When performing Borderless Printing, slight cropping may occur at the edges since the printed image is enlarged to fill the whole page.
- For Borderless Printing, use the following paper:
  - Photo Paper Pro Platinum <PT-101>
  - Glossy Photo Paper "Everyday Use" <GP-501/GP-601>
  - Photo Paper Glossy <GP-601>
  - Photo Paper Plus Glossy II <PP-201>
  - Photo Paper Pro Luster <LU-101>
  - Photo Paper Plus Semi-gloss <SG-201>
  - Matte Photo Paper <MP-101>
Performing Borderless Printing on any other type of paper may substantially reduce printing quality and/or result in printouts with altered color hues. Borderless Printing on plain paper may result in printouts with reduced quality. Use them only for test printing. Borderless Printing onto plain paper from the operation panel is not supported.
- Borderless Printing is not available for legal, A5, or B5 sized paper, or envelopes.
- Depending on the type of paper, Borderless Printing may reduce the print quality at the top and bottom edges of the paper or cause these parts to become smudged.
## Other Sizes than Letter, Legal, Envelopes

<table>
<thead>
<tr>
<th>Size</th>
<th>Printable Area (width x height)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A5</td>
<td>5.56 x 7.95 inches (141.2 x 202.0 mm)</td>
</tr>
<tr>
<td>A4</td>
<td>8.00 x 11.38 inches (203.2 x 289.0 mm)</td>
</tr>
<tr>
<td>B5</td>
<td>6.90 x 9.80 inches (175.2 x 249.0 mm)</td>
</tr>
<tr>
<td>4&quot; x 6&quot; (10 x 15 cm)</td>
<td>3.73 x 5.69 inches (94.8 x 144.4 mm)</td>
</tr>
<tr>
<td>5&quot; x 7&quot; (13 x 18 cm)</td>
<td>4.73 x 6.69 inches (120.2 x 169.8 mm)</td>
</tr>
<tr>
<td>8&quot; x 10&quot; (20 x 25 cm)</td>
<td>7.73 x 9.69 inches (196.4 x 246.0 mm)</td>
</tr>
</tbody>
</table>

(A) 1.70 inches (43.3 mm)
(B) 1.47 inches (37.4 mm)

(C) 0.12 inches (3.0 mm)
(D) 0.20 inches (5.0 mm)
(E) 0.13 inches (3.4 mm)
(F) 0.13 inches (3.4 mm)
# Letter, Legal

<table>
<thead>
<tr>
<th>Size</th>
<th>Printable Area (width x height)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>8.00 x 10.69 inches (203.2 x 271.4 mm)</td>
</tr>
<tr>
<td>Legal</td>
<td>8.00 x 13.69 inches (203.2 x 347.6 mm)</td>
</tr>
</tbody>
</table>

**Recommended printing area**

- **(A)** 1.70 inches (43.3 mm)
- **(B)** 1.47 inches (37.4 mm)

**Printable area**

- **(C)** 0.12 inches (3.0 mm)
- **(D)** 0.20 inches (5.0 mm)
- **(E)** 0.25 inches (6.4 mm)
- **(F)** 0.25 inches (6.3 mm)
# Envelopes

<table>
<thead>
<tr>
<th>Size</th>
<th>Recommended Printing Area (width x height)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope DL</td>
<td>3.88 x 7.06 inches (98.8 x 179.5 mm)</td>
</tr>
<tr>
<td>Envelope Com 10</td>
<td>3.68 x 7.90 inches (93.5 x 200.8 mm)</td>
</tr>
</tbody>
</table>

(A) 0.31 inches (8.0 mm)
(B) 1.28 inches (32.5 mm)
(C) 0.22 inches (5.6 mm)
(D) 0.22 inches (5.6 mm)
Loading Originals

- Loading Originals on the Platen Glass
- How to Load Originals for Each Function
- Originals You Can Load
- How to Detach / Attach the Document Cover
Loading Originals on the Platen Glass

You can load originals to copy or scan on the platen glass.

1. Load an original on the platen glass.
   
   (1) Open the document cover.
   
   (2) Load the original WITH THE SIDE TO SCAN FACING DOWN on the platen glass.

   ⇒ Originals You Can Load
   Make sure of the proper position to load the original for each function.
   ⇒ How to Load Originals for Each Function

   ![Diagram of original loading]

   ![Diagram of original loading]

   **Important**

   - Be sure to observe the following when loading the original on the platen glass.
     - Do not place any objects weighing 4.4 lb (2.0 kg) or more on the platen glass.
     - Do not put any pressure of 4.4 lb (2.0 kg) or more on the platen glass, such as pressing down the original.

   Failure to observe the above may cause the scanner to malfunction or the platen glass to break.

2. Close the document cover gently.
Important

- After loading the original on the platen glass, be sure to close the document cover before starting to copy or scan.
How to Load Originals for Each Function

You may have to load the original in a different position depending on the function you selected in copying, scanning, etc. Load the original in the correct position according to the selected function. If you do not load the original correctly, it may not be scanned properly.

Loading the Original to Be Aligned with the alignment mark

- Load originals to copy
- In Scan,
  - select Auto scan for Doc.type to scan text documents, magazines, or newspapers
  - select Document or Photo for Doc.type and specify a standard size (A4, Letter, etc.) for Scan size to scan originals
- With a software application on a computer,
  - scan text documents, magazines, or newspapers
  - select a standard size (A4, Letter, etc.) to scan originals

Load the original WITH THE SIDE TO SCAN FACING DOWN and align it with the alignment mark.

Important

- The machine cannot scan the shaded area (A) (0.04 inches (1 mm) from the edges of the platen glass).
Loading Only One Original in the Center of the platen glass

- Scan only one printed photo in Photo copy
- In Scan,
  - select Auto scan for Doc.type to scan one printed photo, postcard, business card, or disc
  - select Photo for Doc.type and specify Auto scan for Scan size to scan one original
- Scan one printed photo, postcard, business card, or disc with a software application on a computer

Load the original WITH THE SIDE TO SCAN FACING DOWN and place it at least 0.4 inches (10 mm) away from the edges of the platen glass.

Loading Two or More Originals on the platen glass

- Scan two or more printed photos in Photo copy
- In Scan,
  - select Auto scan for Doc.type to scan two or more printed photos, postcards, or business cards
  - select Photo for Doc.type and specify Auto multi scan for Scan size to scan two or more originals
- Scan two or more printed photos, postcards, or business cards with a software application on a computer

Load two or more originals WITH THE SIDE TO SCAN FACING DOWN and place them at least 0.4 inches (10 mm) away from the edges of the platen glass and at least 0.4 inches (10 mm) apart from each other.
Note

- The Skew Correction function automatically compensates for the originals placed at an angle of up to approximately 10 degrees. Slanted photos with a long edge of 7.1 inches (180 mm) or more cannot be corrected.
- Non-rectangular or irregular shaped photos (such as cut out photos) may not be scanned properly.
## Originals You Can Load

The originals you can load on the platen glass are as follows.

<table>
<thead>
<tr>
<th>Item</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Types of originals</strong></td>
<td>- Text document, magazine, or newspaper</td>
</tr>
<tr>
<td></td>
<td>- Printed photo, postcard, business card, or disc (BD/DVD/CD, etc.)</td>
</tr>
<tr>
<td><strong>Size (width x height)</strong></td>
<td>Max. 8.5 x 11.7 inches (216 x 297 mm)</td>
</tr>
</tbody>
</table>

### Note

- When loading a thick original such as a book on the platen glass, you can load it by removing the document cover from the machine.

⇒ How to Detach / Attach the Document Cover
How to Detach / Attach the Document Cover

Detaching the document cover:
Hold up the document cover vertically and then tip it back.

Attaching the document cover:
Fit both hinges (A) of the document cover into the holder (B) and insert both hinges of the document cover vertically as illustrated below.
Replacing an Ink Tank

- Replacing an Ink Tank
- Checking the Ink Status
Replacing an Ink Tank

When remaining ink cautions or errors occur, the message will appear on the LCD to inform you of the error. Take appropriate action according to the message.

A Message Is Displayed

**Note**

- For information on the compatible ink tank, refer to the printed manual: *Safety and Important Information*.
- If print results become faint or white streaks appear despite sufficient ink levels, see *Maintenance Procedure*.

Replacing Procedure

When you need to replace an ink tank, follow the procedure below.

**Important**

- **Handling ink**
  - If you remove an ink tank, replace it immediately. Do not leave the machine with the ink tank removed.
  - Use a new ink tank for replacement. Installing a used ink tank may cause the nozzles to clog. Furthermore, with such an ink tank, the machine will not be able to inform you when to replace the ink tank properly.
  - Once an ink tank has been installed, do not remove it from the machine and leave it out in the open. This will cause the ink tank to dry out, and the machine may not operate properly when it is reinstalled. To maintain optimal printing quality, use an ink tank within six months of first use.

**Note**

- Color ink may be consumed even when printing a black-and-white document or when black-and-white printing is specified.
  
  Every ink is also consumed in the standard cleaning and deep cleaning of the print head, which may be necessary to maintain the performance of the machine. When an ink tank is out of ink, replace it immediately with a new one.

**Useful Information about Ink**

1. Make sure that the power is turned on.

2. Open the front cover.
3. Open the operation panel (A), then open the paper output tray (B).

Open the operation panel (A) until it stops.
The print head holder moves to the replacement position.

⚠️ Caution
- Do not hold the print head holder to stop or move it forcibly. Do not touch the print head holder until it stops completely.

⚠️ Important
- When opening or closing the operation panel, do not touch the buttons and LCD on the operation panel. Doing so may result in an unexpected operation.
- Do not touch the metallic parts or other parts inside the machine.
- If the operation panel is left open for more than 10 minutes, the print head holder moves to the right. In this case, close and reopen the operation panel.

4. Remove the ink tank with the lamp flashing fast.

Push the tab (C) and lift the ink tank to remove.
Important

- Do not touch other parts besides the ink tanks.
- Handle the ink tank carefully to avoid staining of clothing or the surrounding area.
- Discard the empty ink tank according to the local laws and regulations regarding disposal of consumables.

Note

- Do not remove two or more ink tanks at the same time. Be sure to replace ink tanks one by one when replacing two or more ink tanks.
- For details on ink lamp flashing speed, see Checking the Ink Status with the Ink Lamps.

5. Prepare a new ink tank.

(1) Take a new ink tank out of its package, remove the orange tape (①) completely, then remove the protective film (②) completely.

Important

- Handle an ink tank carefully. Do not drop or apply excessive pressure to it.
If the orange tape remains on the Y-shape air hole (D), ink may splash or the machine may not print properly.

(2) Hold the ink tank with the orange protective cap (E) pointing up while being careful not to block the Y-shape air hole (D).

(3) Lift up the tab on the orange protective cap (E) to remove it off GENTLY.

Important

- Do not push the sides of the ink tank. If you push the sides of the ink tank with the Y-shape air hole (D) blocked, ink may splash.
- Do not touch the inside of the orange protective cap (E) or the open ink port (F). The ink may stain your hands if you touch them.
- Do not reattach the protective cap (E) once you have removed it. Discard it according to the local laws and regulations regarding disposal of consumables.

6. Install the new ink tank.

(1) Insert the front end of the ink tank into the print head at a slant. Make sure that the position of the ink tank matches the label.
(2) Press on the top of the ink tank until the ink tank snaps firmly into place. Make sure that the ink lamp lights up red.

**Important**

- You cannot print if the ink tank is installed in the wrong position. Be sure to install the ink tank in the correct position according to the label on the print head holder.
- You cannot print unless all the ink tanks are installed. Be sure to install all the ink tanks.

7. Close the operation panel gently.

**Caution**

- When closing the operation panel, be careful not to get your fingers caught.
**Important**

- When opening or closing the operation panel, do not touch the buttons and LCD on the operation panel. Doing so may result in an unexpected operation.

**Note**

- If the error message appears after the operation panel is closed, take appropriate action.
  - **A Message Is Displayed**
- When you start printing after replacing the ink tank, the machine starts cleaning the print head automatically. Do not perform any other operations until the machine completes the cleaning of the print head.
- If the print head is out of alignment, as indicated by misaligned printed ruled lines or similar symptoms, adjust the print head position.
  - **Aligning the Print Head**
Checking the Ink Status

- Checking the Ink Status with the LCD on the Machine
- Checking the Ink Status with the Ink Lamps

You can also check the ink status on the computer screen.
- Checking the Ink Status from Your Computer
Checking the Ink Status with the LCD on the Machine

1. Make sure that the power is turned on, and display the HOME screen. If the HOME screen is not displayed, press the HOME button to display it.

2. Select Setup on the HOME screen.

   ➤ LCD and Operation Panel

   The setup menu screen will appear.

3. Select Estimated ink levels, then press the OK button.

   A symbol appears in the area (A) if there is any information about the remaining ink level.

   ![Current estimated ink levels](image)

   Example: 🔄

   Ink tank is running low. Prepare a new ink tank.

   ➤ Note

   - The above screen shows estimated ink levels.
   - Press the HOME button to exit Setup and display the HOME screen.
   - To display and print the model number of the ink tank, select Ink number by pressing the right Function button.
   - You can also check the ink status on a screen of the LCD displayed while printing.
   - You can also check the ink status on the computer screen.

   ➤ Checking the Ink Status from Your Computer
Checking the Ink Status with the Ink Lamps

1. Make sure that the power is turned on.

2. Open the front cover, then open the paper output tray.

3. Lift the operation panel and open until it stops.
   ➪Replacing Procedure

4. Check the ink lamp.
   Close the operation panel after checking the ink lamp status.
   ➪Replacing Procedure

The ink lamp is on.
The ink tank is correctly installed.

The ink lamp is flashing.
Flashingslowly (at around 3-second intervals)

● ● ● ● ● ...... Repeats
Ink tank is running low. Prepare a new ink tank.

Flashingsfast (at around 1-second intervals)

● ● ● ● ● ...... Repeats

- The ink tank is installed in the wrong position.
Or
- The ink has run out.

Make sure that the ink tank is installed in the correct position as indicated by the label on the print head holder. If the position is correct but the lamp flashes, there has been an error and the machine cannot print. Check the error message displayed on the LCD.
 ➪A Message Is Displayed
The ink lamp is off.

The ink tank is not installed properly or the function for detecting the remaining ink level is disabled. If the ink tank is not firmly in place, make sure that the orange protective cap has been removed from the bottom of the ink tank, then press on the top of the ink tank until the ink tank clicks into place.

If the ink lamp is still off after reinstalling the ink tank, there has been an error and the machine cannot print. Check the error message displayed on the LCD.

A Message Is Displayed

---

**Note**

- You can also check the ink status on the computer screen.

- Checking the Ink Status from Your Computer
Maintenance

- When Printing Becomes Faint or Colors Are Incorrect
- Performing Maintenance from a Computer
- Cleaning the Machine
When Printing Becomes Faint or Colors Are Incorrect

- Maintenance Procedure
- Printing the Nozzle Check Pattern
- Examining the Nozzle Check Pattern
- Cleaning the Print Head
- Cleaning the Print Head Deeply
- Aligning the Print Head
Maintenance Procedure

If print results are blurred or colors are not printed correctly, the print head nozzle is probably clogged. Follow the procedure below to print the nozzle check pattern, check the print head nozzle condition, then clean the print head.

If printed ruled lines are misaligned or print results are otherwise unsatisfactory, aligning the print head may improve print quality.

**Important**

- Do not rinse or wipe the print head and ink tank. This can cause trouble with the print head and ink tank.

**Note**

**Before performing maintenance**

- Make sure that the orange protective tape does not remain on the ink tank.

- Open the operation panel and make sure that the lamp on the ink tank is lit red. If the lamp is flashing or off, take appropriate action.

  - **Checking the Ink Status with the Ink Lamps**

- Increasing the print quality in the printer driver settings may improve the print result.

  - **Changing the Print Quality and Correcting Image Data**
When the Print Results Are Blurred or Uneven:

**Step 1**

Print the nozzle check pattern.

From the machine
- ➤Printing the Nozzle Check Pattern
From the computer
- ➤Use Your Computer to Print a Nozzle Check Pattern

Examine the nozzle check pattern.

➤Examining the Nozzle Check Pattern
If there are missing lines or horizontal white streaks in the pattern:

**Step 2**

Clean the print head.

From the machine
- ➤Cleaning the Print Head
From the computer
- ➤Cleaning the Print Heads from Your Computer

If the problem is not resolved after cleaning the print head twice:

**Step 3**

Clean the print head deeply.

From the machine
- ➤Cleaning the Print Head Deeply
From the computer
- ➤Cleaning the Print Heads from Your Computer

**Note**

- When you have performed the procedure until step 3 and the problem has not been resolved, turn off the power and clean the print head deeply again after 24 hours.
  If the problem is still not resolved, the print head may be damaged. Contact the service center.
When the Print Results Are Not Even such as the Ruled Lines Are Misaligned:

Align the print head.

From the machine

▶ Aligning the Print Head
Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzle.

Watch the movie

Note

- If the remaining ink level is low, the nozzle check pattern will not be printed correctly. Replace the ink tank whose ink is low.

Replacing an Ink Tank

You need to prepare: a sheet of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.

2. Load a sheet of A4 or Letter-sized plain paper in the front tray.

3. Open the paper output tray gently.

4. Print the nozzle check pattern.

(1) Select Setup on the HOME screen.

   LCD and Operation Panel

   The setup menu screen will appear.

(2) Select Maintenance, then press the OK button.

   The Maintenance screen will appear.

(3) Select Print nozzle check pattern, then press the OK button.

   The confirmation screen will appear.

(4) Select Yes, then press the OK button.
The nozzle check pattern will be printed and two pattern confirmation screens will appear on the LCD.

5. Examine the nozzle check pattern.

➡ Examining the Nozzle Check Pattern
Examining the Nozzle Check Pattern

Examine the nozzle check pattern, and clean the print head if necessary.

1. Check if there are missing lines in the pattern (C) or horizontal white streaks in the pattern (D).

(A) No missing lines/No horizontal white streaks
(B) Lines are missing/Horizontal white streaks are present
(E) Number of sheets printed so far

2. Select the pattern that is closer to the printed nozzle check pattern on the confirmation screen.

For (A) (no missing lines or no horizontal white streaks) in both the pattern (C) and pattern (D):

(1) The cleaning is not required. Select All A, then press the OK button.
(2) Confirm the message, then press the OK button.

The screen will return to the Maintenance screen.

**Note**

- Press the HOME button to exit Setup and display the HOME screen.

For (B) (lines are missing or horizontal white streaks are present) in the pattern (C) or pattern (D), or in both patterns:

(1) The cleaning is required. Select Also B, then press the OK button.

The cleaning confirmation screen will appear.

(2) Select Yes, then press the OK button.

The machine starts cleaning the print head.

**Cleaning the Print Head**

**Note**

- The total number of sheets printed so far is shown in increments of 50 sheets on the printout of the nozzle check pattern.
Cleaning the Print Head

Clean the print head if lines are missing or if horizontal white streaks are present in the printed nozzle check pattern. Cleaning unclogs the nozzles and restores the print head condition. Cleaning the print head consumes ink, so clean the print head only when necessary.

You need to prepare: a sheet of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.

2. Load a sheet of A4 or Letter-sized plain paper in the front tray.

3. Open the paper output tray gently.

4. Clean the print head.

   (1) Select Setup on the HOME screen.
   
   ➤ LCD and Operation Panel
   
   The setup menu screen will appear.

   (2) Select Maintenance, then press the OK button.
   
   The Maintenance screen will appear.

   (3) Select Cleaning, then press the OK button.

   The confirmation screen will appear.

   (4) Select Yes, then press the OK button.
   
   The machine starts cleaning the print head.

   Do not perform any other operations until the machine completes the cleaning of the print head. This takes about 1 minute.

   The pattern print confirmation screen will appear.
(5) Select **Yes**, then press the **OK** button.
   The nozzle check pattern will be printed.

5. Examine the nozzle check pattern.

   ➤ **Examining the Nozzle Check Pattern**

### Note

- Press the **HOME** button to exit **Setup** and display the **HOME** screen.
- If the problem is not resolved after cleaning the print head twice, clean the print head deeply.

   ➤ **Cleaning the Print Head Deeply**
Cleaning the Print Head Deeply

If print quality does not improve by the standard cleaning of the print head, clean the print head deeply. Cleaning the print head deeply consumes more ink than the standard cleaning of the print head, so clean the print head deeply only when necessary.

You need to prepare: a sheet of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.

2. Load a sheet of A4 or Letter-sized plain paper in the front tray.

3. Open the paper output tray gently.

4. Clean the print head deeply.

   (1) Select **Setup** on the **HOME** screen.
       - **LCD and Operation Panel**
         The setup menu screen will appear.

   (2) Select **Maintenance**, then press the **OK** button.
       The **Maintenance** screen will appear.

   (3) Select **Deep cleaning**, then press the **OK** button.

       ![Deep cleaning menu]

       The confirmation screen will appear.

   (4) Select **Yes**, then press the **OK** button.
       The machine starts cleaning the print head deeply.
       Do not perform any other operations until the machine completes the deep cleaning of the print head. This takes about 1 to 2 minutes.
       The pattern print confirmation screen will appear.

   (5) Select **Yes**, then press the **OK** button.
The nozzle check pattern will be printed.

(6) When the completion message appears, press the OK button. The screen will return to the Maintenance screen.

5. Examine the nozzle check pattern.

➡ Examining the Nozzle Check Pattern

If a particular color is not printed properly, replace the ink tank of that color.

➡ Replacing an Ink Tank

If the problem is not resolved, turn off the power and clean the print head deeply again after 24 hours.

If the problem is still not resolved, the print head may be damaged. Contact the service center.

➡ Note

- Press the HOME button to exit Setup and display the HOME screen.
Aligning the Print Head

If printed ruled lines are misaligned or print results are otherwise unsatisfactory, adjust the print head position.

**Note**

- If the remaining ink level is low, the print head alignment sheet will not be printed correctly. Replace the ink tank whose ink is low.

**Replacing an Ink Tank**

You need to prepare: a sheet of A4 or Letter-sized plain paper (including recycled paper)*

* Be sure to use paper that is white and clean on both sides.

1. Make sure that the power is turned on.

2. Load a sheet of A4 or Letter-sized plain paper in the front tray.

3. Open the paper output tray gently.

4. Print the print head alignment sheet.

   **(1)** Select **Setup** on the **HOME** screen.
   
   ➤ **LCD and Operation Panel**
   The setup menu screen will appear.

   **(2)** Select **Maintenance**, then press the **OK** button.
   The **Maintenance** screen will appear.

   **(3)** Select **Auto head alignment**, then press the **OK** button.

   ➤ **Maintenance**
   
<table>
<thead>
<tr>
<th>Print nozzle check pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleaning</td>
</tr>
<tr>
<td>Deep cleaning</td>
</tr>
<tr>
<td><strong>Auto head alignment</strong></td>
</tr>
<tr>
<td>Print the head alignment value</td>
</tr>
<tr>
<td>Roller cleaning</td>
</tr>
<tr>
<td>Bottom plate cleaning</td>
</tr>
</tbody>
</table>

The confirmation screen will appear.
(4) Confirm the message, select **Yes**, then press the **OK** button.

The print head alignment sheet will be printed.

![Print Head Alignment Sheet]

**Important**

- Do not touch any printed part on the print head alignment sheet.
- Be careful not to get the print head alignment sheet dirty. If the sheet is stained or wrinkled, it may not be scanned properly.

(5) When the message "**Did the patterns print correctly?**" appears, confirm that the pattern is printed correctly, select **Yes**, then press the **OK** button.

5. Scan the print head alignment sheet to adjust the print head position.

(1) Confirm the message, then load the print head alignment sheet on the platen glass.

Load the print head alignment sheet WITH THE PRINTED SIDE FACING DOWN and align the mark ☐ on the bottom right corner of the sheet with the alignment mark ☐.
(2) Close the document cover gently, then press the OK button.
The machine starts scanning the print head alignment sheet, and the print head position will be adjusted automatically.

**Important**

- Do not open the document cover or move the print head alignment sheet on the platen glass until adjusting the print head position is complete.
- If the error message appears on the LCD, press the OK button to release the error, then take appropriate action.

A Message Is Displayed

(3) When the completion message appears, press the OK button.
The screen will return to the Maintenance screen.
Remove the print head alignment sheet on the platen glass.

**Note**

- Press the HOME button to exit Setup and display the HOME screen.
- If the print results are still not satisfactory after adjusting the print head position as described above, adjust the print head position manually from the computer.

- Aligning the Print Head Position Manually from Your Computer
- To print and check the current head position adjustment values, select Print the head alignment value on the Maintenance screen.
Performing Maintenance from a Computer

- Cleaning the Print Heads from Your Computer
- Cleaning the Paper Feed Rollers from Your Computer
- Aligning the Print Head
- Aligning the Print Head Position from Your Computer
- Use Your Computer to Print a Nozzle Check Pattern
- Cleaning Inside the Machine
Cleaning the Print Heads from Your Computer

The print head cleaning function allows you to clear up clogged print head nozzle. Perform print head cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for cleaning the print head is as follows:

1. Open the printer driver setup window

2. Click **Cleaning** on the **Maintenance** tab
   - When the **Print Head Cleaning** dialog box opens, select the ink group for which cleaning is to be performed.
   - Click **Initial Check Items** to display the items you need to check before performing cleaning.

3. Execute cleaning
   - Make sure that the machine is on and then click **Execute**.
   - Print head cleaning starts.

4. Complete cleaning
   - The **Nozzle Check** dialog box opens after the confirmation message.

5. Check the results
   - To check whether the print quality has improved, click **Print Check Pattern**. To cancel the check process, click **Cancel**.
   - If cleaning the head once does not resolve the print head problem, clean it once more.

---

**Important**

- **Cleaning** consumes a small amount of ink.
- Cleaning the print head frequently will rapidly deplete your printer's ink supply.
- Consequently, perform cleaning only when necessary.
**Deep Cleaning**

*Deep Cleaning* is more thorough than cleaning. Perform deep cleaning when two *Cleaning* attempts do not resolve the print head problem.

1. Open the printer driver setup window

2. Click *Deep Cleaning* on the *Maintenance* tab
   
   When the *Deep Cleaning* dialog box opens, select the ink group for which deep cleaning is to be performed.
   
   Click *Initial Check Items* to display the items you need to check before performing deep cleaning.

3. Execute deep cleaning
   
   Make sure that the machine is on and then click *Execute*.
   
   Click *OK* when the confirmation message appears.
   
   Print head deep cleaning starts.

4. Complete deep cleaning
   
   The *Nozzle Check* dialog box opens after the confirmation message.

5. Check the results
   
   To check whether the print quality has improved, click *Print Check Pattern*. To cancel the check process, click *Cancel*.

**Important**

- *Deep Cleaning* consumes a larger amount of ink than *Cleaning*.
  Cleaning the print head frequently will rapidly deplete your printer's ink supply.
  Consequently, perform cleaning only when necessary.

**Note**

- If there is no sign of improvement after *Deep Cleaning*, switch off the machine, wait 24 hours, and then perform *Deep Cleaning* again. If there is still no sign of improvement, the ink may have run out or the print head may be worn. For details on the remedial action to be taken, see "Ink Is Not Ejected."

**Related Topic**

- Use Your Computer to Print a Nozzle Check Pattern
Cleaning the Paper Feed Rollers from Your Computer

Cleans the paper feed rollers. Perform feed roller cleaning when there are paper particles sticking to the paper feed rollers and paper is not fed properly.

The procedure for performing the feed roller cleaning is as follows:

1. **Prepare the machine**
   - Remove all sheets of paper from the front tray.

2. **Open the printer driver setup window**

3. **Click Roller Cleaning on the Maintenance tab**
   - The confirmation message appears.

4. **Execute paper feed roller cleaning**
   - Make sure that the machine is on and then click OK.
   - Paper feed roller cleaning starts.

5. **Complete paper feed roller cleaning**
   - After the rollers have stopped, follow the instruction in the message, load three sheets of plain paper into the front tray, and click OK.
   - Paper will be ejected and feed roller cleaning will be completed.
Aligning the Print Head

When you perform head position adjustment, errors in the print head adjustment position are corrected and conditions such as color and line streaking are improved. If the print results appear uneven because of line shifts or other conditions, adjust the position of the print head.

On this machine, you can adjust the print head either automatically or manually.
Aligning the Print Head Position from Your Computer

Print head alignment corrects the installation positions of the print head and improves deviated colors and lines.

This machine supports two head alignment methods: automatic head alignment and manual head alignment.

The procedure for performing manual print head alignment is as follows:

**Print Head Alignment**

1. Open the printer driver setup window

2. Click **Custom Settings** on the **Maintenance** tab
   The **Custom Settings** dialog box opens.

3. Switch head alignment to manual
   Check the **Align heads manually** check box.

4. Apply the settings
   Click **OK** and when the confirmation message appears, click **OK**.

5. Click **Print Head Alignment** on the **Maintenance** tab
   The **Start Print Head Alignment** dialog box opens.

6. Load paper in the machine
   Load two sheets of A4 size or Letter size plain paper into the front tray.

7. Execute head alignment
   Make sure that the machine is on and click **Align Print Head**.
   Follow the instruction in the message.

8. Check the printed pattern
   Enter the numbers of the patterns with the least amount of streaks in the associated boxes.
   Even if the patterns with the least amount of streaks are clicked in the preview window, their numbers are automatically entered in the associated boxes.
When you have entered all the necessary values, click **OK**.

**Note**

- If it is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical streaks.

  (A) Least noticeable vertical streaks
  (B) Most noticeable vertical streaks

9. Confirm the displayed message and click **OK**

   The second pattern is printed.

10. Check the printed pattern

    Enter the numbers of the patterns with the least noticeable stripes or streaks in the associated boxes.

    Even if the patterns with the least noticeable stripes or streaks are clicked in the preview window, their numbers are automatically entered in the associated boxes.
When you have entered all the necessary values, click OK.

**Note**

- If it is difficult to pick the best pattern, pick the setting that produces the least noticeable horizontal stripes.

(A) Least noticeable horizontal stripes  
(B) Most noticeable horizontal stripes

- If it is difficult to pick the best pattern, pick the setting that produces the least noticeable horizontal streaks.

(A) Least noticeable horizontal streaks  
(B) Most noticeable horizontal streaks

**Note**

- To print and check the current setting, open the Start Print Head Alignment dialog box, and click Print Alignment Value.
Use Your Computer to Print a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

1. **Open the printer driver setup window**

2. **Click Nozzle Check on the Maintenance tab**
   - The Nozzle Check dialog box opens.
   - Click Initial Check Items to display the items that you need to check before printing the nozzle check pattern.

3. **Load paper in the machine**
   - Load one sheet of A4 size or Letter size plain paper into the front tray.

4. **Print a nozzle check pattern**
   - Make sure that the machine is on and click Print Check Pattern.
   - Printing of the nozzle check pattern begins.
   - Click OK when the confirmation message appears.
   - The Pattern Check dialog box opens.

5. **Check the print result**
   - Check the print result. When the print result is normal, click Exit.
   - If the print result is smudged or if there are any unprinted sections, click Cleaning to clean the print head.

**Related Topic**
- Cleaning the Print Heads from Your Computer
Cleaning Inside the Machine

Perform bottom plate cleaning before you execute duplex printing to prevent smudges on the back side of the paper.
Also perform bottom plate cleaning if ink smudges caused by something other than print data appear on the printed page.

The procedure for performing bottom plate cleaning is as follows:

1. Open the printer driver setup window

2. Click **Bottom Plate Cleaning** on the **Maintenance** tab
   The **Bottom Plate Cleaning** dialog box opens.

3. **Load paper** in the machine
   As instructed in the dialog box, fold the A4 size or Letter size plain paper in half horizontally, and then unfold the sheet.
   Fold one side of the paper in another half, aligning the edge with the center crease, then unfold the paper.
   With the ridges of the creases facing up, load the paper into the front tray, so that the edge of the half with no crease faces away from you.

4. Perform the bottom plate cleaning
   Make sure that the machine is on and then click **Execute**. Bottom plate cleaning starts.
Cleaning the Machine

- Cleaning the Exterior of the Machine
- Cleaning the Platen Glass and Document Cover
- Cleaning the Paper Feed Roller
- Cleaning the Inside of the Machine (Bottom Plate Cleaning)
- Cleaning the Protrusions inside the Machine
Cleaning the Exterior of the Machine

Be sure to use a soft and dry cloth such as eyeglasses cleaning cloth and wipe off dirt on the surface gently. Smooth out wrinkles on the cloth if necessary before cleaning.

**Important**

- Be sure to turn off the power and disconnect the power plug before cleaning the machine.
- Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not to scratch the surface. Paper tissue powder or fine threads may remain inside the machine and cause problems such as print head blockage and poor printing results. Be sure to use a soft and dry cloth.
- Never use volatile liquids such as thinners, benzene, acetone, or any other chemical cleaner to clean the machine, as this may cause a malfunction or damage the surface of the machine.
Cleaning the Platen Glass and Document Cover

**Important**

- Be sure to turn off the power and disconnect the power plug before cleaning the machine.
- Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not to scratch the surface. Paper tissue powder or fine threads may remain inside the machine and cause problems such as print head blockage and poor printing results. Be sure to use a soft and dry cloth.
- Never use volatile liquids such as thinners, benzene, acetone, or any other chemical cleaner to clean the machine, as this may cause a malfunction or damage the surface of the machine.

With a soft, clean, lint-free and dry cloth, wipe the platen glass (A) and the inner side of the document cover (white sheet) (B) gently. Make sure not to leave any residue, especially on the glass surface.

**Important**

- The inner side of the document cover (white sheet) (B) is easily damaged, so wipe it gently.
Cleaning the Paper Feed Roller

If the paper feed roller is dirty or paper powder is attached to it, paper may not be fed properly. In this case, clean the paper feed roller. Cleaning will wear out the paper feed roller, so perform this only when necessary.

You need to prepare: three sheets of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.

2. Select **Roller cleaning**.

   (1) Select **Setup** on the HOME screen.
   ➞ **LCD and Operation Panel**
   The setup menu screen will appear.

   (2) Select **Maintenance**, then press the **OK** button.
   The **Maintenance** screen will appear.

   (3) Select **Roller cleaning**, then press the **OK** button.
   ![](image)
   The confirmation screen will appear.

   (4) Select **Yes**, then press the **OK** button.

3. Clean the paper feed roller without paper.

   (1) Follow the message to remove any paper from the front tray.

   (2) Press the **OK** button.
   The paper feed roller will rotate as it is cleaned.

4. Clean the paper feed roller with paper.
(1) Make sure that the paper feed roller has stopped rotating, then follow the message to load three or more sheets of A4 or Letter-sized plain paper in the front tray.

(2) Open the paper output tray gently.

(3) Press the OK button.
   The machine starts cleaning. The cleaning will be complete when the paper is ejected.

(4) When the completion message appears, press the OK button.
   The screen will return to the Maintenance screen.

Note

- Press the HOME button to exit Setup and display the HOME screen.

If the problem is not resolved after cleaning the paper feed roller, contact the service center.
Cleaning the Inside of the Machine (Bottom Plate Cleaning)

Remove stains from the inside of the machine. If the inside of the machine becomes dirty, printed paper may get dirty, so we recommend performing cleaning regularly.

You need to prepare: a sheet of A4 or Letter-sized plain paper*

* Be sure to use a new piece of paper.

1. Make sure that the power is turned on.

2. Clean the inside of the machine.

(1) Select **Setup** on the **HOME** screen.
   → **LCD and Operation Panel**
   The setup menu screen will appear.

(2) Select **Maintenance**, then press the **OK** button.
   The **Maintenance** screen will appear.

(3) Select **Bottom plate cleaning**, then press the **OK** button.
   The confirmation screen will appear.

(4) Select **Yes**, then press the **OK** button.

(5) Follow the message to remove any paper from the front tray, then press the **OK** button.

(6) Fold a single sheet of A4 or Letter-sized plain paper in half widthwise, then unfold the paper.

(7) Fold one side of the opened paper in another half, aligning the edge with the center crease, unfold the paper, then press the **OK** button.
Load only this sheet of paper in the front tray with the ridges of the creases facing up and the edge of the half with no crease facing away from you.

Open the paper output tray gently, then press the OK button. The paper cleans the inside of the machine as it feeds through the machine. Check the folded parts of the ejected paper. If they are smudged with ink, perform Bottom Plate Cleaning again.

When the completion message appears, press the OK button. The screen will return to the Maintenance screen.

If the problem is not resolved after performing cleaning again, the protrusions inside the machine may be stained. Clean them according to instructions.

Cleaning the Protrusions inside the Machine

Note

- Press the HOME button to exit Setup and display the HOME screen.
- When performing Bottom Plate Cleaning again, be sure to use a new piece of paper.
Cleaning the Protrusions inside the Machine

**Important**

- Be sure to turn off the power and disconnect the power plug before cleaning the machine.

You need to prepare: cotton swab

If the protrusions inside the machine are stained, wipe off any ink from the protrusions using a cotton swab or the like.
Changing the Machine Settings

- Changing Machine Settings from Your Computer
- Changing the Machine Settings on the LCD
Changing Machine Settings from Your Computer

- Changing the Print Options
- Registering a Frequently Used Printing Profile
- Managing the Machine Power
- Reducing the Machine Noise
- Changing the Machine Operation Mode
Changing the Print Options

You can change the detailed print driver settings for print data that is sent from an application software.

Specify this option if you encounter print failures such as part of an image data being cut off.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click **Print Options**... on the **Page Setup** tab

![Print Options dialog box](image)

The **Print Options** dialog box opens.

![Print Options dialog box](image)

**Note**

- When you use the XPS printer driver, the functions available to you are different.
3. Change the individual settings

   If necessary, change the setting of each item, and then click **OK**.

   The **Page Setup** tab is displayed again.
Registering a Frequently Used Printing Profile

You can register the frequently used printing profile to **Commonly Used Settings** on the **Quick Setup** tab. Unnecessary printing profiles can be deleted at any time.

The procedure for registering a printing profile is as follows:

### Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items
   - From **Commonly Used Settings** on the **Quick Setup** tab, select the printing profile to be used and if necessary, change the settings after **Additional Features**.
   - You can also register necessary items on the **Main** and **Page Setup** tabs.

3. Click **Save...**

   ![Save Commonly Used Settings dialog box](image)

   The **Save Commonly Used Settings** dialog box opens.

4. Save the settings
Enter a name in the Name field. If necessary, click Options..., set the items, and then click OK.
In the Save Commonly Used Settings dialog box, click OK to save the print settings and return to the Quick Setup tab.
The name and icon are displayed in Commonly Used Settings.

**Important**
- To save the page size, orientation, and number of copies that was set in each sheet, click Options..., and check each item.

**Note**
- When you install the printer driver again or upgrade the version of the printer driver, the print settings you registered will be deleted from Commonly Used Settings. Registered print settings cannot be saved and preserved. If a profile is deleted, register the print settings again.

**Deleting Unnecessary Printing Profile**

1. Select the printing profile to be deleted
   Select the printing profile you want to delete from the Commonly Used Settings list on the Quick Setup tab.

2. Delete the printing profile
   Click Delete. When the confirmation message appears, click OK.
   The selected printing profile is deleted from the Commonly Used Settings list.

**Note**
- Printing profiles that are registered in the initial settings cannot be deleted.
Managing the Machine Power

This function allows you to manage the machine power from the printer driver.

The procedure for managing the machine power is as follows:

---

**Power Off**

The **Power Off** function turns off the machine. When you use this function, you will not be able to turn the machine on from the printer driver.

1. Open the printer driver setup window

2. Execute power off

   Click **Power Off** on the **Maintenance** tab. When the confirmation message appears, click **OK**.

   The machine power switches off, and the **Maintenance** tab is displayed again.

---

**Auto Power**

**Auto Power** allows you to set **Auto Power On** and **Auto Power Off**.

The **Auto Power On** function automatically turns on the machine when data is received. The **Auto Power Off** function automatically turns off the machine when there are no operations from the printer driver or the machine for a specified period of time.

1. Open the printer driver setup window

2. Make sure that the machine is on and then click **Auto Power** on the **Maintenance** tab

   The **Auto Power Settings** dialog box opens.

---

**Note**

- If the machine is off or if communication between the machine and the computer is disabled, an error message may appear because the computer cannot collect the machine status.

  If this happens, click **OK** to display the most recent settings specified on your computer.
3. If necessary, complete the following settings:

**Auto Power On**
Specifying **Enable** from the list will turn the machine on upon receipt of print data.

**Auto Power Off**
Specify the time from the list. When this time lapses without any operations from the printer driver or the machine, the machine is turned off automatically.

4. Apply the settings

Click **OK**. When the confirmation message appears, click **OK**.

The **Maintenance** tab is displayed again.

The auto power on/off function is enabled hereafter. When you want to disable this function, select **Disable** from the list according to the same procedure.

---

### Note

- When the machine is turned off, the status monitor message varies depending on the **Auto Power On** setting.
  - When the setting is **Enable**, "Printer is standing by" is displayed.
  - When the setting is **Disable**, "Printer is offline" is displayed.

### Important

- If you connect this machine to a network and use it, you can set **Auto Power Off** but the power will not switch off automatically.
Reducing the Machine Noise

The silent function allows you to reduce the operating noise of this machine. Select when you wish to reduce the operating noise of the printer at night, etc. Using this function may lower the print speed.

The procedure for using the quiet mode is as follows:

1. Open the printer driver setup window

2. Click Quiet Settings on the Maintenance tab
   The Quiet Settings dialog box opens.

   **Note**
   - If the machine is off or if communication between the machine and the computer is disabled, an error message may appear because the computer cannot collect the machine status.

3. Set the quiet mode
   If necessary, specify one of the following items:

   **Do not use quiet mode**
   Select this option when you wish to use the machine with volume of normal operating noise.

   **Always use quiet mode**
   Select this option when you wish to reduce the operating noise of the machine.

   **Use quiet mode during specified hours**
   Select this option when you wish to reduce the operating noise of the machine during a specified period of time.
   Set the **Start time** and the **End time** of the quiet mode you wish to be activated. If both are set to the same time, the quiet mode will not function.

   **Important**
   - You can set the quiet mode from the operation panel of the machine, the printer driver, or ScanGear (scanner driver).
   No matter how you use to set the quiet mode, the mode is applied when you
perform operations from the operation panel of the machine or printing and scanning from the computer.

- If you specify a time for **Use quiet mode during specified hours**, quiet mode is not applied to operations (copy, direct print, etc.) performed directly from the machine.

4. Apply the settings

   Make sure that the machine is on and click **OK**. Click **OK** when the confirmation message appears.

   The settings are enabled hereafter.

**Note**

- The effects of the quiet mode may be less depending on the print quality settings.
Changing the Machine Operation Mode

If necessary, switch between various modes of machine operation.

The procedure for configuring **Custom Settings** is as follows:

1. Open the printer driver setup window

2. Make sure that the machine is on, and then click **Custom Settings** on the **Maintenance** tab
   
   The **Custom Settings** dialog box opens.

   **Note**
   
   - If the machine is off or if communication between the machine and the computer is disabled, an error message may appear because the computer cannot collect the machine status.
   - If this happens, click **OK** to display the most recent settings specified on your computer.

3. If necessary, complete the following settings:

   **Prevent paper abrasion**
   
   The machine can increase the gap between the print head and the paper during high-density printing to prevent paper abrasion.
   
   Check this check box to prevent paper abrasion.

   **Align heads manually**
   
   Usually, the **Print Head Alignment** function on the **Maintenance** tab is set to automatic head alignment, but you can change it to manual head alignment.
   
   If the printing results are unsatisfactory even after you execute automatic head alignment, **execute manual head alignment**.
   
   Check this check box to perform the manual head alignment. Uncheck this check box to perform the automatic head alignment.

   **Prevent paper double-feed**
   
   Select this check box only if the machine is feeding multiple sheets of plain paper at the same time.
Using this function slows down the print speed.

Rotate 90 degrees left when orientation is [Landscape]
On the Page Setup tab, you can change the rotation direction of the Landscape in the Orientation.
To rotate the print data 90 degrees to the left during printing, select this item. To rotate the print data 90 degrees to the right during printing, clear this item.

Important
Do not change this setting while the print job is displayed in the print wait list. Otherwise, characters may be omitted or the layout may become corrupt.

Detect the paper width when printing from computer
When you print from the computer, this function identifies the paper that was loaded into this machine.
When the paper width detected by the machine differ from the width of the paper specified in Page Size on the Page Setup tab, a message is displayed.
To use paper width detection when printing from the computer, select the check box.

Important
If you are using user-defined paper, use the Custom Paper Size to correctly set the size of the paper loaded in the machine.
If an error message is displayed even though the same size that was set is loaded, clear the check box.

Ink Drying Wait Time
You can set the length of the machine rest time until printing of the next page begins.
Moving the slider to the right increases the pause time, and moving the slider to the left decreases the time.
If the paper gets stained because the next page is ejected before the ink on the printed page dries, increase the ink drying wait time.
Reducing the ink drying wait time speeds up printing.

4. Apply the settings
Click OK and when the confirmation message appears, click OK.
The machine operates with the modified settings hereafter.
Changing the Machine Settings on the LCD

- Changing the Machine Settings on the LCD
- Print settings
- LAN settings
- Device user settings
- Language selection
- Firmware update
- Reset setting
- About ECO settings
- About Quiet setting
- Before Using the Machine with the Access Point Mode
Changing the Machine Settings on the LCD

This section describes the procedure to change the settings in the Device settings screen, taking the steps to specify Extended copy amount as an example.

1. Make sure that the machine is turned on.

2. Select Setup on the HOME screen.

   ➔ LCD and Operation Panel

3. Select Device settings, then press the OK button.

   The Device settings screen is displayed.

4. Use the ▲▼ button to select the setting item, then press the OK button.

   The setting screen for the selected item is displayed.

5. Use the ▲▼ button to select the menu, then press the OK button.

6. Use the ▲▼ button to select the setting item, then press the OK button.
You can select the setting menus below.

- **Print settings**
- **LAN settings**
- **Device user settings**
- **Language selection**
- **Firmware update**
- **Reset setting**

**Note**

- You can use the machine considering the environment, such as setting 2-sided printing as default or enabling the machine to turn on/off automatically.
  - **About ECO settings**
- You can reduce the operating noise when printing at night.
  - **About Quiet setting**
Print settings

• Prevent paper abrasion

Use this setting only if the print surface becomes smudged.

**Important**

- Be sure to set this back to OFF after printing since it may result in lower printing speed or lower print quality.

• Extended copy amount

Selects the amount of image that extends off the paper when printing in borderless (full).

Slight cropping may occur at the edges since the copied image is enlarged to fill the whole page. You can change the width to be cropped from the borders of the original image as needed.

Cropped area will be larger if **Extended amount: Large** is selected.

**Important**

- This setting can be applied under the following conditions:
  - Performing borderless copying
  - Borderless is selected for Border when copying printed photos

**Note**

- If printouts contain margins even though you are printing in Borderless, specifying **Extended amount: Large** for this setting may help solve the problem.

• Auto photo fix setting

When ON is selected, you can select whether to print photos using the Exif information recorded in the image files when **Auto photo fix** is selected for **Photo fix** in printing a photo in online photo album.

**Note**

- This function may not be available depending on the country or region you live in.
- This function is not available after the firmware of the machine is updated.

• Prevent paper double-feed

Select ON to prevent double-feed of plain paper.

**Important**

- Select ON only when double-feed of plain paper occurs.

• Detect paper width

When you print from the machine with ON selected, the machine detects the paper width. If the size of loaded paper does not match with that specified with the machine, a message is displayed on the LCD.
LAN settings

- **WLAN active/inactive**
  Activates/deactivates wireless LAN.

- **Wireless LAN setup**
  Selects the setup method for wireless LAN connection.

  **Note**
  - You can also enter this setting menu by selecting Wireless LAN setup on the HOME screen. In this case, activate wireless LAN.

When this menu is selected, the machine starts searching for a WPS-compatible access point. If the machine detects the access point, follow the on-screen instructions to set up wireless LAN. If an access point is not detected or if you select another setup method, select one of the setup methods below.

- **Standard setup**
  Select when you perform settings for wireless LAN manually using the operation panel of the machine.

- **WPS**
  Select when you perform settings for wireless LAN using Wi-Fi Protected Setup (WPS). Select Push button method or PIN code method according to the method your access point supports, then follow the on-screen instructions.

- **Other setup**
  Select Advanced setup if you perform settings by entering the access point's settings directly on the machine. Select Cableless setup if you specify the settings of the access point information to the machine directly from a device (such as a smartphone) without operating the access point. Follow the on-screen instructions of the connecting device for the setup procedure.

- **Confirm LAN settings**
  The list of wireless LAN settings of this machine is displayed on the LCD. You can print the list from this setting menu.

- **WLAN setting list**
  The list of wireless LAN settings of this machine is displayed on the LCD.
  The following setting items are displayed.

<table>
<thead>
<tr>
<th>Items</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Active/Inactive</td>
</tr>
</tbody>
</table>
| SSID                | XXXXXXXXXXXXXXXXXXXXXX  
<pre><code>                  | XXXXXXXXXXXXXXXXXXXXXX        |
</code></pre>
<p>| Communication mode  | Infrastructure                                                         |
| Channel             | XX                                                                      |
| Wireless LAN security| Inactive/WEP(64bit)/WEP(128bit)/WPA-PSK(TKIP)/WPA-PSK(AES)/WPA2-PSK(TKIP)/WPA2-PSK(AES) |</p>
<table>
<thead>
<tr>
<th><strong>IPv4 address</strong></th>
<th>XXX. XXX. XXX. XXX</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IPv4 subnet mask</strong></td>
<td>XXX. XXX. XXX. XXX</td>
</tr>
<tr>
<td><strong>IPv4 default gateway</strong></td>
<td>XXX. XXX. XXX. XXX</td>
</tr>
<tr>
<td><strong>IPv6 address</strong></td>
<td>XXXX: XXXX: XXXX: XXXX: XXXX: XXXX: XXXX: XXXX</td>
</tr>
<tr>
<td><strong>IPv6 subnet prefix length</strong></td>
<td>XXX</td>
</tr>
<tr>
<td><strong>IPv6 default gateway</strong></td>
<td>XXXX: XXXX: XXXX: XXXX: XXXX: XXXX: XXXX: XXXX</td>
</tr>
<tr>
<td><strong>MAC address</strong></td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td><strong>IPsec settings</strong></td>
<td>Enable (ESP)/Enable (ESP &amp; AH)/Enable (AH)/Disable</td>
</tr>
<tr>
<td><strong>Pre-shared key</strong></td>
<td>XXXXXXXXXXXXXXXXXXX</td>
</tr>
<tr>
<td><strong>Printer name</strong></td>
<td>XXXXXXXXXXXXXXXXXXX</td>
</tr>
<tr>
<td><strong>Bonjour service name</strong></td>
<td>XXXXXXXXXXXXXXXXX</td>
</tr>
<tr>
<td></td>
<td>XXXXXXXXXXXXXXXXX</td>
</tr>
<tr>
<td></td>
<td>XXXXXXXXXXXXXXXXX</td>
</tr>
<tr>
<td></td>
<td>XXXXXXXXXXXXXXXXX</td>
</tr>
</tbody>
</table>

(“XX” represents alphanumeric characters.)

- **Print LAN details**
  You can print out the network settings of the machine such as its IP address and SSID.
  For more information on the machine’s network setting is printed out:

  ➤ [Printing Out Network Setting Information](#)

  **Important**
  - This printout contains valuable information about your computer. Handle it with care.

- **Other settings**
  - **Set printer name**
    Specifies the printer name. You can use up to 15 characters for the name.

  **Note**
  - You cannot use the same printer name as that already used for other LAN connected devices.
  - You cannot use a hyphen for the initial or last character of the printer name.

- **TCP/IP settings**
  Performs IPv4 or IPv6 setting.

- **WSD setting**
  Setting items when you use WSD (one of the network protocols supported in Windows 8, Windows 7, and Windows Vista).

  **Enable/disable WSD**
  Selects whether WSD is enabled or disabled.
Note

- When this setting is activated, the printer icon is displayed on the Network Explorer in Windows 8, Windows 7 and Windows Vista.

**WSD scan from this device**

Selecting **Enable** allows you to transfer the scanned data to the computer using WSD.

**Timeout setting**

Specifies the timeout length.

- **Bonjour settings**

Setting items for LAN using Bonjour for Mac OS.

**Enable/disable Bonjour**

Selecting **Enable** allows you to use Bonjour to perform the network settings.

**Service name**

Specifies the Bonjour service name. You can use up to 48 characters for the name.

Note

- You cannot use the same service name as that already used for other LAN connected devices.

- **LPR protocol setting**

Activates/deactivates the LPR setting.

- **Wireless LAN DRX setting**

Selecting **Enable** allows you to activate discontinuous reception when using wireless LAN. It allows you to save electricity.

Note

- Depending on the access point you are using, discontinuous reception may not be activated even though **Enable** is selected.

- Discontinuous reception is activated only while the machine is on standby. (The LCD is in the screen saver mode.)

- **Access point mode settings**

When you use the machine as an access point, specify the access point name and the security setting.

➤ Before Using the Machine with the Access Point Mode
Device user settings

• Date display format
  Changes the display format of dates on the LCD.

  Note
  • This function may not be available depending on the country or region you live in.
  • This function is not available after the firmware of the machine is updated.

• Key repeat
  Enables/Disables continuous input by pressing and holding down the ▲, ▼, ◀, ▶, +, or - button when setting the number of copies, changing the photo displayed on the LCD, setting the zoom ratio, etc.

• Device info sending setting
  Selects whether you will send the printer usage information to Canon server. The information sent to Canon will be utilized to develop better products. Select Agree to send the printer usage information to Canon server.
Language selection

Changes the language for messages and menus on the LCD.
Firmware update

You can update the firmware of the machine, check the firmware version, or perform settings of a notification screen, a DNS server and a proxy server.

**Note**

- Only Check current version is available when Disable LAN is selected for WLAN active/inactive in LAN settings.

- Install update

  Performs the firmware update of the machine. If you select Yes, the firmware update starts. Follow the on-screen instructions to perform update.

  **Important**

  - When you use this function, make sure that the machine is connected to the Internet.

  **Note**

  - If the firmware update is not complete, check the following and take an appropriate action.
    - Check the network settings such as an access point or a router.
    - If Cannot connect to the server. is displayed on the LCD, press the OK button, then try again after a while.

- Check current version

  You can check the current firmware version.

- Update notification setting

  When ON is selected and the firmware update is available, the screen to inform you of the firmware update is displayed on the LCD.

- DNS server setup

  Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup, follow the display on the LCD to perform settings.

- Proxy server setup

  Performs settings for a proxy server. Follow the display on the LCD to perform settings.
Reset setting

You can change the settings back to the default.

• **Web service setup only**
  Reverts the Web service settings back to the default.

• **LAN settings only**
  Reverts the LAN settings back to the default.

• **Settings only**
  Reverts the settings such as the paper size or media type back to the default.

• **Device info sending setting only**
  Reverts only the device information sending settings.

• **Reset all**
  Reverts all settings you made to the machine back to default.

---

**Note**

• You cannot change the following setting items back to the default:
  • The language displayed on the LCD
  • The current position of the print head
About ECO settings

This setting allows you to use automatic duplex printing as a default to save paper and to turn the machine on/off automatically to save electricity.

➡️ Using Duplex Printing
➡️ Using Power Saving Function

Using Duplex Printing

Follow the procedure below to use duplex printing.

1. Make sure that the machine is turned on.
2. Select ECO settings on the HOME screen.
   ➡️ LCD and Operation Panel
3. Select Two-sided printing setting, then press the OK button.
4. Use the ▲▼ button to change the setting item, use the ◀▶ button to change the setting, then use the OK button to confirm the selection.

   1. Copy
      Sets two-sided copying as a default.
   2. Template print
      Sets two-sided printing of template forms on the machine as a default.

   ➤➤ Note

   • When duplex printing is selected, the icon is displayed on each menu of the HOME screen or on the setting items for duplex printing on each print setting screen.

Using Power Saving Function

Follow the procedure below to use power saving function.

1. Make sure that the machine is turned on.
2. Select **ECO settings** on the **HOME** screen.

   ➤ LCD and Operation Panel

3. Select **Energy saving settings**, then press the **OK** button.

4. Use the ▲▼ button to change the setting item, use the ◄► button to change the setting, then use the **OK** button to confirm the selection.

   ![Energy saving settings menu](image)

   1. **Auto power off**
      
      Specifies the length of time to turn the machine off automatically when no operation is made or no printing data is sent to the machine.

      | Note |
      |------|
      | • The Auto power off setting is invalid when using the machine via a network and the network connection is enabled.  
      | You can check the connection status from WLAN setting list in Confirm LAN settings under LAN settings. |

   2. **Auto power on**
      
      Selecting **ON** enables the machine to turn on automatically when a scanning command from a computer or printing data is sent to the machine.
About Quiet setting

Enables this function on the machine if you want to reduce the operating noise, such as when printing at night.

Follow the procedure below to perform setting.

1. **Make sure that the machine is turned on.**

2. Select **Quiet setting** on the HOME screen.

3. Use the ▲▼ button to select **Use quiet mode**, then press the **OK** button.

   The confirmation screen is displayed, then the on icon appears as the **Quiet setting** menu icon.

   Activate this setting to reduce the operating noise while printing is in progress.

   **Important**
   - Operating speed may be reduced compared to when **Do not use quiet mode** is selected.
   - This function may not be so effective depending on the machine's setting. Furthermore, certain noise, such as when the machine is preparing for printing, is not reduced.

   **Note**
   - You can set the quiet mode from the operation panel of the machine, the printer driver, or ScanGear (scanner driver). No matter how you use to set the quiet mode, the mode is applied when you perform operations from the operation panel of the machine or printing and scanning from the computer.
Before Using the Machine with the Access Point Mode

When you use the machine with the access point mode, be sure to specify the access point name of the machine and the security setting in advance.

Setting Procedure When Using the Machine with the Access Point Mode

1. Make sure that the machine is turned on.

2. Select Setup on the HOME screen.

3. Select Device settings, then press the OK button.

4. Use the button to select LAN settings, then press the OK button.

5. Use the button to select Other settings, then press the OK button.

6. Use the button to select Access point mode settings, then press the OK button.
   The screen to specify the access point name is displayed.

7. Press the OK button.

8. Enter the access point name.
   Enter the access point name when you use the machine as an access point.

9. Press the left Function button to finish entering the name.

10. Press the left Function button to finish specifying the access point name.

11. Use the button to select the security setting, then press the OK button.
   Disable
   Finishes the access point settings without specifying the security setting.

   WPA2-PSK (AES)
   Specifies the security setting applying WPA2-PSK (AES). Proceed to the next step when the screen to specify the passphrase.

12. Press the OK button.

13. Enter the passphrase.

14. Press the left Function button to finish entering the passphrase.
15. Press the left **Function** button to finish specifying the passphrase setting.

For details on printing or scanning with the access point mode:

- Printing with the Access Point Mode
- Scanning with the Access Point Mode

**Restrictions on Using the Access Point Mode**

When you use the machine with the access point mode, note the following.

- Up to 5 external devices (ex: smartphone) can be connected to the machine.
- While you are using the machine with the access point mode, you cannot perform the operations below.
  - Operations using the operation panel of the machine (ex: copying or scanning)
  - Operations necessary to connect the machine to the Internet
  - Changing the network settings of the machine or displaying the network settings
Information about Network Connection

- Useful Information about Network Connection
Useful Information about Network Connection

- Initial Values Set at Factory (Network)
- Connecting the Machine to the Computer Using a USB Cable
- When Detecting the Printers Have the Same Name during Setup
- Connecting to Other Computer with LAN/Changing the Connection Method from USB to LAN
- Printing Out Network Setting Information
# Initial Values Set at Factory (Network)

<table>
<thead>
<tr>
<th>Item</th>
<th>Initial Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>WLAN active/inactive</td>
<td>Disable LAN</td>
</tr>
<tr>
<td>SSID</td>
<td>BJNPSETUP</td>
</tr>
<tr>
<td>Communication mode</td>
<td>Infrastructure</td>
</tr>
<tr>
<td>Wireless LAN security</td>
<td>Disable</td>
</tr>
<tr>
<td>IP address (IPv4)</td>
<td>Auto setup</td>
</tr>
<tr>
<td>IP address (IPv6)</td>
<td>Auto setup</td>
</tr>
<tr>
<td>Set printer name*</td>
<td>XXXXXXXXXXXXX</td>
</tr>
<tr>
<td>Enable/disable IPv6</td>
<td>Enable</td>
</tr>
<tr>
<td>Enable/disable WSD</td>
<td>Enable</td>
</tr>
<tr>
<td>Timeout setting</td>
<td>1 minute</td>
</tr>
<tr>
<td>Enable/disable Bonjour</td>
<td>Enable</td>
</tr>
<tr>
<td>Service name</td>
<td>Canon MG5500 series</td>
</tr>
<tr>
<td>LPR protocol setting</td>
<td>Enable</td>
</tr>
<tr>
<td>Wireless LAN DRX setting</td>
<td>Enable</td>
</tr>
</tbody>
</table>

("XX" represents alphanumeric characters.)

* The initial value in this item varies by machine. You can check the value in this item using the operation panel on the machine.

⇒ **LAN settings**
Connecting the Machine to the Computer Using a USB Cable

Connect the machine and the computer using a USB cable as the illustration below. The USB port is located on the rear of the machine.
When Detecting the Printers Have the Same Name during Setup

When the printer is detected during setup, you may see multiple printers of the same name on the detection result screen.

Select a printer with checking the MAC address set to the printer against the MAC address on detection result screen.

To check the MAC address of the printer, print out the network setting information using the operation panel of the printer.

➤ Printing Out Network Setting Information

Additionally, you can check the network setting information on the LCD of the printer. Select WLAN setting list from Confirm LAN settings in LAN settings under Device settings, and check the item displayed on the LCD.

➤ LAN settings
Connecting to Other Computer with LAN/Changing the Connection Method from USB to LAN

To add the computer connecting the printer with LAN or to change the connection method between the printer and the computer from USB to LAN, perform setup with the Setup CD-ROM or perform it according to the instructions on our website.

Connecting to Other Computer with LAN

To add the computer connecting the printer with LAN, perform setup with the Setup CD-ROM or perform it according to the instructions on our website.

Changing the Connection Method from USB to LAN

To change the connection method between the printer and the computer from USB to LAN, perform setup with the Setup CD-ROM or perform it according to the instructions on our website.

To change the connection method to LAN while you are using the printer with USB connection, perform setup again with the Setup CD-ROM or perform it again according to the instructions on our website and select Change Connection Method.
Printing Out Network Setting Information

You can print out the network settings of the machine such as its IP address and SSID.

**Important**

- This print out contains valuable information about your computer. Handle it with care.

1. **Make sure that the machine is turned on.**

2. **Load a sheet of A4 or Letter-sized plain paper.**

3. Select **Setup** on the **HOME** screen.

   - **LCD and Operation Panel**
     The menu screen is displayed.

4. Select **Device settings**, then use the **OK** button to confirm the selection.

5. Use the ▲▼ button to select **LAN settings**, then use the **OK** button to confirm the selection.

6. Use the ▲▼ button to select **Confirm LAN settings**, then use the **OK** button to confirm the selection.

7. Use the ▲▼ button to select **Print LAN details**, then use the **OK** button to confirm the selection.

8. Use the ▲▼ button to select **Yes**, then use the **OK** button to start printing.

   The machine starts printing the network setting information.

   The following information on the machine’s network setting is printed out.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanations of the item</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless LAN</td>
<td>Wireless LAN</td>
<td>Enable/Disable</td>
</tr>
<tr>
<td>Connection</td>
<td>Status of the Wireless LAN</td>
<td>Active/Inactive</td>
</tr>
<tr>
<td>MAC Address</td>
<td>MAC Address</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>SSID</td>
<td>SSID</td>
<td>SSID of the wireless LAN</td>
</tr>
<tr>
<td>Communication Mode</td>
<td>Communication Mode</td>
<td>Infrastructure</td>
</tr>
<tr>
<td>Channel</td>
<td>Channel</td>
<td>XX (1 to 13)</td>
</tr>
<tr>
<td>Encryption</td>
<td>Method of the Encryption</td>
<td>none/WEP/TKIP/AES</td>
</tr>
<tr>
<td>WEP Key Length</td>
<td>WEP Key Length</td>
<td>Inactive/128/64</td>
</tr>
<tr>
<td><strong>Authentication</strong></td>
<td>Method of the Authentication</td>
<td>none/auto/open/shared/WPA-PSK/WPA2-PSK</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td><strong>Signal Strength</strong></td>
<td>Signal Strength</td>
<td>0 to 100 [%]</td>
</tr>
<tr>
<td><strong>TCP/IP Version</strong></td>
<td>TCP/IP Version</td>
<td>IPv4 &amp; IPv6/IPv4</td>
</tr>
<tr>
<td><strong>IPv4 IP Address</strong></td>
<td>Selected IP Address (IPv4)</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td><strong>IPv4 Default Gateway</strong></td>
<td>Default Gateway (IPv4)</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td><strong>Subnet Mask</strong></td>
<td>Subnet Mask</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>*<em>IPv6 IP Address <em>1</em></em></td>
<td>Selected IP Address (IPv6)</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>*<em>IPv6 Default Gateway <em>1</em></em></td>
<td>Default Gateway (IPv6)</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td><strong>Subnet Prefix Length*1</strong></td>
<td>Subnet Prefix Length</td>
<td>XXX</td>
</tr>
<tr>
<td><strong>IPsec*2</strong></td>
<td>IPsec setting</td>
<td>Active</td>
</tr>
<tr>
<td><strong>Security Protocol*2</strong></td>
<td>Method of the Security Protocol</td>
<td>ESP/ESP &amp; AH/AH</td>
</tr>
<tr>
<td><strong>Wireless LAN DRX</strong></td>
<td>Discontinuous reception (wireless LAN)</td>
<td>Enable/Disable</td>
</tr>
<tr>
<td><strong>Other Settings</strong></td>
<td>Other settings</td>
<td>-</td>
</tr>
<tr>
<td><strong>Printer Name</strong></td>
<td>Printer name</td>
<td>Printer name (Up to 15 characters)</td>
</tr>
<tr>
<td><strong>WSD</strong></td>
<td>WSD setting</td>
<td>Enable/Disable</td>
</tr>
<tr>
<td><strong>WSD Timeout</strong></td>
<td>Timeout</td>
<td>1/5/10/15/20 [min]</td>
</tr>
<tr>
<td><strong>LPR Protocol</strong></td>
<td>LPR protocol setting</td>
<td>Enable/Disable</td>
</tr>
<tr>
<td><strong>Bonjour</strong></td>
<td>Bonjour setting</td>
<td>Enable/Disable</td>
</tr>
<tr>
<td><strong>Bonjour Service Name</strong></td>
<td>Bonjour service name</td>
<td>Bonjour service name (Up to 52 characters)</td>
</tr>
<tr>
<td><strong>DNS Server</strong></td>
<td>Getting DNS Server automatically</td>
<td>Auto/Manual</td>
</tr>
<tr>
<td><strong>Primary Server</strong></td>
<td>Primary server address</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td><strong>Secondary Server</strong></td>
<td>Secondary server address</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td><strong>Proxy Server</strong></td>
<td>Proxy Server setting</td>
<td>Enable/Disable</td>
</tr>
<tr>
<td><strong>Proxy Port</strong></td>
<td>Specifying Proxy Port</td>
<td>1 to 65535</td>
</tr>
<tr>
<td><strong>Proxy Address</strong></td>
<td>Proxy Address</td>
<td>XXXXXXXXXXXXXXXXXXXXXXX</td>
</tr>
<tr>
<td><strong>IP Address Filtering</strong></td>
<td>IP Address Filtering</td>
<td>Enable/Disable</td>
</tr>
</tbody>
</table>

("XX" represents alphanumeric characters.)

*1 Only when IPv6 is activated, the status of the network is printed.

*2 Only IPv6 and the IPsec setting are activated, the status of the network is printed.
About Network Communication

- Changing and Confirming Network Settings
- Screens for Network Connection of IJ Network Tool
- Other Screens of IJ Network Tool
- Appendix for Network Communication
Changing and Confirming Network Settings

- IJ Network Tool
- Changing the Settings in the Wireless LAN Sheet
- Changing the WEP Detailed Settings
- Changing the WPA or WPA2 Detailed Settings
- Changing the Settings in the Wired LAN Sheet
- Changing the Settings in the Admin Password Sheet
- Monitoring Wireless Network Status
- Initializing the Network Settings of the Machine
- Viewing the Modified Settings
IJ Network Tool

IJ Network Tool is a utility that enables you to display and modify the machine network settings. It is installed when the machine is set up.

**Important**

- To use the machine over LAN, make sure you have the equipment necessary for the connection type, such as an access point or a LAN cable.
- Do not start up IJ Network Tool while printing.
- Do not print when IJ Network Tool is running.
- If the firewall function of your security software is turned on, a message may appear warning that Canon software is attempting to access the network. If the warning message appears, set the security software to always allow access.
- IJ Network Tool has been verified to work on Windows XP, however, it does not support Fast User Switching. It is recommended to exit IJ Network Tool when switching users.

**Starting up IJ Network Tool**

1. Start up IJ Network Tool as shown below.
   - In Windows 8, select **IJ Network Tool** on the **Start** screen to start IJ Network Tool. If **IJ Network Tool** is not displayed on the **Start** screen, select the **Search** charm, then search for "IJ Network Tool".
   - In Windows 7, Windows Vista, or Windows XP, click **Start** and select **All programs, Canon Utilities, IJ Network Tool**, and then **IJ Network Tool**.

**Note**

- You can also start up IJ Network Tool by clicking **Network Settings** from **Device Settings & Maintenance** on Quick Menu.
Changing the Settings in the Wireless LAN Sheet

To change the wireless network settings of the printer, connect the printer and the computer with a USB cable temporarily. If you modify the wireless network settings of the computer over wireless connection without USB connection, your computer may not be able to communicate with the machine after modifying the settings.

Note

• This screen is not available depending on the printer you are using.

• Activate the wireless LAN setting of the printer to change the settings in the Wireless LAN sheet.

1. Start up IJ Network Tool.

2. Select the printer in Printers:

   When the printer is connected to the computer with a USB cable temporarily, select the printer with "USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

   The Wireless LAN sheet is displayed.

For details on the Wireless LAN sheet, see Wireless LAN Sheet.

5. Change the settings or confirm.

SSID:

Enter the same value that was set for the target access point.

When the printer is connected with USB, the Search screen appears by clicking Search.... Set the SSID of the access point by selecting the one of the detected access points.

Search Screen
Note

• Enter the same SSID that the access point is configured to use. The SSID is case-sensitive.

Encryption Method:
Select the encryption method used over the wireless LAN.
You can change WEP settings with selecting Use WEP and clicking Configuration....
➡ Changing the WEP Detailed Settings
You can change WPA or WPA2 settings with selecting Use WPA or Use WPA2 and clicking Configuration....
➡ Changing the WPA or WPA2 Detailed Settings

Important

• If all encryption types of the access point, printer, or computer do not match, the printer cannot communicate with the computer. If the printer cannot communicate with the computer after the encryption type of the printer was switched, make sure that encryption types for the computer and the access point matches that set to the printer.

• If you connect to a network that is not protected with security measures, there is a risk of disclosing data such as your personal information to a third party.

TCP/IP Setup:
Sets the IP address of the printer to be used over the LAN. Set a value appropriate for your network environment.

6. Click OK.

After changing configuration, a screen is displayed asking you for confirmation before the settings are sent to the printer. If you click Yes, the settings are sent to the printer and the Transmitted Settings screen is displayed.

Note

• Changing the network settings with the USB cable temporarily may switch the default printer. In this case, reset Set as Default Printer.
Changing the WEP Detailed Settings

Note

• This screen is not available depending on the printer you are using.

To change the wireless network settings of the printer, connect the printer and the computer with a USB cable temporarily. If you modify the wireless network settings of the computer over wireless connection without USB connection, your computer may not be able to communicate with the machine after modifying the settings.

1. Start up IJ Network Tool.

2. Select the printer in Printers:

   When the printer is connected to the computer with a USB cable temporarily, select the printer with "USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

5. Select Use WEP in Encryption Method: and click Configuration....

   The WEP Details screen is displayed.

6. Change the settings or confirm.

   When changing the password (WEP key), the same change must be made to the password (WEP key) of the access point.

   **WEP Key:**

   Enter the same key as the one set to the access point.

   The number of characters and character type that can be entered differ depending on the key length and key format.

<table>
<thead>
<tr>
<th>Key Format</th>
<th>ASCII</th>
<th>64bit</th>
<th>128bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Length</td>
<td>5 characters</td>
<td>13 characters</td>
<td></td>
</tr>
</tbody>
</table>

   ![WEP Details](image)
2. **Key Length:**
   Select either 64bit or 128bit.

3. **Key Format:**
   Select either ASCII or Hex.

4. **Key ID:**
   Select the Key ID (index) set to the access point.

5. **Authentication:**
   Select the authentication method to authenticate the printer's access to the access point.
   Normally, select Auto. If you want to specify the method manually, select Open System or Shared Key according to the setting of the access point.

7. Click **OK**.

### Important
- If the printer cannot communicate with the computer after the encryption type of the printer was switched, make sure that encryption types for the computer and the access point matches that set to the printer.

### Note
- Changing the network settings with the USB cable temporarily may switch the default printer. In this case, reset Set as Default Printer.
Changing the WPA or WPA2 Detailed Settings

Note

• This screen is not available depending on the printer you are using.

To change the wireless network settings of the printer, connect the printer and the computer with a USB cable temporarily. If you modify the wireless network settings of the computer over wireless connection without USB connection, your computer may not be able to communicate with the machine after modifying the settings.

The example screenshots in this section refer to the WPA detailed settings.

1. Start up IJ Network Tool.

2. Select the printer in Printers:.

   When the printer is connected to the computer with a USB cable temporarily, select the printer with "USBnnn" (where "n" is a number) appearing in the Port Name column.

3. Select Configuration... from the Settings menu.

4. Click the Wireless LAN tab.

5. Select Use WPA or Use WPA2 in Encryption Method: and click Configuration....

   The WPA Details screen is displayed (For WPA2, the WPA2 Details screen is displayed).

   If encryption is not set to the printer, the Authentication Type Confirmation screen is displayed. Go to step 7.

6. Click Change Settings....

   ![WPA Details screenshot]

7. Check the client authentication type and click Next>.
8. Enter the passphrase, confirm the type of dynamic encryption and click **Next>**.

Enter the passphrase set to the access point. The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal value.

If you do not know the access point passphrase, refer to the instruction manual provided with the access point or contact its manufacturer.

9. Click **Finish**.
Important

- If the printer cannot communicate with the computer after the encryption type of the printer was switched, make sure that encryption types for the computer and the access point matches that set to the printer.

Note

- Changing the network settings with the USB cable temporarily may switch the default printer. In this case, reset Set as Default Printer.
Changing the Settings in the Wired LAN Sheet

**Note**

- This screen is not available depending on the printer you are using.
- Activate the wired LAN setting of the printer to change the settings in the Wired LAN sheet.

1. Start up IJ Network Tool.

2. Select the printer in Printers:

3. Select Configuration... from the Settings menu.

4. Click the Wired LAN tab.
   
The Wired LAN sheet is displayed.

   ![Wired LAN Sheet](image)

   For details on the Wired LAN sheet, see Wired LAN Sheet.

5. Change the settings or confirm.

   Sets the IP address of the printer to be used over the LAN. Set a value appropriate for your network environment.

6. Click OK.

   After changing configuration, a screen is displayed asking you for confirmation before the settings are sent to the printer. If you click Yes, the settings are sent to the printer and the Transmitted Settings screen is displayed.
Changing the Settings in the Admin Password Sheet

1. Start up IJ Network Tool.

2. Select the printer in Printers:

3. Select Configuration... from the Settings menu.

4. Click the Admin Password tab.

   The Admin Password sheet is displayed.

5. Change the settings or confirm.

   To use admin password, select the Use admin password check box and enter a password.

   **Important**

   - The password should consist of alphanumeric characters and be no longer than 32 characters. The password is case-sensitive. Do not forget the password you set.

6. Click OK.

   A screen is displayed asking you for confirmation before the settings are sent to the printer. If you click Yes, the settings are sent to the printer and the Transmitted Settings screen is displayed.
Monitoring Wireless Network Status

Note

• This screen is not available depending on the printer you are using.
• When using the machine over the wired LAN, you cannot monitor network status.

1. **Start up IJ Network Tool.**

2. Select the printer in **Printers**.

3. Select **Status** from the **View** menu.

   The **Status** screen is displayed and you can check the printer status and connection performance.

   ![Status Screen](image)

   **Important**

   • If the indicated value is low, move your printer closer to the wireless network device.

4. If you measure the connection performance in detail, click **Advanced Measurement**.

   The **Connection Performance Measurement** screen is displayed.

5. Click **Next**.

   The measurement starts and the status displays. Measurement takes a few minutes.
6. Check the status.

When the measurement is complete, the status is displayed.

When ✔️ is displayed in Connection Performance between the Printer and the Access Point, the printer can communicate with the access point. Otherwise, refer to displayed comments and the following to improve the status of communication link, and click Remeasurement.

- Check that the printer and the access point are located within the wireless connectivity range with no obstacles between them.
- Check if the distance between the printer and the access point is not too far.
  If they are too far, move them closer together (within 164 ft./50 m).
- Check that there is no barrier or obstacle between the printer and the access point.
  In general, connection performance decreases for communications through walls or between different floors. Adjust the locations to avoid such situations.
- Check that there are no sources of radio interference near the printer and the access point.
  The wireless connection may use the same frequency band as microwave ovens and other sources of radio interference. Try to keep the printer and the access point away from such sources.
- Check if the radio channel of the access point is close to that of other access points nearby.
  If the radio channel of the access point is close to that of other access points nearby, the connection performance may become unstable. Be sure to use a radio channel that does not interfere with other access points.
- Check that the printer and the access point face each other.
  Connection performance may depend on the orientations of the wireless devices. Replace the access point and the printer in another direction to achieve the best performance.
- Check whether other computers are not accessing the printer.
  If ❔ appears in the result of the measurement, check whether other computers are not accessing the printer.
If still appears even if you have tried the above, finish the measurement, then restart the IJ Network Tool to start over the measurement.

7. Click **Finish**.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>- If any messages appear on <em>Overall Network Performance</em>; move the machine and access point as instructed to improve the performance.</td>
</tr>
</tbody>
</table>
Initializing the Network Settings of the Machine

⚠️ Important

- Note that initialization erases all network settings on the machine, printing or scanning operation from a computer over network may become impossible. To use the machine over network, perform setup with the Setup CD-ROM or perform setup according to the instructions on our website.

1. **Start up IJ Network Tool.**

2. Select the printer in **Printers**.

3. Select **Maintenance...** from the **Settings** menu.

   The **Maintenance** screen is displayed.

4. Click **Initialize**.

5. When the confirmation screen is displayed, click **Yes**.

   The network settings of the printer is initialized.

   Do not turn off the printer during initialization.

   Click **OK** when initialization is complete.

   Performing initialization when connected over wireless LAN will break the connection, so perform setup with the Setup CD-ROM or perform setup according to the instructions on our website.

⚠️ Note

- You can change the network settings of the printer using IJ Network Tool with USB connection after initializing the LAN settings. To change the network settings using Canon IJ Network Tool, activate wireless LAN in advance.
Viewing the Modified Settings

The **Confirmation** screen is displayed when you modified the printer settings on the **Configuration** screen. When you click **Yes** on the **Confirmation** screen, the following screen is displayed for confirming the modified settings.
Screens for Network Connection of IJ Network Tool

- Canon IJ Network Tool Screen
- Configuration Screen
- Wireless LAN Sheet
- Search Screen
- WEP Details Screen
- WPA Details Screen
- WPA2 Details Screen
- Authentication Type Confirmation Screen
- PSK: Passphrase and Dynamic Encryption Setup Screen
- Setup Information Confirmation Screen
- Wired LAN Sheet
- Admin Password Sheet
- Network Information Screen
- Access Control Sheet
- Edit Accessible MAC Address Screen/Add Accessible MAC Address Screen
- Edit Accessible IP Address Screen/Add Accessible IP Address Screen
Canon IJ Network Tool Screen

This section describes the items and menus displayed on the Canon IJ Network Tool screen.

Items on the Canon IJ Network Tool Screen

The following item is displayed on the Canon IJ Network Tool screen.

1. Printers:
   The printer name, status, printer model name, and port name are displayed.
   A check mark next to the printer in the Name list indicates it is set as the default printer.
   Configuration changes are applied to the selected printer.

2. Update
   Performs printer detection again. Click this button if the target printer is not displayed.

   Important
   • To change the printer’s network settings using IJ Network Tool, it must be connected via a LAN.
   • If No Driver is displayed for the name, associate the port with the printer.
   • If Not Found is displayed for the status, check the followings:
     • The access point is turned on.
     • When using wired LAN, the LAN cable is connected properly.
   • If the printer on a network is not detected, make sure that the printer is turned on, then click Update. It may take several minutes to detect printers. If the printer is not yet detected, connect the machine and the computer with a USB cable, then click Update.
   • If the printer is being used from another computer, a screen is displayed informing you of this condition.
3. **Configuration...**

Click to configure settings of the selected printer.

---

**Note**

- This item has the same function as **Refresh** in the **View** menu.

---

**Canon IJ Network Tool Menus**

The following menu is displayed from the **Canon IJ Network Tool** screen.

![Canon IJ Network Tool Screen](image)

1. **File menu**

   **Exit**

   Exits IJ Network Tool.

2. **View menu**

   **Status**

   Displays the **Status** screen to confirm the printer connection status and wireless communication status.

   ![Status Screen](image)

   **Refresh**

   Updates and displays the contents of **Printers**: on the **Canon IJ Network Tool** screen to the latest information.

---

**Important**

- To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.
- If **No Driver** is displayed for the name, associate the port with the printer.

---

243
• If **Not Found** is displayed for the status, check the followings:
  • The access point is turned on.
  • When using wired LAN, the LAN cable is connected properly.

• If the printer on a network is not detected, make sure that the printer is turned on, then select **Refresh**. It may take several minutes to detect printers. If the printer is not yet detected, connect the machine and the computer with a USB cable, then select **Refresh**.

• If the printer is being used from another computer, a screen is displayed informing you of this condition.

**Note**

- This item has the same function as **Update** in the Canon IJ Network Tool screen.

**Network Information**

Displays the **Network Information** screen to confirm the network settings of the printer and the computer.

⇒ **Network Information Screen**

**Display Warning Automatically**

Enables or disables automatic display of the instruction screen.

When this menu is selected, the instruction screen is displayed if one or more ports are unavailable for printing.

3. **Settings menu**

**Configuration...**

Displays the **Configuration** screen to configure settings of the selected printer.

⇒ **Configuration Screen**

**Note**

- This item has the same function as **Configuration...** in the Canon IJ Network Tool screen.

**Associate Port...**

Displays the **Associate Port** screen and you can associate a port with the printer.

⇒ **Associate Port Screen**

This menu is available when **No Driver** is displayed for the selected printer. Associating a port with the printer enables you to use it.

**Maintenance...**

Displays the **Maintenance** screen to revert the network settings of the printer to factory default and to mount the card slot as the network drive.

⇒ **Maintenance Screen**

4. **Help menu**

**Instructions**

Displays this guide.

**About**

Displays the version of IJ Network Tool.
Configuration Screen

You can change the configuration of the printer selected on the **Canon IJ Network Tool** screen. Click the tab to select the sheet to change the settings. The following screen is the example to change the setting on the **Wireless LAN** sheet.

**Note**

- This screen is not available depending on the printer you are using.

For details on each sheet, see the following.

- [Wireless LAN Sheet](#)
- [Wired LAN Sheet](#)
- [Admin Password Sheet](#)
Wireless LAN Sheet

Note

• This screen is not available depending on the printer you are using.

Allows you to set the printer with wireless LAN connection.

To display the Wireless LAN sheet, click the Wireless LAN tab on the Configuration screen.

1. **Network Type:**
   
   Infrastructure
   
   Connects the printer to the wireless LAN with an access point.

2. **SSID:**
   
   The SSID of the wireless LAN is displayed.
   
   As the initial settings, the unique value is displayed.

   Note

   • Enter the same SSID that the access point is configured to use. The SSID is case-sensitive.

3. **Search...**

   The Search screen is displayed to select an access point to connect to.

   Note

   • When IJ Network Tool runs over a LAN, the button is grayed out and cannot be selected. Connect the printer and the computer with a USB cable temporarily to change the settings.

4. **Encryption Method:**

   Select the encryption method used over the wireless LAN.
Do not use
Select to disable encryption.

Use WEP
Transmission is encrypted using a WEP key you specified.
If a WEP key has not been set, the WEP Details screen is displayed automatically. To change WEP settings set before, click Configuration... to display the screen.

☞ Changing the WEP Detailed Settings

Use WPA/Use WPA2
Transmission is encrypted using a WPA or WPA2 key you specified.
The security has been strengthened more than WEP.
If a WPA or WPA2 key has not been set, the Authentication Type Confirmation screen is displayed automatically. To change WPA or WPA2 settings set before, click Configuration... to display the WPA Details screen or WPA2 Details screen.

☞ Changing the WPA or WPA2 Detailed Settings

5. Configuration...
The detailed settings screen is displayed. The WEP, the WPA, or the WPA2 key selected in Encryption Method: can be confirmed and changed.

For details on WEP setting:
☞ Changing the WEP Detailed Settings

For details on WPA or WPA2 setting:
☞ Changing the WPA or WPA2 Detailed Settings

6. TCP/IP Setup:
Sets the IP address of the printer to be used over the LAN. Set a value appropriate for your network environment.

Get IP address automatically
Select this option to use an IP address automatically assigned by a DHCP server. DHCP server functionality must be enabled on your wireless LAN router or access point.

Use next IP address
If no DHCP server functionality is available in your setup where you use the printer or you want to use a particular IP address, select this option to use a fixed IP address.
Search Screen

**Note**

- This screen is not available depending on the printer you are using.

The access points detected are listed.

1. **Detected Access Points:**

   The signal strength from the access point, encryption type, name of access point, and the radio channel can be confirmed.

   **Important**
   
   - If you connect to a network that is not protected with security measures, there is a risk of disclosing data such as your personal information to a third party.

   **Note**
   
   - Signal strength is displayed as follows.
     - ●: Good
     - ▲: Fair
     - ▼: Poor
   
   - Type of encryption is displayed as follows.
     - Blank: No encryption
     - WEP: WEP is set
     - WPA: WPA is set
     - WPA2: WPA2 is set

2. **Update**

   Click to update the list of access points when your target access point is not detected.

   If the target access point is set to the stealth mode, click **Cancel** to return to the previous screen and enter the access point's SSID in **SSID** on the **Wireless LAN** sheet.

   [Wireless LAN Sheet](#)
3. **Set**

Click to set the access point's SSID in **SSID**: on the **Wireless LAN** sheet.

**Note**

- The **WEP Details** screen, the **WPA Details** screen, or the **WPA2 Details** screen appears if the selected access point is encrypted. In this case, configure the details to use the same encryption settings set to the access point.
- Access points that cannot be used by this machine (including those configured to use different encryption methods) are displayed grayed out and cannot be configured.
WEP Details Screen

Note

• This screen is not available depending on the printer you are using.

Specify the printer WEP settings.

![WEP Details Screen](image)

Note

• When changing the password (WEP key) of the printer, the same change must be made to the password (WEP key) of the access point.

1. **WEP Key:**

   Enter the same key as the one set to the access point.

   The number of characters and character type that can be entered differ depending on the key length and key format.

<table>
<thead>
<tr>
<th>Key Format</th>
<th>Key Length</th>
<th>64bit</th>
<th>128bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII</td>
<td>5 characters</td>
<td>13 characters</td>
<td></td>
</tr>
<tr>
<td>Hexadecimal (Hex)</td>
<td>10 digits</td>
<td>26 digits</td>
<td></td>
</tr>
</tbody>
</table>

2. **Key Length:**

   Select either **64bit** or **128bit**.

3. **Key Format:**

   Select either **ASCII** or **Hex**.

4. **Key ID:**

   Select the Key ID (index) set to the access point.

5. **Authentication:**

   Select the authentication method to authenticate the printer's access to the access point.

   Select **Auto** or **Open System** or **Shared Key**.
WPA Details Screen

Note

- This screen is not available depending on the printer you are using.

Specify the printer WPA settings.
The value displayed on the screen differs depending on the present settings.

1. **Authentication Type:**
   
   Displays the type of authentication used for client authentication. This machine supports the PSK authentication method.

2. **Dynamic Encryption Type:**
   
   Displays the dynamic encryption method.

3. **Change Settings...**
   
   Displays the Authentication Type Confirmation screen.

   ➤ [Authentication Type Confirmation Screen](#)
WPA2 Details Screen

Note

• This screen is not available depending on the printer you are using.

Specify the printer WPA2 settings.

The value displayed on the screen differs depending on the present settings.

1. **Authentication Type:**
   Displays the type of authentication used for client authentication. This machine supports the PSK authentication method.

2. **Dynamic Encryption Type:**
   Displays the dynamic encryption method.

3. **Change Settings...**
   Displays the Authentication Type Confirmation screen.

   ➤ [Authentication Type Confirmation Screen](#)
Authentication Type Confirmation Screen

Note

- This screen is not available depending on the printer you are using.

Type of authentication used for client authentication is displayed.

1. Authentication Type

   Type of authentication used for client authentication is displayed.

   **PSK**

   This machine supports the **PSK** authentication method.

   This authentication type **PSK** uses a passphrase.
PSK: Passphrase and Dynamic Encryption Setup Screen

Note

• This screen is not available depending on the printer you are using.

Enter the passphrase and select the dynamic encryption method.

1. **Passphrase:**
   
Enter the passphrase set to the access point. The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal value.
   
   If you do not know the access point passphrase, refer to the instruction manual provided with the access point or contact its manufacturer.

2. **Dynamic Encryption Type**
   
   Select the dynamic encryption method from either **TKIP (Basic Encryption)**, or **AES (Secure Encryption)** according to the setting of the access point.
Note

• This screen is not available depending on the printer you are using.

Displays the settings used for client authentication.

Confirm the settings and click Finish.
Wired LAN Sheet

Note

• This screen is not available depending on the printer you are using.

Allows you to set the printer with wired LAN connection.

To display the Wired LAN sheet, click the Wired LAN tab on the Configuration screen.

1. TCP/IP Setup:

Sets the IP address of the printer to be used over the LAN. Set a value appropriate for your network environment.

Get IP address automatically
Select this option to use an IP address automatically assigned by a DHCP server. DHCP server functionality must be enabled on your router.

Use next IP address
If no DHCP server functionality is available in your setup where you use the printer or you want to use a particular IP address, select this option to use a fixed IP address.
Admin Password Sheet

Set a password for the printer to allow specific people to perform setup and configurations operation. To display the Admin Password sheet, click the Admin Password tab on the Configuration screen.

1. **Use admin password**
   
   Set a password for the administrator with privileges to set up and change detailed options. To use this feature, select this check box and enter a password.

2. **Password:**
   
   Enter the password to set.

3. **Password Confirmation:**
   
   Enter the password again for confirmation.
Network Information Screen

Display the network information that is set for the printers and the computers.

To display the **Network Information** screen, select **Network Information** from the **View** menu.

1. **OK**
   
   Returns to the Canon IJ Network Tool screen.

2. **Copy All Information**
   
   All network information displayed is copy to the clipboard.
Access Control Sheet

Note

• This screen is not available depending on the printer you are using.

You can register the MAC addresses or the IP addresses of computers or network devices to allow access.

To display the Access Control sheet, click the Access Control tab on the Configuration screen.

1. Printer Access Control Type:

   Select the type of access control with which to limit access of computers or network devices to the printer over a network.

   The setting items may differ depending on the choice of access control methods.

   ➤ When Selecting MAC address

   ➤ When Selecting IP address

When Selecting MAC address

The accessible computers or network devices are specified by their MAC addresses. Computers or network devices whose MAC addresses appear on the list are allowed access.
1. **Enable printer access control (MAC address)**

Select to enable access control to the printer by MAC address.

**Note**

- The two types of access control (i.e., by MAC address and by IP address) can be enabled at the same time.

  An access control type is enabled as long as the Enable printer access control check box is selected, regardless of the type currently displayed by selecting in Printer Access Control Type.

- When both access control types are enabled at the same time, a computer or a network device whose address is registered to either list will be allowed access to the printer.

2. **Accessible MAC Addresses:**

Shows the registered MAC addresses and any comments.

3. **Edit...**

The Edit Accessible MAC Address screen is displayed to edit the settings selected in Accessible MAC Addresses.

   ➤ Edit Accessible MAC Address Screen/Add Accessible MAC Address Screen

4. **Add...**

The Add Accessible MAC Address screen is displayed to register the MAC address of a computer or a network device from which to access the printer over the network.

**Important**

- Add the MAC address of all computers or network devices within the network from which to access the printer. The printer cannot be accessed from a computer or a network device that is not on the list.

5. **Delete**

Deletes the selected MAC address from the list.

**When Selecting IP address**

The accessible computers or network devices are specified by their IP addresses. Computers or network devices whose IP addresses appear on the list are allowed access.
1. **Enable printer access control(IP address)**

Select to enable access control to the printer by IP address.

**Note**

- The two types of access control (i.e., by MAC address and by IP address) can be enabled at the same time.

  An access control type is enabled as long as the **Enable printer access control** check box is selected, regardless of the type currently displayed by selecting in **Printer Access Control Type**:

- When both access control types are enabled at the same time, a computer or a network device whose address is registered to either list will be allowed access to the printer.

2. **Accessible IP Addresses:**

Shows the registered IP addresses and any comments.

3. **Edit...**

The **Edit Accessible IP Address** screen is displayed to edit the settings selected in **Accessible IP Addresses**:

   - [Edit Accessible IP Address Screen/Add Accessible IP Address Screen](#)

4. **Add...**

The **Add Accessible IP Address** screen is displayed to register the IP address of a computer or a network device from which to access the printer over the network.

**Important**

- Add the IP address of all computers or network devices within the network from which to access the printer. The printer cannot be accessed from a computer or a network device that is not on the list.

- Up to 16 IP addresses can be registered. IP addresses specified by Range Specification are counted as one address. Use Range Specification when you intend to register 17 or more IP addresses.
5. **Delete**

Deletes the selected IP address from the list.
Edit Accessible MAC Address Screen/Add Accessible MAC Address Screen

Note

- This screen is not available depending on the printer you are using.

The example screenshots in this section refer to the Add Accessible MAC Address Screen.

1. **MAC Address:**

   Enter the MAC address of a computer or a network device to allow access.

2. **Comment:**

   Optionally enter any information to identify the device, such as the name of the computer.

Important

- Comments will be displayed only on the computer used to enter them.
Edit Accessible IP Address Screen/Add Accessible IP Address Screen

Note
• This screen is not available depending on the printer you are using.

The example screenshots in this section refer to the Add Accessible IP Address Screen.

1. Specification Method:
   Select either Single Address Specification or Range Specification to add the IP address(es).
   
   **Single Address Specification**
   Specify each IP address separately.
   
   **Range Specification**
   Specify a range of successive IP addresses.

2. IP Address:
   Enter the IP address of a computer or a network device to allow access when you selected Single Address Specification in Specification Method.
   An IP address is expressed as four values ranging from 0 to 255.
   
   **Start IP Address:**
   Enter the first IP address in the range of addresses of the computers or network devices to allow access when you selected Range Specification in Specification Method.
   An IP address is expressed as four values ranging from 0 to 255.
   
   **End IP Address:**
   Enter the last IP address in the range of addresses of the computers or network devices to allow access when you selected Range Specification in Specification Method.
   An IP address is expressed as four values ranging from 0 to 255.

Note
• The Start IP Address: must be a smaller value than the End IP Address.

3. Comment:
   Optionally enter any information to identify the device, such as the name of the computer.

Important
• Comments will be displayed only on the computer used to enter them.
Other Screens of IJ Network Tool

- Canon IJ Network Tool Screen
- Status Screen
- Connection Performance Measurement Screen
- Maintenance Screen
- Network Setup of the Card Slot Screen
- Associate Port Screen
- Network Information Screen
Canon IJ Network Tool Screen

This section describes the items and menus displayed on the Canon IJ Network Tool screen.

⇒ Items on the Canon IJ Network Tool Screen
⇒ Canon IJ Network Tool Menus

Items on the Canon IJ Network Tool Screen

The following item is displayed on the Canon IJ Network Tool screen.

1. Printers:

   The printer name, status, printer model name, and port name are displayed.

   A check mark next to the printer in the Name list indicates it is set as the default printer.

   Configuration changes are applied to the selected printer.

2. Update

   Performs printer detection again. Click this button if the target printer is not displayed.

   Important

   • To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.
   • If No Driver is displayed for the name, associate the port with the printer.

   ⇒ When the Printer Driver Is Not Associated with a Port
   • If Not Found is displayed for the status, check the followings:
     • The access point is turned on.
     • When using wired LAN, the LAN cable is connected properly.
   • If the printer on a network is not detected, make sure that the printer is turned on, then click Update. It may take several minutes to detect printers. If the printer is not yet detected, connect the machine and the computer with a USB cable, then click Update.
   • If the printer is being used from another computer, a screen is displayed informing you of this condition.
**Note**

- This item has the same function as **Refresh** in the **View** menu.

3. **Configuration...**

Click to configure settings of the selected printer.

⇒ **Configuration Screen**

**Note**

- You cannot configure a printer that has the status **Not Found**.
- This item has the same function as **Configuration...** in the **Settings** menu.

---

**Canon IJ Network Tool Menus**

The following menu is displayed from the **Canon IJ Network Tool** screen.

![Canon IJ Network Tool Menu](image)

1. **File menu**

   **Exit**
   
   Exits IJ Network Tool.

2. **View menu**

   **Status**
   
   Displays the **Status** screen to confirm the printer connection status and wireless communication status.

⇒ **Status Screen**

**Refresh**

Updates and displays the contents of **Printers**: on the **Canon IJ Network Tool** screen to the latest information.

**Important**

- To change the printer's network settings using IJ Network Tool, it must be connected via a LAN.
- If **No Driver** is displayed for the name, associate the port with the printer.

⇒ **When the Printer Driver Is Not Associated with a Port**
• If **Not Found** is displayed for the status, check the followings:
  • The access point is turned on.
  • When using wired LAN, the LAN cable is connected properly.

• If the printer on a network is not detected, make sure that the printer is turned on, then select **Refresh**. It may take several minutes to detect printers. If the printer is not yet detected, connect the machine and the computer with a USB cable, then select **Refresh**.

• If the printer is being used from another computer, a screen is displayed informing you of this condition.

**Note**

• This item has the same function as **Update** in the **Canon IJ Network Tool** screen.

**Network Information**

Displays the **Network Information** screen to confirm the network settings of the printer and the computer.

[Network Information Screen](#)

**Display Warning Automatically**

Enables or disables automatic display of the instruction screen.

When this menu is selected, the instruction screen is displayed if one or more ports are unavailable for printing.

3. **Settings** menu

**Configuration...**

Displays the **Configuration** screen to configure settings of the selected printer.

[Configuration Screen](#)

**Note**

• This item has the same function as **Configuration...** in the **Canon IJ Network Tool** screen.

**Associate Port...**

Displays the **Associate Port** screen and you can associate a port with the printer.

[Associate Port Screen](#)

This menu is available when **No Driver** is displayed for the selected printer. Associating a port with the printer enables you to use it.

**Maintenance...**

Displays the **Maintenance** screen to revert the network settings of the printer to factory default and to mount the card slot as the network drive.

[Maintenance Screen](#)

4. **Help** menu

**Instructions**

Displays this guide.

**About**

Displays the version of IJ Network Tool.
Status Screen

You can check the printer status and connection performance.

To display the Status screen, select Status from the View menu.

Note

- This screen is not available depending on the printer you are using.
- When using wired LAN, Signal Strength:, Link Quality: and Advanced Measurement... are not available.

1. **Device Status:**
   The device status is displayed as Available or Unavailable.

2. **Signal Strength:**
   Indicates the strength of the signal received by the printer, ranging from 0% to 100%.

3. **Link Quality:**
   Indicates the signal quality excluding the noise while communicating, ranging from 0% to 100%.

4. **Advanced Measurement...**
   To examine the connection performance between the printer and the access point or between the printer and the computer.
   
   When you click, the **Connection Performance Measurement** is displayed.
   
   ➤ **Connection Performance Measurement Screen**
## Connection Performance Measurement Screen

**Note**
- This screen is not available depending on the printer you are using.

Displays to execute the connection performance measurement.

- [Connection Performance Measurement Screen (Initial Screen)](#)
- [Connection Performance Measurement Screen (Completion Screen)](#)

### Connection Performance Measurement Screen (Initial Screen)

Click **Next >** to start measurement.

![Connection Performance Measurement Screen (Initial Screen)](image)

### Connection Performance Measurement Screen (Completion Screen)

Displays when the measurement is finished.

![Connection Performance Measurement Screen (Completion Screen)](image)
1. **Connection Performance between the Printer and the Access Point:**

   A mark indicates the result of the connection performance measurement between the printer and the access point.
   - ☑️: Good connection performance
   - 🚨: Unstable connection performance
   - ⚠️: Cannot connect
   - 🤔: Measurement is canceled, or cannot measure

2. **Remeasurement**

   Measures the connection performance again.

   ⚠️⚠️ **Note**

   - If any messages appear on **Overall Network Performance**: move the machine and access point as instructed to improve the performance.
Maintenance Screen

Displays to perform Setting Initialization and Network Setup of the Card Slot.

To display the Maintenance screen, select Maintenance... from the Settings menu.

1. Setting Initialization

Reverts all the network settings of the printer to factory default. Click Initialize to display the Initialize Settings screen and click Yes to initialize the network settings of the printer. Do not turn off the printer during initialization. Click OK when initialization is complete.

Performing initialization when connected over wireless LAN will break the connection, so perform setup with the Setup CD-ROM or perform setup according to the instructions on our website.

2. Network Setup of the Card Slot

Note

- This item is not available depending on the printer you are using.

Status displays whether the card slot is mapped as a network drive.

When you click, the Network Setup of the Card Slot is displayed.

Network Setup of the Card Slot Screen
Network Setup of the Card Slot Screen

**Note**

• This screen is not available depending on the printer you are using.

Displays settings of the card slot and allows you to map a card slot on the network as a network drive on the computer.

Displays when you click **Setup** on the **Maintenance** screen.

Network Setup of the Card Slot Screen (Setup Screen)

Network Setup of the Card Slot Screen (Setup Failed Screen)

**Note**

• You can change the network settings of the printer using IJ Network Tool with USB connection after initializing the LAN settings. To change the network settings using IJ Network Tool, activate the LAN settings in advance.

Network Setup of the Card Slot Screen (Setup Screen)

1. **Drive:**
   
   Select the drive letter to assign to the network drive.

2. **Update**
   
   Reloads the drive letters that are unassigned in **Computer** (**My Computer** in Windows XP) and displays them in the **Drive:** list.

Network Setup of the Card Slot Screen (Setup Failed Screen)

Display when the network setup of the card slot is failed.
1. **Skip**
   Completes the setup without mapping a network drive to the card slot.

2. **Retry**
   Returns to **Network Setup of the Card Slot** screen and re-executes the network drive mapping.

3. **Cancel**
   Cancels the card slot setup. When IJ Network Tool is running over LAN, the **Cancel** button is displayed grayed out and cannot be clicked.


## Associate Port Screen

Allows you to associate a created port with a printer driver.

Select the printer for which you want to change the association, then click **OK**.

### Note

- You cannot print with the printer unless the printer driver is associated with the port.

---

### 1. Model:

Displays the name of device specified as a destination port.

It is blank if the name of device is not detected.

### 2. Printer:

Displays the printer driver installed in the computer.

Select the printer for which you want to change the association.

### 3. OK

Performs association.
Network Information Screen

Display the network information that is set for the printers and the computers.

To display the Network Information screen, select Network Information from the View menu.

1. OK

   Returns to the Canon IJ Network Tool screen.

2. Copy All Information

   All network information displayed is copy to the clipboard.
Appendix for Network Communication

- Using the Card Slot over a Network
- When the Printer Driver Is Not Associated with a Port
- About Technical Terms
- Restrictions
- About Firewall
Using the Card Slot over a Network

Note

• This screen is not available depending on the printer you are using.

Mounting the Card Slot as the Network Drive

The card slot must be mounted to use it over a network.
To mount the card slot as the network drive, follow the procedure below.

1. Insert a memory card into the card slot of the machine.

2. Start up IJ Network Tool.

3. Select the machine in Printers:

4. Select Maintenance... on the Settings menu.

5. Click Setup.

6. Specify the drive letter, then click OK.
7. Make sure that the card slot is mounted.

When the card slot is mounted, the following icon appears on Computer (or My Computer).

Restrictions on Card Slot Use over a Network

- The card slot can be shared by multiple computers, if the machine is connected to a network. Multiple computers can read files from a memory card in the card slot at the same time. However, while one computer is writing a file into a memory card, other computers cannot access the same file.

- If your computer joins a domain, the card slot may not be mounted as the network drive.

- If you use the memory card stored the large size files or many files, a large amount of card access may be generated. In this case, the operation in the memory card may be impossible or slow. Operate after the Access lamp of the machine is lit.

- When you access the network drive for the card slot over the network, file names consisting of eight or less lowercase letters (not including its extension) may be shown in uppercase. For example, a file name such as "abcdefg.doc" will be "ABCDEFG.DOC", while a name such as "AbcdeFG.doc" will appear the same. The file is not actually renamed, but merely appears to be changed.

- When you enable a memory card in the card slot of the machine to be writable only from a USB-connected computer, you cannot access the network drive of the card slot. On the other hand, when you enable it to be writable only from a LAN-connected computer, the card slot is not detected via USB. Make sure that the card slot setting is selected properly according to your connection method.

To read files from a memory card via USB and over a network, disable the function to write files to a memory card from a computer. You cannot write files to a memory card in either way with this setting.

- When you enable a memory card in the card slot of the machine to be writable only from a LAN-connected computer, you can write files to a memory card from a computer connected to a network. Note that it may increase the risk that the data on the memory card is infected by computer viruses or accessed illegally.

It is recommended to use the access control function of the machine or connect to the Internet via a router. For information on using a router, contact your Internet service provider or a network device manufacturer.

- If you write files to a memory card over a network when IJ Network Scanner Selector EX is not running, the Date Modified of the files may not be proper. Make sure to start up IJ Network Scanner Selector EX before you write files to a memory card over the network. For details, refer to "IJ Network Scanner Selector EX Menu and Setting Screen" from the HOME of your product’s Online Manual.
When the Printer Driver Is Not Associated with a Port

If No Driver is displayed for the printer’s name on the Canon IJ Network Tool screen, the printer driver is not associated with a created port.

To associate a port with a printer driver, follow the procedure below.

1. Start up IJ Network Tool.

2. Select the printer displayed as No Driver on Name.

3. Select Associate Port... on the Settings menu.

   The Associate Port screen is displayed.

4. Select a printer to associate with a port.

   The list of the printers that the printer driver is installed is displayed at Printer: on the Associate Port screen. Select a printer to associate with a created port.

5. Click OK.
About Technical Terms

In this section, technical terms used in the manual are explained.

- **Access Point**
  A wireless transceiver or base station that receives information from wireless clients/the machine and rebroadcasts it. Required in an infrastructure network.

- **Ad-hoc**
  Client computer and machine setting where wireless communication occurs on a peer-to-peer basis, i.e., all clients in with the same SSID/network name communicate directly with each other. No access point is required. This machine does not support ad-hoc communication.

- **Admin Password**
  Administration password in IJ Network Tool to restrict access to network users. It must be entered to access the printer and change printer settings.

  When the printer's network settings are factory default, the admin password does not have to been entered.

- **AES**
  An encryption method. It is optional for WPA. Strong cryptographic algorithm adopted within U.S. government organizations for information processing.

- **Authentication Method**
  The method that an access point uses to authenticate a printer through a wireless LAN. The methods are agreeable each other.
When using WEP as an encryption method, the authentication method is able to fix to **Open System** or **Shared Key**.

For WPA/WPA2, authentication method is PSK.

- **Auto**
  The printer automatically changes its authentication method to match the access point.

- **Open System**
  In this authentication method, the communication partner is authenticated without using WEP key even if **Use WEP** is selected.

- **Shared Key**
  In this authentication method, the communication partner is authenticated using the WEP key that was set for encryption.

**B**

- **Bonjour**
  A service built into Mac OS X operating system to detect the connectable devices on a network automatically.

**C**

- **Channel**
  Frequency channel for wireless communication. In the infrastructure mode, the channel is automatically adjusted to match that set to the access point. This machine supports channels 1 to 13. Note that the number of channels that can be used for your wireless LAN varies depending on the region or country.

**D**

- **Default Gateway**
  A relay device to connect to another network such as a router or a computer.

- **DHCP server functionality**
  The router or the access point assigns an IP address automatically whenever the printer or the personal computer on a network starts up.

- **DNS server**
  A server that converts device names into IP addresses. When specifying IP addresses manually, specify the addresses of both a primary and a secondary server.

**F**

- **Firewall**
  It is a system that prevents an unlawful computer access in the network. To prevent, you can use the firewall function of a broadband router, the security software installed in the computer, or operation system for computer.
• IEEE 802.11b
  International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to 11 Mbps.

• IEEE 802.11g
  International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to 54 Mbps. Compatible with 802.11b.

• IEEE 802.11n
  International standard for wireless LAN using the 2.4 GHz and 5 GHz frequency ranges. Even when using two or more antennas simultaneously or obtaining a bigger transfer rate than before by using multiple communication channels at the same time, the transmission speed may be influenced by the connected apparatus.

  At the maximum transfer rate of 600 Mbps, it is possible to communicate with multiple computer terminals within a dozen or so metre radius.

  Compatible with 802.11b and 802.11g.

• Infrastructure
  Client computer and machine setup where all wireless communications pass through an access point.

• IP Address
  A unique number with four parts separated by dots. Every network device that is connected to the Internet has an IP address. Example: 192.168.0.1

  An IP address is usually assigned by an access point or a DHCP server of the router automatically.

• IPv4/IPv6
  They are internetwork-layer protocol used on the internet. IPv4 uses 32-bit addresses and IPv6 uses 128-bit addresses.

K

• Key Format
  Select either ASCII or Hex as the WEP key format. The character that can be used for the WEP key differs depending on the selected key formats.

  ◦ ASCII
    Specify with a 5 or 13-character string that can include alphanumerical and underscore "_" characters. It is case-sensitive.

  ◦ Hex
    Specify a 10-digit or 26-digit string that can contain hexadecimal (0 to 9, A to F, and a to f).

• Key Length
  Length of the WEP key. Select either 64 bits or 128 bits. Longer key length allows you to set a more complex WEP key.
• **Link Quality**
  The status of connection between the access point and the printer excluding noise (interference) is indicated with a value from 0 to 100%.

• **LPR**
  A platform-independent printing protocol used in TCP/IP networks. It is not supported bidirectional communication.

• **MAC Address**
  Also known as the physical address. A unique and permanent hardware identifier that is assigned to network devices by its manufacturer. MAC addresses are 48 bits long and are written as a hexadecimal number separated by colons, i.e., 11:22:33:44:55:66.

• **Operation Status**
  Indicates the status on whether the printer can be used.

• **Proxy server**
  A server that links a LAN-connected computer to the Internet. When using a proxy server, specify the address and the port number of the proxy server.

• **PSK**
  An encryption method employed by WPA/WPA2.

• **Router**
  A relay device to connect to another network.

• **Signal Strength**
  The strength of the signal received by the printer from the access point is indicated with a value from 0 to 100%.

• **SSID**
  Unique label for wireless LAN. It is often represented such as a network name or an access point name.
  SSID distinguishes one wireless LAN from another to prevent interference.
The printer and all clients on a wireless LAN must use the same SSID in order to communicate with each other. The SSID can be up to 32 characters long, and is made up of alphanumeric characters. The SSID may also be referred to by its network name.

- **Stealth**
  In the stealth mode, an access point hides itself by not broadcasting its SSID. The client must specify the SSID set to the access point to detect it.

- **Subnet Mask**
  IP address has two components, the network address and the host address. Subnet Mask used to calculate the Subnet Mask address from the IP address. A Subnet Mask is usually assigned by an access point or a DHCP server of the router automatically.

  Example:
  
  IP Address: 192.168.127.123
  Subnet Mask: 255.255.255.0
  Subnet Mask Address: 192.168.127.0

- **TCP/IP**
  Suite of communications protocols used to connect hosts on the Internet or the LAN. This protocol allows different terminals to communicate with each other.

- **TKIP**
  An encryption protocol employed by WPA/WPA2.

- **USB**
  Serial interface designed to enable you to “hot-swap” devices, i.e., by plugging and unplugging them without turning off the power.

- **WCN (Windows Connect Now)**
  Users running Windows Vista or later can obtain the setting information directly via wireless network (WCN-NET).

- **WEP/WEP Key**
  An encryption method employed by IEEE 802.11. Shared security key used to encrypt and decrypt data sent over wireless networks. This printer supports key length of 64 bits or 128 bits, key format of ASCII code or Hexadecimal, and key number of 1 to 4.

- **Wi-Fi**
  International association that certifies interoperability of wireless LAN products based on the IEEE 802.11 specification.
This machine is a Wi-Fi authorized product.

- **Wireless LAN**
  A network that, instead of being connected by physical wires, is connected by a wireless technology, such as Wi-Fi.

- **WPA**
  Security framework announced by the Wi-Fi Alliance in October 2002. The security has been strengthened more than WEP.
  - **Authentication**
    WPA defines the following authentication methods: PSK that can be used without an authentication server, plus WPA-802.1x that do require an authentication server.
    This machine supports WPA-PSK.
  - **Passphrase**
    This encrypted key is used to perform WPA-PSK authentication.
    The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal value.

- **WPA2**
  Security framework released by the Wi-Fi Alliance in September 2004 as a later version of WPA. Provides a stronger encryption mechanism through Advanced Encryption Standard (AES).
  - **Authentication**
    WPA2 defines the following authentication methods: PSK that can be used without an authentication server, plus WPA2-802.1x that do require an authentication server.
    This machine supports WPA2-PSK.
  - **Passphrase**
    This encrypted key is used to perform WPA2-PSK authentication.
    The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal value.

- **WPS (Wi-Fi Protected Setup)**
  WPS is a standard for easy and secure establishment of a wireless network.
  There are 2 primary methods used in the Wi-Fi Protected Setup:
  - PIN entry: a mandatory method of setup for all WPS certified devices
  - Push button configuration (PBC): an actual push button on the hardware or through a simulated push button in the software.
Restrictions

If you use a printer over the wireless LAN, the printer may recognize nearby wireless systems, you should set a network key (WEP, WPA, or WPA2) to the access point to encrypt wireless transmission. Wireless communication with a product that does not comply with the Wi-Fi standard cannot be guaranteed.

Connecting with too many computers may affect the printer performance, such as printing speed.
About Firewall

A firewall is a function of the security software installed in the computer or operation system for computer, and is a system that is designed to prevent unauthorized access to a network.

Precautions When a Firewall Function is Enabled

- A firewall function may limit communications between a printer and a computer. This may disable printer setup and communications.

- During the printer setup, you may be prompted to enable or disable communications, depending on the firewall function of the security software or operation system. If so, choose to enable communications.

- When using IJ Network Tool, you may be prompted to enable or disable communications, depending on the firewall function of the security software. If so, choose to enable communications.

- If you cannot set up the printer, temporarily disable the firewall function of the security software or operation system.

>>> Important

- If you disabled the firewall function, disconnect your network from the Internet.

- Some applications (like the network configuration software) override firewall settings. Check the application's settings beforehand.

- If the printer you use is set to Get IP address automatically, the IP address changes every time the printer connects to the network. This may disable printer setup and communications, depending on the firewall settings. In this case, either change the firewall settings or assign a fixed IP address to the printer. An IP address can be set using IJ Network Tool.

   ➤ Changing the Settings in the Wireless LAN Sheet

   ➤ Changing the Settings in the Wired LAN Sheet

When assigning a fixed IP address to the printer, you will need to specify an IP address with which the computer can communicate.

>>> Note

- For the operation system firewall settings or the security software firewall settings, refer to the instruction manual of the computer or software, or contact its manufacturer.
Tips for Ensuring Optimal Printing Quality

- Useful Information about Ink
- Key Points to Successful Printing
- Be Sure to Make Paper Settings after Loading Paper
- Canceling a Print Job
- Key to Enjoying Consistent Printing Quality
- Precautions for Safe Transport of the Machine
Useful Information about Ink

How is ink used for various purposes other than printing?
Ink may be used for purposes other than printing.

When you use the Canon printer for the first time after you install the bundled ink tanks, the printer consumes a small amount of ink in the amount to enable printing by filling the nozzles of the Print Head with ink. For this reason, the number of sheets that can be printed with the first ink tanks is fewer than the succeeding ink tanks.

The printing costs described in the brochures or websites are based on the consumption data from not the first ink tank /ink cartridge but the succeeding ink tank /ink cartridge.

Ink is sometimes used to maintain the optimal printing quality. To keep printer’s performance, Canon printer performs cleaning automatically according to its condition. When the printer performs cleaning, a small amount of ink is consumed. In this case, all colors of ink may be consumed.

[Cleaning function]
The cleaning function helps the printer to suck air bubbles or ink itself from the nozzle and thus prevents print quality degradation or nozzle clogging.

Does black-and-white printing use color ink?
Black-and-white printing may use ink other than black ink depending on the type of printing paper or the settings of the printer driver. So, color ink is consumed even when printing in black-and-white.

Why does the machine have two black ink tanks?
There are two kinds of black ink in the machine: dye ink (BK) and pigment ink (PGBK). The dye ink is used mainly for printing photos, illustration, etc., and the pigment ink is used for text-based documents. Each has different purposes so that even if one runs out, another will not be used instead. If either of them runs out, the ink tank replacement is required. These two inks are automatically used depending on the type of printing paper or the settings of the printer driver. You cannot change the usage of these inks yourself.

The ink lamp indicates when ink is running low.
The inside of the ink tank consists of (A) the part where ink is preserved and (B) the sponge with absorbed ink.
When the ink (A) runs out, the ink lamp flashes slowly to indicate that the ink is running low. Then, when the ink (B) runs out, the ink lamp flashes fast to indicate that the ink tank needs to be replaced with a new one.

Checking the Ink Status with the Ink Lamps
Key Points to Successful Printing

Check the machine status before printing!

- Is the print head OK?
  
  If a print head nozzle is clogged, print will be faint and papers will be wasted. Print the nozzle check pattern to check the print head.
  ➤Maintenance Procedure

- Is the inside of the machine smeared with ink?

  After printing large quantities of paper or performing borderless printing, the area where papers go through may get smeared with ink. Clean the inside of your machine with Bottom Plate Cleaning.
  ➤Cleaning the Inside of the Machine (Bottom Plate Cleaning)

Check how to load the paper correctly!

- Is the paper loaded in the correct orientation?

  To load paper in a front tray, load paper WITH THE PRINT SIDE FACING DOWN.
  ➤Loading Paper

- Is the paper curled?

  The curled paper causes paper jam. Flatten the curled paper, then reload it.
  ➤"Load the paper after correcting its curl." in Paper Is Smudged/Printed Surface Is Scratched
Be Sure to Make Paper Settings after Loading Paper

If the media type setting is not the one for the loaded paper, printing results may not be satisfactory. After loading paper, be sure to select the appropriate media type setting for the loaded paper.

Print Results Not Satisfactory

There are various types of paper: paper with special coating on the surface for printing photos with optimal quality and paper suitable for documents. Each media type has specific preset settings, such as how ink is used and sprayed, distance from nozzles, etc., so that you can print on that type with optimal image quality. This allows you to print with the settings best suited for the loaded media type just by selecting that media type.
Canceling a Print Job

Never press the ON button!
If you press the ON button while printing is in progress, the print data sent from the computer queues in the machine and you may not be able to continue to print.
Press the Stop button to cancel printing.
Key to Enjoying Consistent Printing Quality

The key to printing with the optimal printing quality is to prevent the print head from drying or clogging. Always observe the following rules for optimal printing quality.

Never disconnect the power plug until the power is turned off!

If you press the ON button to turn off the power, the machine caps the print head (nozzles) automatically to prevent from drying. If you disconnect the power plug from the wall outlet before the power is turned off (the POWER lamp is not lit), the print head will not be capped properly and this will cause drying or clogging.

When disconnecting the power plug, make sure that the POWER lamp is not lit.

➡️ Notice for Unplugging the Power Cord

Print periodically!

Just as the tip of a felt pen becomes dry and unusable if it has not been used for a long time, even if it is capped, the print head too, may become dried or clogged if the machine has not been used for a long time.

We recommend you to use the machine at least once a month.

➡️ Note

- Depending on the type of paper, ink may blur if you trace the printed area with a highlight pen or paint-stick, or bleed if water or sweat comes in contact with the printed area.
Precautions for Safe Transport of the Machine

When relocating the machine, make sure of the following.

**Important**

**When sending the machine for repair**
- Pack the machine in a sturdy box so that it is placed with its bottom facing down, using sufficient protective material to ensure safe transport.
- With the print head and ink tank left installed in the machine, press the **ON** button to turn off the power. This allows the machine to automatically cap the print head, thus preventing it from drying.
- After packing, do not tilt the box containing the machine or turn it on its side or upside down. Doing so may cause the ink to leak during transport and cause damage to the machine.
- When a shipping agent is handling transport of the machine, have its box marked "THIS SIDE UP" to keep the machine with its bottom facing down. Mark also with "FRAGILE" or "HANDLE WITH CARE".

1. Turn the machine off.

2. Confirm that the **POWER** lamp is off and unplug the machine.

   **Notice for Unplugging the Power Cord**

   **Important**
   - Do not unplug the machine while the **POWER** lamp is lit or flashing, as it may cause malfunction or damage to the machine, making the machine unable to print.

3. Retract the paper output support, then close the paper output tray.

4. Retract the output tray extension and the paper support, then close the front tray.

5. Disconnect the printer cable from the computer and from the machine, then disconnect the power plug from the machine.
6. Use adhesive tape to secure all the covers on the machine to keep them from opening during transportation. Then pack the machine in the plastic bag.

7. Attach the protective material to the machine when packing the machine in the box.
Legal Limitations on Use of Your Product and Use of Images

It may be unlawful to make copies of, scan, print, or use reproductions of the following documents.
The list provided is non-exhaustive. When in doubt, check with a legal representative in your jurisdiction.

- Paper money
- Money orders
- Certificates of deposit
- Postage stamps (canceled or uncanceled)
- Identifying badges or insignias
- Selective service or draft papers
- Checks or drafts issued by governmental agencies
- Motor vehicle licenses and certificates of title
- Traveler’s checks
- Food stamps
- Passports
- Immigration papers
- Internal revenue stamps (canceled or uncanceled)
- Bonds or other certificates of indebtedness
- Stock certificates
- Copyrighted works/works of art without permission of copyright owner
### Specifications

#### General Specifications

<table>
<thead>
<tr>
<th>Printing resolution (dpi)</th>
<th>4800* (horizontal) x 1200 (vertical)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>* Ink droplets can be placed with a pitch of 1/4800 inch at minimum.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Interface</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>USB Port:</td>
<td>Hi-Speed USB *1</td>
</tr>
<tr>
<td>LAN Port:</td>
<td>Wireless LAN: IEEE802.11n/IEEE802.11g/IEEE802.11b *2</td>
</tr>
<tr>
<td></td>
<td>*1 A computer that complies with Hi-Speed USB standard is required. Since the Hi-Speed USB interface is fully upwardly compatible with USB 1.1, it can be used at USB 1.1.</td>
</tr>
<tr>
<td></td>
<td>*2 Setup possible through Standard setup, WPS (Wi-Fi Protected Setup), WCN (Windows Connect Now) or Cableless setup.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print width</th>
<th>8 inches/203.2 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>(for Borderless Printing: 8.5 inches/216 mm)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operating environment</th>
<th>Temperature: 41 to 95 °F (5 to 35 °C)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Humidity: 10 to 90 % RH (no condensation)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Storage environment</th>
<th>Temperature: 32 to 104 °F (0 to 40 °C)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Humidity: 5 to 95 % RH (no condensation)</td>
</tr>
</tbody>
</table>

| Power supply                 | AC 100-240 V, 50/60 Hz |

<table>
<thead>
<tr>
<th>Power consumption</th>
<th>Printing (Copy): Approx. 11 W</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Standby (minimum): Approx. 1.1 W <em>1</em>2</td>
</tr>
<tr>
<td></td>
<td>OFF: Approx. 0.3 W *1</td>
</tr>
<tr>
<td></td>
<td>*1 USB connection to PC</td>
</tr>
<tr>
<td></td>
<td>*2 The wait time for standby cannot be changed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>External dimensions</th>
<th>Approx. 18 (W) x 14.6 (D) x 5.9 (H) inches</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Approx. 455 (W) x 369 (D) x 148 (H) mm</td>
</tr>
<tr>
<td></td>
<td>* With the Front Tray retracted.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Weight</th>
<th>Approx. 13.8 lb (Approx. 6.3 kg)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>* With the Print Head and ink tanks installed.</td>
</tr>
</tbody>
</table>

| Print Head/Ink               | Total 4096 nozzles (PgBK 1024 nozzles, Y/DyeBK each 512 nozzles, C/M each 1024 nozzles) |
Copy Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple copy</td>
<td>max. 99 pages</td>
</tr>
<tr>
<td>Intensity adjustment</td>
<td>9 positions, Auto intensity (AE copy)</td>
</tr>
<tr>
<td>Reduction/Enlargement</td>
<td>25 % - 400 % (1 % unit)</td>
</tr>
</tbody>
</table>

Scan Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanner driver</td>
<td>Windows: TWAIN 1.9 Specification, WIA</td>
</tr>
<tr>
<td></td>
<td>Mac OS: ICA</td>
</tr>
<tr>
<td>Maximum scanning size</td>
<td>A4/Letter, 8.5” x 11.7”/216 x 297 mm</td>
</tr>
<tr>
<td>Scanning resolution</td>
<td>Optical resolution (horizontal x vertical) max: 1200 x 2400 dpi *1</td>
</tr>
<tr>
<td></td>
<td>Interpolated resolution max: 19200 x 19200 dpi *2</td>
</tr>
<tr>
<td></td>
<td>*1 Optical Resolution represents the maximum sampling rate based on ISO 14473.</td>
</tr>
<tr>
<td></td>
<td>*2 Increasing the scanning resolution will limit the maximum possible scanning area.</td>
</tr>
<tr>
<td>Gradation (Input/Output)</td>
<td>Gray: 16 bit/8 bit</td>
</tr>
<tr>
<td></td>
<td>Color: 48 bit/24 bit (RGB each 16 bit/8 bit)</td>
</tr>
</tbody>
</table>

Network Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication protocol</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Supported Standards</td>
<td>IEEE802.11n/IEEE802.11g/IEEE802.11b</td>
</tr>
<tr>
<td>Frequency bandwidth</td>
<td>2.4 GHz</td>
</tr>
<tr>
<td>Channel</td>
<td>1-11 or 1-13</td>
</tr>
<tr>
<td>Wirelessly LAN</td>
<td></td>
</tr>
<tr>
<td>Transfer speed (Standard value):</td>
<td>IEEE802.11n: max. 150 Mbps</td>
</tr>
<tr>
<td></td>
<td>IEEE802.11g: max. 54 Mbps</td>
</tr>
<tr>
<td></td>
<td>IEEE802.11b: max. 11 Mbps</td>
</tr>
<tr>
<td></td>
<td>* These values are a theoretical maximum transmission speed between the printer and an equivalent network device, and do not indicate the actual transmission speed obtained.</td>
</tr>
<tr>
<td>Communication distance</td>
<td>Indoors 164 feet/50 m</td>
</tr>
<tr>
<td></td>
<td>* Effective range varies depending on the installation environment and location.</td>
</tr>
<tr>
<td>Security</td>
<td></td>
</tr>
</tbody>
</table>
WEP (64/128 bits)
WPA-PSK (TKIP/AES)
WPA2-PSK (TKIP/AES)

Setup:
Standard setup
WPS (Push button configuration/PIN code method)
WCN (WCN-NET)
Cableless setup

Other Features: Administration password

Minimum System Requirements
Conform to the operating system's requirements when higher than those given here.

Windows

| Operating System | Windows 8  
|------------------|------------------|  
| Windows 7, Windows 7 SP1  
| Windows Vista SP1, Windows Vista SP2  
| Windows XP SP3 32-bit only  
| Browser | Internet Explorer 8 or later  
| Hard Disk Space | 3 GB  
| Note: For bundled software installation.  
| The necessary amount of hard disk space may be changed without notice.  
| Display | XGA 1024 x 768  

Mac OS

| Operating System | Mac OS X v10.6.8 or later  
| Browser | Safari 5 or later  
| Hard Disk Space | 1.5 GB  
| Note: For bundled software installation.  
| The necessary amount of hard disk space may be changed without notice.  
| Display | XGA 1024 x 768  

Other Supported OS
Some functions may not be available with each OS. Refer to the manual or the Canon web site for details on operation with iOS, Android, and Windows RT.
### Mobile Printing Capability

<table>
<thead>
<tr>
<th>Apple AirPrint</th>
<th>Google Cloud Print</th>
<th>Print from E-mail</th>
</tr>
</thead>
</table>

- An internet connection is required to view the *Online Manual*.
- Windows: Operation can only be guaranteed on a computer with Windows 8, Windows 7, Windows Vista or Windows XP pre-installed.
- Windows: A CD-ROM Drive or internet connection is required during software installation.
- Windows: Internet Explorer 8, 9 or 10 is required to install Easy-WebPrint EX. Easy-WebPrint EX for Internet Explorer 10 can be downloaded from the Canon website.
- Windows: Some functions may not be available with Windows Media Center.
- Windows: .NET Framework 4 or 4.5 must be installed to use the Windows software.
- Windows: XPS Essentials Pack is required to print on Windows XP.
- Mac OS: Hard Disk must be formatted as Mac OS Extended (Journaled) or Mac OS Extended.
- Mac OS: For Mac OS, an internet connection is required during software installation.
- Windows: The TWAIN driver (ScanGear) is based on the TWAIN 1.9 Specification and requires the Data Source Manager bundled with the operating system.

Specifications are subject to change without notice.